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Chapter 1. Introduction

IBM® Unica® Marketing Operations is a tool for enterprise planning, collaboration,
and workflow that provides a complete solution for the needs of marketers. You
can use IBM Unica Marketing Operations to get a comprehensive and holistic view
of all marketing projects across your company. You can then focus on improving
each dimension of marketing planning. Everyone on the marketing team: chief
marketing officers, marketing managers, event planners, creative directors, and
marketing controllers, realizes immediate benefits in efficiency and performance.

What does IBM Unica Marketing Operations do?

IBM Unica Marketing Operations is the marketing resource management (MRM)
solution that allows you to plan, budget, and monitor every type of marketing
program in your company.

Use IBM Unica Marketing Operations to perform the following tasks.
v Get real-time visibility into every marketing program.
v Manage all marketing activities, including advertising, brand management,

direct and interactive marketing, promotions, events, collateral, research, public
relations.

v Enforce marketing "best practices".
v Increase productivity and optimization of resources, including people and

budgets, through automated workflow, collaboration, and unique optimization
capabilities.

v Promote effective management of marketing content and projects created by
dynamic marketing organizations.

v Manage workflow and projects across the entire marketing operation for all
types of media, events, campaigns, and brand loyalty efforts. For projects as
diverse as mailers, ad campaigns, catalogs, and seminars, Marketing Operations
is an effective management tool.

Why use IBM Unica Marketing Operations?
By using IBM Unica Marketing Operations, marketers can increase the return and
lower the risk of all their resource investments by optimizing decisions,
collaborating across programs, operating more efficiently, and gaining greater
visibility into what they are doing, what they are spending money on, and what
the results are.

Marketing Operations allows you to do the following.
v Manage and coordinate all your marketing activities in one solution. Because

all relevant marketing information is in one place, there are fewer misaligned
investments. Centralization leads to tighter controls over which marketing
programs are launched. As a result, greater operational efficiencies are gained,
allowing marketers to get to market rapidly and spend more time on strategy.

v Improve decision making, minimize risk. The marketing measurement
provided by using IBM Unica Marketing Operations enables marketers to focus
on the most profitable opportunities. Additionally, marketers make better tactical
decisions because the marketing mix is more easily optimized.

© Copyright IBM Corp. 2002, 2012 1



v Ensure that strategic goals and marketing activities are aligned. Strategic goals,
marketing plans, and budgets are centralized to promote clarity of agreed upon
objectives and tactics to achieve business goals. The result is improved
alignment of marketing plans and activity.

v Achieve faster, lower-cost execution of all marketing activities. Rather than
reconciling individual project plans, chasing down approvals, and manually
tracking creative changes, project plans and assets are centralized, and approvals
are clear and automated. Waste is eliminated, because better execution results in
less duplication of effort, fewer fees and penalties for completing tasks in a rush,
and allocation of resources to the right programs.

v Ensure compliance. By using the centralized repository and advanced reporting
capabilities in IBM Unica Marketing Operations, marketers reduce time and
money spent satisfying the needs of regulatory agencies, corporate auditors, and
management.

v Open, flexible architecture. IBM Unica Marketing Operations is based on an
open architecture that makes it easy for IT to implement and allows you to
leverage your existing infrastructure and data. Marketing Operations uses a
3-tier J2EE architecture, which separates the client, web server, application
server, and backend data sources.

Who uses IBM Unica Marketing Operations?
Your marketing department and any outside interested parties can benefit from
using IBM Unica Marketing Operations. People who benefit include the following.
v Executives who want to create strategic plans and manage their set of core

marketing metrics.
v Executives outside the group who need visibility into group activities.
v Senior managers who contribute projects, allocate resources, and monitor critical

events, metrics, and components.
v Managers for lines of business, channels, or geographies who need to define and

track projects, automate the approval process, and track costs.
v Brand managers and advertising executives who want visibility into the entire

corporate communications plan.
v Database marketers who create activities and tasks, track “To Do” lists, and

send, receive, and monitor notifications.
v Team members who carry out the plan.
v External vendors who have a role in the marketing plan.

Integration with IBM Unica Campaign
Marketing Operations optionally integrates with IBM Unica Campaign, which, in
turn, can integrate with several other products. When Marketing Operations and
Campaign are integrated, you can use the marketing resource management
features in Marketing Operations to create, plan, and approve campaigns.

For information about working with an integrated system, see the IBM Unica
Marketing Operations and IBM Unica Campaign Integration Guide.
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Using IBM Unica Marketing Operations

Before you start using IBM Unica Marketing Operations, your administrator must
install Marketing Operations and set it up. If you are having problems, contact
your administrator.

The following steps outline some of the major tasks users perform in IBM Unica
Marketing Operations.
1. Create plans that contain programs.
2. Create programs that contain projects.
3. Create more projects, request a project, accept a request, start a project, or view

projects.
4. Work with projects by navigating through them, completing the setup of

workflows, viewing and modifying tasks, and printing, copying, and deleting
the projects.

5. Work with assets, including adding, editing, and changing the status of assets,
as well as adding folders.

6. Work with approvals, including adding an approval process; submitting it for
review; canceling the review; modifying, printing, and deleting it; putting the
approval on hold; responding to it; and marking up approval items with
comments.

7. Create invoices that keep track of expenses related to programs and projects.
8. Search for projects and approvals using both the standard and advanced search

capabilities, and save advanced searches for future use.
9. Collaborate with other users using the alerts window and the message board.

Business processes
A business process is the representation, in IBM Unica Marketing Operations, of a
collection of related, structured activities (a chain of events) that produce one of
the following.
v marketing activities targeted at a particular set of prospects and/or customers
v reusable marketing components that support these marketing activities.

IBM Unica Marketing Operations provides the following types of business
processes.
v Plans
v Programs
v Projects
v Subprojects
v Project requests
v Approvals

Relationship of planning objects

This section details how planning objects (plans, programs, and projects) relate to
one another. Plans contain one or more programs, and programs contain one or
more projects.

Projects can contain subprojects. A budget for a plan consists of individual line
items for projects and programs that roll up into the budget for the plan.

Chapter 1. Introduction 3
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On the summary page of projects and programs, there is a field, Parent Items and
Code, that contains a view of the ancestors for the object. For example, the
summary page of a subproject shows the current object (a subproject), its parent
project, and all of its ancestors back to its root plan. The ID codes for these objects
are displayed, as well as direct links to each of the ancestor objects.

Plans
A plan is intended to capture the objectives of a given business unit/area, for a
given period of time, typically measured yearly or quarterly. Additionally, a plan
serves as a container and "rollup" point for the various programs and projects that
you define in order to meet your marketing goals.

Information from "child" programs and child projects of the programs roll up to
the plan, tracking linked information. For example, for a plan that has a child
program, you can make metrics or budget information related to the program roll
up—or move upwards from the program—to the plan, so that you can study and
keep track of this information from the perspective of the plan.

Programs
A program represents a marketing activity and it is typically comprised of multiple
related marketing deliverables or initiatives. A program can contain or group
multiple projects. The program itself has information that is central or common to
the development and execution of these marketing deliverables. For example, a
direct marketing program could contain multiple projects each representing a
distinct marketing promotion or campaign. Also, a product launch program could
contain projects pertaining to various types of collateral development, analyst
briefings, and tradeshow attendance.

Projects
A project represents all the information related to developing and executing one or
more related marketing deliverables or initiatives. This information can include a
checklist or schedule of tasks that people working on the project must perform in
order to prepare and produce the deliverables for the project.
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For example, you might use a project called Monthly Tradeshow to collect all the
information needed for the one tradeshow each month that your organization
attends. This information could include who attends the show, what equipment
you need in the booth, copies of demos of the product that you intend to present,
collateral you want to hand out to customers, costs of promotional materials, and
any additional information that pertains to the tradeshow.

Note: Projects can have subprojects. A subproject has all the same characteristics
as a project. A subproject is linked to a parent project; any project linked in this
manner is referred to as a subproject.

Project structure

A project contains a workflow, budget information, metrics, digital assets,
approvals, and both standard and custom information. Of course, not every project
needs all of this information; most of it is optional and can be filled in only when
needed.

Note: Note that approvals can also exist independently from projects. That is, an
approval does not need to be associated with a particular project.

Project requests
A project request is similar to a work order or creative brief. It represents a
request for someone else to do work according to the specifications supplied by the
requester.

Users within an organization and outside vendors can request a project. For
example, an outside vendor can submit a project request to the marketing services
organization requesting some collateral. The marketing services representative
accepts the request and creates a project, organizing tasks and assigning resources
to the project in order to manage the creation of the collateral.

If you request a project, you are a requester. You then submit the request to a
recipient for approval. When the recipient accepts the request, the recipient owns
the resulting project and is called the owner.

Note: A project request does not contain a workflow. When the request is
approved and transitions to a project, it contains the appropriate workflow.

Approvals
An approval allows you to streamline and track the process of having your work
reviewed and approved. This feature allows many users to review work in parallel
or in an order that represents your business processes. Reviewers (or approvers)
can electronically mark up content submitted for review. IBM Unica Marketing
Operations then records approvals and denials for audit purposes. You can tie
approvals to a project or they can exist independently from any project.

Collaboration tools
Use the following IBM Unica Marketing Operations functionalities to communicate
information to other users.
v “Teams” on page 6
v “Alerts” on page 6
v “Attachments” on page 6
v “Message Boards” on page 6
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v “Metrics” on page 7
v “Workflows” on page 7
v “Functional roles” on page 7
v “Security policies” on page 7

Teams
A team is a group of people who work together to complete tasks across a number
of different business processes. Someone in charge of a business process can assign
tasks to a team, rather than an individual, when necessary.

Team leaders can then manage their resources across initiatives. Team leaders can
decide to explicitly assign work to team members or allow team members to assign
work to themselves. In all cases, the team leader can monitor the queue of work
assigned to their team and track the progress and performance of individual team
members.

Alerts
Alerts are notifications of important events or actions you need to take regarding a
program, project, a project request, asset, account, approval, or invoice. An alert
could remind you that a project is running behind schedule or over budget, or that
there is an item that needs your approval.

You receive alerts directly through IBM Unica Marketing Operations and through
email. When you receive an alert through Marketing Operations, you go to the
Alerts page to view it. When you receive an alert through e-mail, it goes directly to
the inbox of your e-mail application.

There are two types of alerts in IBM Unica Marketing Operations.
v alerts that Marketing Operations sends based on events, such as the start of a

project, or
v alarms that an administrator sets up to send at regular intervals, such as once a

day.

Attachments
Team members can attach relevant documents to the main IBM Unica Marketing
Operations objects. An attachment is a URL, digital asset, or a file that you add to
a Marketing Operations object. You can add attachments to plans, programs,
projects, invoices, approvals, and accounts.

Attachments can be organized by category. For example, your project might
contain the following attachment categories.
v Reference Materials
v Vendor Forms
v Offer Creatives
v Deliverables

The attachment categories are set up in the template used to create the particular
object.

Message Boards
A message board is a place to post and read messages pertaining to a particular
object. Plans, programs, projects, requests, accounts, approvals, and invoices can
each have their own message board.
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Useful for less formal collaboration, message boards allow team members to log
comments and keep track of responses.

Metrics
Metrics are used for management reports and analysis. You view them on the
Tracking tab for plans, programs, and projects.

Use IBM Unica Marketing Operations metrics for the following calculations.
v Automatically calculate internal measures (such as budgets and resource

consumption).
v Automatically tabulate program results, such as the following.

– Measure consistently across activities.
– Aggregate results across programs.

v Automatically link key metrics (such as number of contacts and responses) from
campaigns back to project metrics.

v Build a marketing memory.

The metrics that are available in a plan, program, or project depend on the
template you used to create it.

Workflows
A workflow allows you to view and edit the group of tasks and milestones that
drives the project. It allows you to efficiently meet and manage project goals.
Tasks, dependencies, and durations are populated for a workflow based on the
template used to create it. You can view workflow information as either a
spreadsheet, timeline, or process flowchart. You can use workflows to forecast and
plan your activities. Once work has begun, workflows make it easy to monitor
progress and identify bottlenecks.

Functional roles
When setting up a project, one part of that process is assigning individuals to tasks
based on the individuals’ functional role or job role, such as writer, graphic artist,
or project manager. IBM Unica Marketing Operations uses the concept of roles as a
bridge between people and tasks. Roles are useful for the following reasons.
v People come and go: assigning a role to a task makes it easier to control people

leaving and returning a project.
v Resources are not always available: you can assign a role to a task before any

people are available to fill the role or perform the task.
v Roles are predictable: you can create project templates with standard roles and

fill people into the roles independently for each project you create from the
project template.

Security policies
A security policy is a set of rules that govern any objects (such as projects or
programs) that are associated with the policy. These rules indicate which types of
users will be able to view, modify, delete or perform any of the other relevant
functions for these objects.

In order to express these rules, security policies contain tje following.
v user roles to identify the types of users, and
v function grants or blocks to identify what each type of user can or cannot do.

Multiple Security Policies are allowed, and one example security policy, Global, is
provided with IBM Unica Marketing Operations.
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The global policy is a special policy that is always considered in the governance of
all objects in the system (rather than all users). Companies with simple security
models need only utilize the global policy to express their rules.

Companies that require different groups to be kept in discrete groups from one
another will utilize custom security policies to do so, and use the global policy
only for system-wide administrative or executive access rules.

Note: The term global is not intended to indicate that every user has full (global)
access to everything, but rather that the security policy is, by default,
globally-associated with every user.

Details of security policies are discussed in the IBM Unica Marketing Operations
Administrator’s Guide.

Strategic planning and financial management
IBM Unica Marketing Operations includes strategic planning and financial
management functionality that allows you to do the following.
v Develop top-down budgets for marketing plans and the programs they contain.
v Track actual expenses incurred, with respect to budget.
v Facilitate spend tracking and reporting in Accounting (GL) terms.

In IBM Unica Marketing Operations, you use the following to perform Strategic
Planning and Financial Management tasks.
v Accounts
v Budgets
v Cost Categories
v Invoices

Accounts: A top-level account represents a specific corporate general ledger
account established by a finance department for the purpose of tracking and
controlling expenditures and cash flows for a certain area of the business. This
account tracks budget needs and expenditures at weekly and monthly levels and
then aggregates them to quarterly and yearly levels.

Accounts may have subaccounts. Depending on the account structure at your
company, the subaccounts also may represent specific general ledger accounts, or
they may have been created to represent a greater level of granularity that
marketing wants to track, even if the general ledger structure doesn't include that
level of detail.

Budgets: In IBM Unica Marketing Operations, a budget allows you to plan
expenses that will occur as you execute your plan, program, or project. After
setting the plan budget, you can fund linked programs, and ultimately projects,
from it. Marketing Operations tracks budgets of child programs and projects in the
form of allocations, forecasted or committed spending, and actual expenses.

IBM Unica Marketing Operations tracks budgets of child programs and projects,
although these objects can have different owners. For example, a program linked to
a plan can have a different owner than the plan itself. As such, the person who
allocates a budget from a plan down to a program can be different from the person
forecasting expenses from a program up to a plan. Marketing Operations allows a
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plan owner, a marketing manager for example, to track expected expenses from
child programs and projects as well as the plan budget itself, and remain
responsive to budgetary needs.

Note: Budgets are available only when the Marketing Operations financial module
is enabled.

Fiscal year

You can view the total budget for all years, or see a detailed view for a particular
year broken down into weeks, months, or quarters.

IBM Unica Marketing Operations keeps budget information for the current fiscal
year, the next two fiscal years, and any past fiscal years dating back to when you
first installed Marketing Operations.

On the plan level, to view or edit a different fiscal year, change the Fiscal Year
field value on the Plan Summary tab. Linked programs and projects take the
financial year from the parent plan; stand-alone programs and projects use the
system's current fiscal year.

Granularity

With IBM Unica Marketing Operations, you can break fiscal years into weeks,
months, or quarters. When creating a plan, program, or project, choose the wanted
increment from the Budget Granularity list on the Summary tab.

Users are not allowed to edit budget granularity. Plans, programs, and projects
with different budget granularities are not allowed to be linked together.

For example, if a plan’s fiscal year is broken into months, you can only link it to
programs and projects that also use months as the budget granularity. In this
scenario, programs and projects with weeks or quarters as their granularity are
unavailable for linking.

For more information about linking plans, programs, and projects, see “To link a
program to a plan” on page 27, “To link an existing project to a program” on page
33, and “To link a child project or request to a project” on page 50.

Cost categories: Cost Categories are used to categorize expenses into types, such
as travel expense, mailing expense, and so on. For details on creating and editing
cost categories, see the IBM Unica Marketing Operations Administrator’s Guide.

Cost categories are used both when tracking invoices and creating budgets.

Invoices: In IBM Unica Marketing Operations, an invoice electronically captures a
paper invoice submitted to a marketing department for services, time, or materials
provided by a third-party vendor or supplier. You must manually enter the
information captured in paper invoices into an Marketing Operations invoice.

Here are some advantages of transferring your paper invoices to IBM Unica
Marketing Operations.
v Easy accessibility
v Accurate and immediate expense tracking
v Vendor spend analysis
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v Rollup reporting
v Periodic transfer or export to a general ledger (GL) system

Libraries of reusable elements
IBM Unica Marketing Operations allows you to reuse marketing items by
providing the following.
v Marketing objects
v Digital Asset Management

Marketing objects: You can create new marketing objects if you have permission
to do so. After you create a marketing object, you can start it at any time. Starting
the marketing object makes it active.

A marketing object is any work product a team develops and reuses in the course of
its marketing activities. A marketing object can represent a physical item (such as a
letter, credit card, or banner ad), or a business component (such as a credit card
offer, a target segment definition, or a rewards program definition).
v You define and manage marketing objects that represent all reusable work

products.
v You can perform basic operations (create, edit, change state, copy, link, and

delete) on marketing objects.
v You enter and manage all of the attributes that define a particular marketing

object, such as name, owner, state/status, description.
v You can define and manage business processes (such as projects) that produce,

modify, and retire marketing objects.
v You can construct robust projects which define multiple marketing activities by

“assembling” each discrete marketing activity from existing marketing objects.

IBM Unica Marketing Operations marketing objects are defined in stages, and how
they are defined influences how they are organized and presented to users. The
following terms are important in understanding the definition and organization of
marketing objects.

Marketing object type

A marketing object type is the highest-level division for marketing objects. An
administrator creates marketing object types. Each marketing object type has a
menu item, but the menu on which it appears depends on how the administrator
configured the marketing object type.

Marketing object template

A marketing object type is broken down into one or more marketing object templates.
Typically, an administrator creates a marketing object template for each significant
characteristic for the marketing object type.

Marketing object instance

A marketing object instance is a single marketing object. Users with appropriate
security permissions create marketing object instances from marketing object
templates. Marketing object instances are called “marketing objects” in this guide.
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Digital asset management: An asset is any electronically stored document that
you may want to use or reference in a marketing program. This can include brand
images, marketing research documents, reference materials, corporate collateral,
letterheads, or document templates.

You can store all marketing assets in a secure, central location, using IBM Unica
Marketing Operations Assets, with the following advantages.
v leverage concepts that were approved in previous marketing campaigns
v require pre-approval of material to reduce review times
v assign usage guidelines and expiration dates to items.

Additionally, assets contained in Approval objects have integrated mark-up
capabilities, enabling collaboration between staff and agency partners and tracking
of comments, edits, and changes within creative content.

To sign in to IBM Unica Marketing Operations

To use IBM Unica Marketing Operations, you must sign in. If you are uncertain of
the correct URL or you need a user name or password, contact your administrator.
1. Open your web browser.

Note: If you are using a Safari browser, and you are experiencing cache-related
problems, for example, icons have been updated but new ones are not showing,
you can manually empty the cache by pressing Command+Option+E or
choosing Empty Cache from the Safari menu.

2. In the address field of the browser, enter the web address (URL) for IBM Unica
Marketing Operations. For example:
http://unicaserver:7001/MktOps/

3. If your administrator set up security for IBM Unica Marketing Operations, the
application prompts you to accept a digital security certificate the first time you
log in. Click Yes to accept the certificate.
The IBM Unica Marketing Operations sign in screen appears.

4. Enter your user name and password, then click Sign In.

If your sign in is successful, IBM Unica Marketing Operations displays the main
application screen. Depending on how your administrator configured your options,
you may see the Programs List page or the Projects List page.

About customizing Marketing Operations

You can customize the Marketing Operations interface to meet your needs.
Customization settings are available in Marketing Operations when you click
Settings or Settings > Marketing Operations Settings. The following table
describes what you can customize.

Table 1. Options for customizing Marketing Operations

Option Description

Set current page
as Home

Set the current page to display automatically as soon as you log in to
Marketing Operations.

Basic Settings Set the security policy to apply to new items by default.

Assets Options Define the asset list to show by default.
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Table 1. Options for customizing Marketing Operations (continued)

Option Description

Approvals
Options

Define the approval list to show by default.

Projects Options Define the project list and view to show by default for projects.

Tasks Options Define the task list and view to show by default for tasks.

Operational
Analytics Options

Set a default report to display when you go to the Analytics >
Operational Analytics page, and set the Analytics home page as your
login page.

Calendar/
Timeline Settings

Select options to customize how you view the calendar and task
milestones. See “Setting the appearance of the calendar” on page 117.

Out of Office
Settings

Define whether you are in or out of the office and identify delegates.

You (or another user with the appropriate permission) also can set up dashboards
to show the information that you need to view most often. Each dashboard can
include one or more "list portlets" to present lists such as Approvals Awaiting
Action, Manage My Tasks, and My Alerts. For more information, see “Marketing
Operations list portlets” on page 181.

Setting your start page
If you do not want a dashboard page to appear when you first log in to IBM Unica
Marketing, you can select a page from one of the installed IBM products as your
start page.

To set a page you are viewing as your start page, select Settings > Set current
page as home. Pages available for selection as a start page are determined by each
IBM Unica Marketing product and by your permissions in IBM Unica Marketing.

On any page you are viewing, if the Set current page as home option is enabled,
you can set the page as your start page.

Setting your basic settings

The basic settings option allows you to choose the security policy used by default
when you create new items.
1. Select Settings > Marketing Operations Settings.

The Administrative Settings page opens.
2. Click Basic Settings.

The Basic Settings page opens.
3. Select the security policy you want to use by default when you create new

items in Marketing Operations in the Default Security Policy field.
You can leave Global selected, which is the default, to use the global security
policy defined by your administrator, or you can select a security policy that
your administrator instructed you to select. As a best practice, do not change
the security policy without the guidance of your administrator. For more
information about security policies, contact your administrator or see the
Marketing Operations Administrator's Guide.

4. Click Save Changes to save your changes.
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Setting your approvals options

The approvals options allow you to customize Marketing Operations so you view
and receive information about approvals that is important to you.
1. Select Settings > Marketing Operations Settings > Approvals.

The Approvals Options page appears.
2. In the Default List field, select the default Approval List view that you want

to appear when you open the approval list page.
By default, the My Active Approvals view appears in this field; the result is
that Marketing Operations displays only your active approvals when you select
Operations > Approvals.
If you have any saved searches, this list also includes that information.

Setting your projects options

Projects options allow you to customize Marketing Operations so you view and
receive project information that is important to you. For example, you may want to
specify the list of projects that appears by default when you open the Projects
page.

You set project options through the Options icon ( ) on the Projects page. A
subset of these options is also available through the Administration page.
1. Select Operations > Projects.

2. Click the Options icon ( ).
The Projects Options page appears.

3. In the Default List field, select the default project list view to appear when you
open the project list page.
By default, the Active Projects and Requests view appears in this field (unless
you previously changed the setting.
If you have any saved searches, this list also includes that information.

4. In the Default View Mode field, select the default list view mode that appears
when you open the Projects page. You can display projects in a list view or a
calendar view.

5. In the Optional Project Columns field, select any optional project columns to
add to the current project list view.

Note: The columns that you select here appear only on this specific project list
view.

6. Click Save Changes to save your changes.

The settings you chose remain in effect for all of your Marketing Operations
sessions.

About optional project columns
For Project List view pages, you can customize which columns appear in the list.

When you select optional columns, note that you select them for a particular view.
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For example, if you select an optional column called Objectives in the Active
Projects and Requests view, this column does not appear in the All Projects and
Requests view.

The column choices in the Optional Columns field include all fields used in all
project templates in the system. Template creators define fields in project templates.
Some projects that appear in the Project list view may have been created with a
project template that did not contain a certain field. If a project does not have a
field defined, there will be no value in the corresponding column on the project list
view.

If you are in the Project Calendar view instead of the Project List view, in the
Optional Information to Show field, select any optional project milestones or
project start and end dates that you want to view. These milestones and dates
appear in the calendar.

Setting your tasks options

Your tasks options allow you to customize Marketing Operations so you view and
receive task information. For example, you can specify the list of tasks that appears
by default when you open the Tasks page.
1. Select Settings > Marketing Operations Settings > Tasks Options.

The Task Options page opens.
2. For the Default List, select the default Task List view that you want to appear

when you open the Tasks list page.
By default, the My Tasks view appears in this field, so Marketing Operations
displays only tasks currently awaiting your action when you click Operations >
Tasks.
This list also includes saved searches.

3. For the Default List View, select the default list view mode that you want to
appear when you open the Tasks page. You can display tasks in a list view (the
default) or a calendar view.

4. Click Save Changes to save your changes, Revert to Saved to discard the
changes you made since the last time you saved changes, or Cancel to exit.

Setting your operational analytics options

By default, the Analytics Home page shows a list of all available reports. You can
set a different report to display when you go to the Analytics Home page.
1. Select Settings > Marketing Operations Settings.
2. Click Operational Analytics Options.

The Analysis Options page appears.
3. Select the report you want as the default report.

If at any time the report you select is not available, the list of all available
reports is displayed.

4. Click Save Changes.

Defining out of office settings

Out of office settings help ensure that there is coverage for your tasks, approvals,
and requests when you are out of the office.
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1. Select Settings > Marketing Operations Settings. The Administrative Settings
page opens.

2. Click Out of Office Settings. The Out of Office Settings page opens.
3. At the top of the page, indicate whether you are currently in or out of the

office. Your selection goes into effect when you click Save Changes.
4. Specify the Marketing Operations user who covers for your responsibilities

when you are out of the office. You can specify the same user or different users
for:
v Workflow Tasks and Approval Tasks: only tasks that are ready to start are

assigned to your delegate when you are out of the office. Tasks with other
statuses that are assigned to you are not automatically reassigned to your
delegate.
Your system administrator defines whether you can select any other user as a
delegate, or only a user who is already a member of the same project teams
and with appropriate permissions. If your system or any of your projects
uses the more restrictive setting, an error displays if you attempt to delegate
tasks to a user who cannot perform them.

v Standalone Approvals and Budget Approvals: approvals that are waiting for
your response are assigned to your delegate while you are out of the office.
An error displays if you attempt to delegate approvals to a user who cannot
respond to them.

v Project Requests: requests that are waiting for your response are assigned to
your delegate while you are out of the office.
An error displays if you attempt to delegate project requests to a user who
cannot respond to them.

5. Enter an optional message to include with all of the activities that are delegated
while you are out of the office.

6. Click Save Changes.
When you indicate that you are Out of Office:
v The Item Delegation History at the bottom of this page logs all of the

activities that are delegated in your absence.
v A reminder displays each time you log in to Marketing Operations.

Chapter 1. Introduction 15



16 IBM Unica Marketing Operations: User's Guide



Chapter 2. Common tasks

Some tasks are not specific to IBM Unica Marketing Operations objects. For
example, several different types of objects can contain attachments. You work with
project attachments in the same way as you work with program or plan
attachments. This section describes:
v “Working with attachments”
v “Statuses of business processes” on page 19
v “Using disabled attribute values” on page 20
v “Selecting resources” on page 22
v “Using Save and Return to List” on page 22
v “Column headers” on page 22
v “To print an object” on page 22
v “To export information in Microsoft Excel format” on page 23

Working with attachments
You can attach relevant documents to IBM Unica Marketing Operations objects
(such as plans, programs, and so on). The Attachments tab of an object contains
links to all files or URLs related to the object.

IBM Unica Marketing Operations automatically creates a thumbnail for documents,
images, PDFs, and web pages when these items are attached or sent for approval.
Files types supported are as follows.
v BMP
v Doc
v Docx
v GIF
v htm
v html
v JPEG
v JPG
v pdf
v ppt
v pptx
v RTF
v xls

Note the following limitations.
v By default, IBM Unica Marketing Operations allows you to attach up to five files

at once. This number is configurable, and may be different in your system.
v Attachment size is limited to under 2 gigabytes (GB) in size. The exact limitation

depends on your browser and operating system.
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To add an attachment to an object

Users can add attachments on an ongoing basis.
1. Navigate to the object to which you would like to add an attachment.
2. Click the Attachments tab.

The tab displays any attachments that are already present for the object.

3. Click the Add icon ( ) to add an attachment to the object.
The Add Attachment window appears.

4. From the drop-down list in the Save Attachment To field, select where you
want to save the attachment.

5. In the File to Attach field, select From My Computer, From the Asset Library,
or URL.

6. Do one of the following.
v Click Browse to search for a file on your computer. When the dialog box

appears, navigate to the file you want to attach, and click Open.
v Click Browse Library to attach a file in an asset library. Click the library that

contains the file you want to add. Use the tree in the left pane of the screen
to navigate to the folder and then the asset that you want to attach. Click
Accept Asset when viewing the asset in the right pane.

v Enter the URL in the field provided.
7. Add any comments about the attachment.
8. Click Add More to display an additional set of fields for each additional

attachment you want to add.
9. Click Save Changes to add the attachment or attachments.

The attachments are added to the Attachments tab for the object.

To remove an attachment from an object
1. Navigate to the object to which you would like to remove an attachment.
2. Click the Attachments tab.

The tab displays any attachments that already exist for the object.
3. Click Remove beside the attachment you would like to delete.

A message appears asking you to verify the deletion.
4. Click OK.

The attachment is removed.

To send e-mail attachments

Users that have a valid e-mail address configured in IBM Unica Marketing
Operations or IBM Unica Marketing Platform can send e-mail attachments. If your
e-mail address is configured incorrectly in the system, you receive an error
message.
1. Navigate to the object to which you would like to add an attachment.

For approvals and assets, attachments are available on the summary page. For
all other objects, click the Attachments tab.
The tab displays any attachments that already exist for the object.

2. Click Send as Mail Attachment beside the attachment you would like to send.
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You can also right-click the attachment icon and choose Send as Mail
Attachment from the menu.
The Send Mail Attachment window appears.

3. Enter or select values in the To and Cc fields for the email recipients.
v To send the attachment to IBM Unica Marketing Operations users, click the

arrow at the right side of the field and select one or more email addresses.
The addresses you select are added to the field. If you deselect an address, it
is removed from the field.

v You can also enter any valid external email address in the fields. Separate
multiple addresses by a comma. For example:
user1@inbox.com,user2@myCompany.com

4. Enter values for the Subject field and body of the message.
5. Click Send to send the attachment.

The system displays a message that confirms that the e-mail has been sent or
that an error occurred while the system attempted to send the message.
The Send Mail Attachment window remains open until the e-mail server has
sent the message. If you close the window while the mail is being sent, you do
not receive any confirmation.

Note the following.
v Any replies to the message go directly to the e-mail address of the sender.
v If you sends an attachment to an invalid address, a message is sent to the user

that the e-mail was not delivered.
v If the mail server is down (for the Marketing Operations server), the system

displays a message that the attachment could not be sent. You can take either of
the following actions:

v If the mail is accepted by the e-mail server for delivery, and it cannot be
delivered for any reason (for example, if an email address is invalid) the e-mail
server sends the details directly back to the user in the local client e-mail
application.

Statuses of business processes

The following table describes the possible statuses for plans, programs, projects,
and approvals.

Status Description

Not started Indicates the object has been created.

In progress Indicates work on the object has been started.

On hold Indicates work on this object should not continue at this time.

Cancelled Indicates that no users should access the object; work on it has been
stopped permanently.

Completed Indicates that work on the object is finished.

In Reconciliation (Projects only). Indicates someone is editing a cancelled or completed
project. This is a temporary state available to users having the proper
security permission.
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To change the status of a process

You can change the status of a business process, to control its lifecycle. Your
administrator can set up IBM Unica Marketing Operations to send an alert to
owners and members of a process when its status changes.

The following procedure describes how to change the status for plans, programs,
projects, marketing objects, and approvals.
1. From the appropriate navigation menu, select the object type.

For example, click Operations > Plans to work with a plan.
2. Click the object you want to change.

The object’s Summary tab appears.

3. Click the Status icon ( ) and select a status. The options that display
depend on the current state of the object, as follows.
v Start <object> (or Submit <object> for requests and approvals) changes the

status to In Progress.
v Pause <object> (or Stop Review for an approval) changes the status to On

Hold. Available for In Progress objects.
v Continue <object> changes the status to In Progress. Available for On Hold

objects.
v Finish <object> changes the status to Completed. Objects in this status cannot

be changed to any other status, except for projects, which you reconcile after
completing.

v Cancel <object> changes the status to Canceled. Select this option to cancel
the object permanently. Objects in this status cannot be changed to any other
status, except for projects, which you reconcile after canceling.

A dialog box displays "Changing status to" and the new status for the object.
4. Add comments.
5. Click Continue to close the dialog box and apply the new status.

Using disabled attribute values
Throughout IBM Unica Marketing Operations, users select an item or items from a
drop-down list. Over time, the items in the lists can change; administrators can
add, remove, or disable items from drop-down lists. When an administrator
disables an attribute, it affects the behavior of Marketing Operations in the
following ways.
v When users perform advanced searches.
v When users edit an existing object that contains a disabled value in one of its

drop-down lists.

Disabled attribute values in objects
When an administrator disables an attribute value, it no longer appears in
drop-down lists for new objects. However, users need to consider disabled values
in the following situations.
v A user edits a tab for an existing object with an attribute that is set to a disabled

value. The attribute is optional.
If the user edits the attribute, he or she must select an enabled value. However,
the user can save the page without editing the attribute (that is, the attribute can
be saved with the existing, disabled value).
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v A user edits a tab with an attribute that is set to a disabled value. The attribute
is required.
The user must select an enabled value for the attribute. The system does not
allow the user to save the data until an enabled value has been set for the
attribute.

v A user creates a new object. One tab contains an optional attribute that has a
disabled, default value.
The attribute is set to a blank value.

v A user creates a new object. One tab contains a required attribute that has a
disabled, default value.
The system presents an error message that the attribute is required. The user
cannot finish creating the object until he or she sets the value of the required
attribute.

Disabled attribute values in searches
When users search on an attribute that contains disabled values, they can select
from both enabled and disabled values. This allows users to find objects that
contain values that may no longer be used.

Disabled attribute values example

Consider a project template, Marketing Collateral, which contains a tab,
Production Info. Production Info contains several attributes, including a required
attribute, Color, and an optional attribute, Coating. The attributes have the
following values:

Color (required) Coating (optional)

(default value)

4C

4/4

Black and White

Gloss Aqueous (default value)

Dull Aqueous

UV Coating

Etched

Tom creates a marketing collateral project, MC001, and sets the Color to 4/4 and
the Coating to Dull Aqueous.

An administrator then disables the 4/4 and Dull Aqueous values.

Tom opens the MC001 project, and edits the Production Info tab:
v He can leave the Coating value as Dull Aqueous, or set it to any of the enabled

values, such as Etched.
v He must change the value of Color to one of the enabled values before he can

save the Production Info tab.

The administrator re-enables 4/4 and Dull Aqueous values, and disables the
default value (Gloss Aqueous).

Tom creates a marketing collateral project, MC002:
v The value of Coating is blank.
v Tom must select a valid value for Color before he can finish creating MC002
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Selecting resources
Throughout IBM Unica Marketing Operations, users can select people and teams
as resources. Users add and remove members to planning objects, marketing
objects, assets, invoices and approvals. When users perform advanced searches,
they can add people and teams to the search criteria.

Note: The list of people available in IBM Unica Marketing Operations is populated
from IBM Unica Marketing Platform. Administrators can limit the list of teams and
people a particular user sees, depending on the role and permissions for the user.

Using Save and Return to List
When you create or edit a project, request, or marketing object, you can save your
work at any time. If you click Save and Return to List, your work is saved and
you see a list, saved search, default search, or summary page, as described here.
v If you start a wizard from a saved search or list page, you return to that page.
v If you start a wizard from the Actions menu, you return to your default search

page for the object type.
v If you start a wizard from the Manage Linked Objects menu, you return to the

Summary page of the parent program.
v If you edit an existing object you return to the saved search page, if that is

where you initiated the edit, or the default search page if you initiated the edit
from the summary page of the project or request.

Column headers

Many IBM Unica Marketing Operations pages display a summary table with rows
that contain objects (such as program, plans, and tasks), and columns that contain
characteristics for the object (such as name, status, and owner).

In these pages, you can click the column headers to sort or group the table on the
selected column. Clicking a second time on the column name reverses the sort
order.

You can determine how data on the page is sorted.

v If a column contains the symbol, data on the page is sorted in ascending
order based on the contents of this column.

v If a column contains the symbol, data on the page is sorted in descending
order based on the contents of this column.

v If the current sort column is any column other than Name, the list is sorted by
current sort column, then by the Name column.

To print an object

You can print the current page for many IBM Unica Marketing Operations objects.
Use the following procedure to print any of these objects: accounts, approvals,
invoices, plans, programs, projects, and marketing objects.

IBM Unica Marketing Operations prints the information found on the tab currently
showing.
1. Navigate to the Summary tab of the object to print.
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2. Select the tab to print and click the Print icon ( ) on the Marketing
Operations toolbar.
For some objects, a drop-down menu displays with two choices: Print and
Export.

3. If the menu appears, click Print.
A print dialog appears.

4. Complete the fields in the dialog and click Print.

The data on the screen prints to the selected printer.

To export information in Microsoft Excel format

You can export information from IBM Unica Marketing Operations to an Excel
spreadsheet for programs, projects, and project requests.

Note: You cannot export Tracking, People, Attachment, Workflow, Budget, or
Analysis tabs to Excel.

In particular, you can export the Summary tab or a custom tab. From the Program
or Project List page, you can export summary information for multiple programs,
projects, or requests.

When you export list pages for programs, projects, tasks, and marketing objects, all
the items in the list are exported, even if the list spans multiple pages.
1. You can export information for a single object or for a list of objects.

v To export information to Excel for a single object, navigate to Summary or
custom tab of the object.

v To export a list of objects to Excel, click Operations > Programs or
Operations > Projects and open the view you want to export.

2. Click the Print icon ( ) and select Export from the drop-down menu.
A window displays, asking whether to Open or Save the file that will be
exported. If you are exporting a list, IBM Unica Marketing Operations prints
information about all the objects in the current view of the list page.

3. You can either open the item in Excel, or save it to disk.
v Click Open to launch Excel. The information you exported displays on the

spreadsheet.
v Click Save to save the file. You can then open the Excel spreadsheet,

displaying summary information about the object or list of objects.
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Chapter 3. Plans

A plan is intended to capture the objectives of a given business unit/area, for a
given period of time, typically measured yearly or quarterly. Additionally, a plan
serves as a container and "rollup" point for the various programs and projects that
you define in order to meet your marketing goals.

Information from "child" programs and child projects of the programs roll up to
the plan, tracking linked information. For example, for a plan that has a child
program, you can make metrics or budget information related to the program roll
up—or move upwards from the program—to the plan, so that you can study and
keep track of this information from the perspective of the plan.

Plan views
IBM Unica Marketing Operations organizes plans in views.
v The All Plans view lists all plans. It also contains links to the Active Plans view.
v The Active Plans view lists all plans currently in the In Progress state. The

Active Plans view is the default view.

You can access the different plan views from the Actions menu. This menu
contains a link to each of the plan views. In either view, you can change the sort
order by clicking the column you want to sort by. Click the column a second time
to reverse the sort order.

Additionally, you can search for a plan.

Summary information for plans
On the plan Summary tab, IBM Unica Marketing Operations lists summary
information about a plan, such as status, program areas, and security policy. By
default, the plan Summary tab displays when you select a plan from the Plan List
page. Any programs linked to the plan are listed on the Summary tab. You can
perform tasks such as changing plan status, editing the plan, adding a new
program, linking an existing program, or removing a linked program.

Fiscal year for plans
When you add or edit a plan, you choose its fiscal year from a drop-down list. You
can edit budget information for the fiscal year you choose. IBM Unica Marketing
Operations keeps multi-year budget data for plans. The system keeps budget
information for the current fiscal year, the next two fiscal years, and any past fiscal
years dating back to when you first installed IBM Unica Marketing Operations.

Viewing budget information

The budget information that you view in Total mode is for the life of the plan. The
budget information that you view in Detailed mode is for the specified fiscal year.
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Editing budget information

Budget information that you edit on the Budget tab corresponds to the selected
fiscal year. You can edit only the budget for one fiscal year at a time. To edit
budget data for a fiscal year, edit the Fiscal Year value on the summary page for
the plan; set the value to the fiscal year that corresponds to the budget data you
want to edit.

To add a plan

When you add a plan, you become an owner of that plan.
1. Click Operations > Plans.

2. Click the Add Plan icon ( ).
3. Enter a plan name in the Name field.
4. Enter a description of the plan in the Description field.
5. Click Add/Remove Members to add team members to the plan.
6. Select Auto-generate on save, or Enter a plan ID in the Plan Code field.

By default, the Auto-generate on save field is checked and IBM Unica
Marketing Operations generates a number automatically when the plan is
saved. To enter a plan ID manually in the Plan ID field, clear the
Auto-generate on save check box.
The plan ID must be unique.

7. Select the security policy from the Security Policy list.
A security policy is required and defaults to Global or the default security
policy set by your system administrator.

8. Select a business area in the Business Area field.
9. Click Add/Remove Program Area to select the program areas to use for

programs in this plan.
10. Select a fiscal year from the Fiscal Year list.

To indicate the year in which the plan is active, you can choose the current
fiscal year or one of the next two fiscal years. That is, for a plan created in
fiscal year 2012 you can select FY 2012, FY 2013, or FY 2014.

Note: The budget information available on the Budget tab corresponds to the
value in this field.

11. Select the Budget Granularity.
12. Click Save Changes to save the plan.

To edit an existing plan, click the Edit icon ( ) found on the plan
Summary tab.

To add or remove a program area

Program areas are subsections of plans, allowing programs that are linked to the
plan to be arranged into logical subgroups.

IBM Unica Marketing Operations administrators create the program areas from
which you can choose.
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1. Follow the steps for adding a plan until you get to the step of adding a
program area.

2. Click Add/Remove Program Areas (located under the Program Areas field).
3. To add a program area, select a program area from the Available Program

Areas field and click the right-pointing arrows to add the program area to the
Selected Program Areas field.
When you add a program area to the Selected Program Areas field, it
populates the Program Areas field on the plan Summary tab.

4. To remove a program area, select a program area in the Selected Program
Areas field and click the left-pointing arrows to remove it.

Note: Before you remove a program area you must first remove any programs
assigned to it.

To link a program to a plan

Once you have created a plan, you can link existing programs to it. When you link
a program to a plan, all the plan participants receive an e-mail message informing
them of the link.
1. Navigate to the plan to which you want to link a program.

2. Click the Manage Linked Objects icon ( ) and select Link Existing.
The Link Existing Programs to Plan window appears.

3. Enter a string in the Find by name or code field and click Find or leave the
field empty and click Find

Note: The Search Results field shows only programs which you can link to the
plan. Only programs with the same budget granularity and security policy as
the plan will be available. Programs with a status of Cancelled, Deleted, or
Completed never appear in Search Results.

4. In the Select a Program Area field select a program area. The program will
belong to the program area that you choose.

5. In the Search Results field, click the programs to link to the plan.

Note: To select more than one program at a time, press the Ctrl key and click
each program.

6. Click the right-pointing arrows. The Selected Items to link field populates with
your selections.
To deselect a program, click the program in the Selected Items to link field
and click the left-pointing arrows.

7. Click Save Changes.

The program appears in the Supporting Program(s) field on the Plan Summary
tab.

Linked programs appear with summary information on the Plan Summary tab in
the Supporting Programs field. Click the program name to be taken to the
Summary tab for that program.
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Security considerations for linking plans and programs
Linked programs and plans must have the same security policy. When you link a
program to a plan, you cannot change the security policy of either object without
first removing the program from the plan.

In order to link an existing program to the plan, you must have Edit Summary
Tab permission on each program you want to link. If you do not have this
permission, ask your administrator for help.

Adding a new program from a plan
You can create a new program when you are in a plan; IBM Unica Marketing
Operations links the new program to the plan. The program areas you choose in
the program creation process are the program areas currently defined for the plan.

After you click the Add Program icon ( ) on the plan summary page, the
process is similar to creating a new, non-linked program.

Linked programs

If you add a program from the plan summary page, the new program’s program
area is constrained by the plan’s program areas.
v If the plan from which you add a program contains more than one program

area, you will be asked to choose the program area to which you would like the
new program to belong.

v If the plan contains only one program area, the new program will default to that
program area.

v If you want to re-assign a different program area to a linked program, you must
first remove that program from the plan, then link the program to the other
program area.

Non-linked programs

If you add a program that is not linked to a plan, you can assign it to any program
area.

To remove a program from a plan

Before you can delete a plan, you must remove any programs linked to it.
Removing the link does not delete the program from IBM Unica Marketing
Operations, it simply breaks the link.
1. Navigate to the Summary tab of the plan from which to remove a linked

program.

2. Click the Manage Linked Objects icon ( ) and select Remove.
The Remove Program Links From Plan window appears.

3. Select the program you want to remove from the Linked Program(s) field.
4. Click the right-pointing arrows button to move the program into the Selected

Items to Remove field.
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To move the program back to the Linked Program(s) field, click the program in
the Selected Items to Remove field and click the left-pointing arrows.

5. Click Save Changes.

To start a plan

Once you start a plan, all participants can work on the plan.
1. Navigate to the Summary tab of the plan that you would like to start.

2. Click the Status icon ( ) and select > Start Plan.
A window appears in which you can add comments or additional information
about the plan.

3. Click Continue.

The plan Summary tab displays. The status is set to In Progress.

To delete a plan

You can delete a plan from the Plan List page or from the plan Summary tab.

Note: You cannot delete a plan if it has linked programs. You must first remove
the link to the program before deleting the plan.

The following procedure describes how to delete a plan from the Plan List page.
1. Click Operations > Plans.

By default the Active Plans view of the Plan List page appears.
2. Select the checkbox next to each plan that you want to delete.

3. Click the Delete this Item icon ( ).
4. When IBM Unica Marketing Operations prompts you to verify that you want to

delete the plans, click OK.
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Chapter 4. Programs

If you have permission to create programs, you can add a program. As part of
adding a program, you select a template set up by an IBM Unica Marketing
Operations administrator.

After you create a program, you can start the program at any time. Starting the
program makes it active and changes the status of the program to In Progress.

Program views

IBM Unica Marketing Operations organizes programs in views.
v The All Programs view lists all programs. It also contains links to the Active

Programs and My Programs views.
v The Active Programs view lists all the programs that are now in the In Progress

state. The Active Programs view is the default view.
v The My Programs view lists all the programs that you own or are part of as a

team member.

You can also access the different views of programs using the Actions menu. It
contains links to each of the program views. In any view, you can change the sort
order by clicking on the column you want to sort by. Click the column a second
time to reverse the sort order.

Additionally, you can search for a program.

Summary information for programs

On the program Summary tab, IBM Unica Marketing Operations lists summary
information about a program, such as status and security policy. By default, the
Summary tab for the program displays when you select a program from the
Program List page. Any projects linked to the program are listed on the Summary
tab as well.

From the Summary tab, you can also perform tasks such as changing program
status, adding a request, editing the program, linking an existing project, or
removing a linked project.

Supporting projects and requests

At the bottom of the Summary tab, the Supporting Projects and Requests section
displays information about all child projects for the program. This list shows the
name of the project, the name of the project owners, the project ID, the date and
time when the last person updated the project, the target start and end dates of the
project, and the project status.
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To add a program

When adding a program, note the following
v To add a program you must have permission to add a program.
v If you add a program, you are the owner of the program.
v You can add other team members, some of whom can also be program owners.
1. Click Operations > Programs.

2. Click the Add Program icon ( ).
3. Select the appropriate template for your program.

Your administrator sets up templates that correspond to the types of programs
that fit the needs of your organization. For more information about templates,
see the IBM Unica Marketing Operations Administrator’s Guide.

4. Click Continue.
On the Summary page of the program wizard, you can click Add/Remove
Members to add team members to the program. You can add members as
either owners or participants in the program. For details, see “About team
alerts” on page 105.

5. Fill in the fields and continue clicking Next and filling out the required fields
until you reach the Attachments page. The required fields have a double
asterisk (**) next to them.
The number and content of your program pages differ depending on the
template you use. A typical program contains program summary information,
perhaps some additional information pages, and attachments of documents
related to the program.

To start a program

You can start any program you created, or any program for which you are listed as
an owner. Additionally, a user can have permission to change the status of all
programs. These permissions are assigned based on a user’s role in the security
policy for the program.
1. Navigate to the Summary tab of the program you want to start.

2. Click the Status icon ( ) and select Start Program.
A dialog box appears.

3. Add any comments in the dialog box, then click Close to start the program.

The status of the program changes to In Progress.

To add new project requests and projects to programs

After you create a program, you can create a project request or project from within
the program. When you do so, IBM Unica Marketing Operations automatically
links the project request or new project to the program.

After you add a project request or a project to a program, you cannot change the
security policy of the project request, project, or program. You must remove the
item from the program to change the security policy.
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1. Navigate to the Summary tab of the program that you want to contain the new
project request or project.

2. Click the Manage Linked Objects icon ( ) and select Add Request to
create a project request, or Add Project to create a project.
The wizard for adding a project request or adding a project opens

3. Do one of the following.
v Follow the steps in “To request a project” on page 43 to add a project request

and associate it with this program. After a user accepts the request, the
project created from this project request is also part of this program.

v Follow the steps in “To create a project” on page 40 to add a project and
associate it with this program.

When you complete the steps, the project request or project opens to the
Summary tab. The Summary tab has a field called Parent Items and Code. This
field contains a link to the program of which the project is a part.

4. Click the link to open the program.
Scroll to the bottom of the Summary tab of the program to view a list of all the
projects contained in the program.

To link an existing project to a program

Before you can link an existing project to a program, there must be existing
projects in your system and you must have the appropriate permission.

After you create a program, you can link existing projects to the program. When
you link a project to a program, all the team members listed in both the project
and the program receive an email message informing them of the link.
1. Navigate to the Summary tab of the program that you want to link to an

existing project.

2. Click the Manage Linked Objects icon ( ) and select Link Existing.
A dialog box appears for you to specify the projects to link.

3. Enter search criteria in the Find by name or code field.
4. Click Find.

Note: The Search Results field displays only projects that you can link to the
program. Only projects with the same budget granularity and security policy as
the program will are available. Programs with a status of Canceled, Deleted, or
Completed never appear in Search Results.

5. In the Search Results field, select the projects to link.
6. Click >> and << to move projects into or out of the Selected Items to Link list

box.
7. Click Save Changes to create child links to the projects you selected.

The projects you added appear in the list of projects at the bottom of the Summary
tab of the program.
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Security considerations for linking projects and programs

Linked projects and programs must have the same security policy. After you link a
project to a program, you cannot change the security policy of either object without
first removing the project from the program.

In order to add projects to the program, you must have Edit Summary Tab
permission for each project you want to add. If you do not have this permission
for one or more projects, ask your administrator for help.

To navigate from a program to a plan

You can link the programs you create to a plan. A plan can contain several
programs and helps organize programs in logical groups. After you link a program
to a plan, you can navigate to the plan from within that program.
1. Navigate to a program that has a parent plan.

The Summary tab has a field called Parent Items and Code. This field contains
a link to the plan that the program is part of.

2. Click the link to open the plan. The Summary tab of the plan appears. Scroll to
the bottom of the Summary tab of the plan to view a list of all the programs
contained in the plan.

3. Click the name of the program you were just in to go back to that program.

To remove projects from programs

You can remove new project requests, new projects, and existing projects from a
program.
1. Navigate to the Summary tab of the program that contains the project you

want to remove.

2. Click the Manage Linked Objects icon ( ) and select Remove.
The Remove Project Links From Program window appears.

3. In the Linked Project/Request list box, select the project requests or projects to
remove.

4. Use the arrow button to move selected items to the Selected Items to Remove
list box.

5. Click Save Changes.

The project requests and projects no longer appear in the list on the Summary tab
of the program.

To delete a program

When you delete a program, IBM Unica Marketing Operations checks to see if the
program contains links to any projects. If so, you cannot delete the program until
you remove all linked projects.
1. Select Operations > Programs.
2. Select the check box next to each program to delete.
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3. Click the Delete this Item icon ( ).

The selected programs are deleted from the system.

Note: You can also delete a program when you have the program open. From any

tab, click the Delete this Item icon ( ) in the IBM Unica Marketing Operations
toolbar.
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Chapter 5. Projects

A project contains all the information related to developing and executing one or
more related marketing deliverables or initiatives. This information can include a
checklist or schedule of tasks that people working on the project must perform in
order to prepare and produce the deliverables for the project.

For example, you might use a project called Monthly Trade Show to collect all the
information needed for the one trade show each month that your organization
attends. This information could include who attends the show, what equipment
you need in the booth, copies of demonstrations of the product that you intend to
present, collateral you want to hand out to customers, costs of promotional
materials, and any additional information that pertains to the trade show.

Note: Projects can have subprojects. A subproject has all the same characteristics
as a project. A subproject is linked to a parent project; any project linked in this
manner is referred to as a subproject.

Creating projects and requests
Your permission settings determine whether you create projects or project requests.
v If you have permission to create projects, you can create one by selecting either a

project template or an existing project.
For example, to capture information about upcoming trade shows, you can
create a project based on the Monthly Trade show template every month.
Alternatively, you can select any existing trade show project and copy it. To
create up to 99 different projects at once, you can select a project and clone it.
For more information, see “To create a project” on page 40, “To copy a project or
request” on page 46, or “To create projects by cloning” on page 41.

v If you do not have permission to create a project, you can instead create a
project request. Project requests allow you to get formal approval of a proposed
project, or allow for acceptance of a work request.
After you create a project request, you submit it to an authorized individual;
when the request is accepted IBM Unica Marketing Operations creates a project.
For example, a marketing manager can submit a project request to the CMO to
have the request formally approved and turned into a project. A sales account
manager can submit a project request to the marketing services department to
request development and production of some specialized collateral.
For more information, see “To create a request” on page 43 or “To copy a project
or request” on page 46.

Project requests and projects can also be created from within a program.

After you create a project, you can start it at any time. Starting the project makes it
active and you can view it in different views in IBM Unica Marketing Operations.
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Request statuses

The following table describes the possible statuses for requests.

Table 2. Request statuses

Status Description

Draft Indicates that the request has been created, but not yet submitted.

Submitted Indicates that the request has been submitted to the appropriate person
who can accept or reject the request.

Returned Indicates that the person who reviewed the request has returned it to
the submitter, either for rework or some other deficiency.

Accepted Indicates that the request has been accepted. After a request is
accepted, IBM Unica Marketing Operations creates a corresponding
project. This status indicates the end of the lifecycle for the request.

Reconciliation
Projects can be in a temporary state, In Reconciliation. A user can use this status
to reactivate a completed or canceled project, update project information, then
change the state back to its previous state (completed or canceled). For example,
the owner of a project can make private changes to a canceled project.

While a project is in this state, it is not available to any other participants for
editing. The project is read-only for users who do not have reactivate rights.

The spirit of reconciliation is that one can do anything within the project but
nothing externally. That is, for the rest of the IBM Unica Marketing Operations
system, the project is not available. For example, while a project is in reconciliation
you cannot reassign tasks.

Project views

IBM Unica Marketing Operations organizes projects and project requests in views
as follows.

Table 3. Project views

View Description

All Projects and
Requests

Lists all projects and requests. It also contains links to the other project
views and any saved project searches.

Active Projects
and Requests

Lists any active projects or project requests. A project is active when it
is in the In Progress state and a request is active when it is in the
Submitted state. The Active Projects and Requests view is the default
view.

My Projects Lists all the projects that you own or are part of as a team member.

My Requests Lists all the requests where you are either the requester or the
recipient.

Completed
Projects

Lists all projects with a status of Completed.

This Week's
Projects and
Requests

All projects and requests that fall within the current week.
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Table 3. Project views (continued)

View Description

Next Week's
Projects and
Requests

All projects and requests that fall within next week.

This Month's
Projects and
Requests

All projects and requests that fall within the current month.

Next Month's
Projects and
Requests

All projects and requests that fall within next month.

All My Teams
Projects

All projects assigned to a team to which you belong.

All My Teams
Project Requests

All project requests assigned to a team to which you belong.

All My Teams
Unassigned
Project Requests

Lists all project requests assigned to a team to which you belong but
not assigned to a team member.

Choosing list or calendar view

You can view projects in a project list view or a calendar view. By default, IBM
Unica Marketing Operations displays projects in a list view when you select
Projects from the Operations menu.

Table 4. Viewing projects in a list or calendar

View Description

List view Displays all the projects listed alphabetically in ascending order. You
can change the order by clicking once on the Name/Owner column.

If you want to sort by any of the other columns, click that column.
Click the column a second time to change the order of the column
from ascending to descending.

Calendar view Displays a calendar view of projects, listing any projects taking place
and their dates of activity.

To select project views

You can access the different views of projects using the Actions menu. In any view,
you can change the sort order by clicking on the column you want to sort by. Click
the column a second time to reverse the sort order.
1. Open Marketing Operations and select Operations > Projects.

The default page that appears is the Active projects and Requests view. You
can change this default page by modifying your user options.

2. Click the Actions icon ( ) and select All Projects and Requests or My
Requests or My Projects to view all projects, only project requests that pertain
to you, or only projects that pertain to you.

3. Click the Actions icon ( ) and select Search for Projects to search for
projects meeting a specified criteria. You can then save that search.
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Searching for projects
You can search for projects grouped by any criteria that is useful to you and save
the results of that search for later viewing. For example, you might search for all
projects that started in June and then save the results of that search by naming it
June Projects. You can also search for all projects of a certain type, such as all trade
show projects, and save that search. You can then access those search results at any
time.

About campaign projects
If your IBM Unica Marketing Operations system is integrated with IBM Unica
Campaign, you can create campaign projects.

A campaign project collects the information related to developing a marketing
campaign and executing it through Campaign.

A campaign project can contain any features available to projects, including
subprojects. Campaign projects also contain a TCS tab with a Target Cell
Spreadsheet and an additional Campaign Summary section of the Summary tab.

In a campaign project, you synchronize the campaign, offer, contact history, and
response history data for the project with Campaign.

About project codes and campaign codes
When you create a campaign project, you must specify a project name and code.
The same name and code are used as the campaign name and code when you click
the Create Linked Campaign icon to create the campaign in IBM Unica Campaign.

The code must be unique in both IBM Unica Marketing Operations and IBM Unica
Campaign. The system checks the uniqueness of the code before creating the
project or saving the project (if you changed the code).

To create a project

When creating a project, note the following.
v To create a project, you must have the appropriate security permission.
v When you create a project, you are the owner of the project.
v You can add other team members to the project (some of whom can also be

project owners).

Follow these steps to create a single project based on a project template. Project
templates are set up and maintained by an administrator. You can also create
projects by copying a project, making up to 99 clones of a project, or responding to
a project request.
1. Select Operations > Projects.

2. Click the Add Project icon ( ). The Add Project dialog opens.
3. Select a template for your project.

An IBM Unica Marketing Operations administrator sets up the templates for
your organization. To access any of the IBM Unica Marketing Operations and
IBM Unica Campaign integration features, you must select a template
configured as a campaign project template.
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4. Click Continue.
5. Complete the Add Project wizard: supply values for required and optional

fields. Click Next to access all pages of the wizard.
6. When you save the project, the system verifies that all required fields have a

value. It also completes optional fields by supplying default values from the
template when available. To save your project, use one of the following options.
v Click Finish. The Summary tab displays for the new project.
v Click Save and Duplicate. The system saves the initial project and then uses

the same information to create another project. The Summary tab displays for
the duplicate project: edit the default name supplied for the duplicate and
for other fields as needed, then save that project as well.

v Click Save and Return to List on any page. The All Projects and Requests
page displays.

Newly created projects are given a status of Not Started. To use the project to
collect and share information, you change its status. See “To start a project” on
page 42.

The tabs in a project differ depending on the template you used. A typical project
contains tabs for project Summary information, People, Strategy, Workflow
including a schedule of tasks and deliverables, Tracking of expenses and resources,
and Attachments related to the project. When IBM Unica Campaign is integrated
with Marketing Operations, a campaign project also contains a Target Cell
Spreadsheet tab.

To create projects by cloning

To create multiple similar projects from a single existing project, you can clone the
project. You specify how many projects to create, and select fields you want to edit
before the new projects are saved. You can clone a project when it is in any status.
To clone a project you must have the appropriate security permission.
1. Navigate to the Summary tab of the project you want to clone.

2. Click the Clone icon ( ). The Clone this project dialog opens.
3. Specify from 1 to 99 as the Number of projects to create.
4. Select either the project or the project template as the source of the metrics to

use in the new projects.
5. If the project you are cloning is linked to a program, the Copy parent link

check box appears. Select this check box to apply the same relationship link to
all of the new projects.

6. Select at least one attribute (or field) to edit for the new projects. Use
Ctrl+click or Shift+click to select up to 20 attributes from the list. For example,
to edit the default name and specify a target start date for each of the new
projects, hold down the Ctrl key while you click Name and Target start date.

7. Click OK. The Clone Projects Grid displays a column for each of the attributes
you selected and a row for each new project.

8. To change or enter values for attributes in the grid, click the Edit mode icon (

) and then click in the cell you want to edit.
For more information about working with grids, see Chapter 10, “Grids,” on
page 123.
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9. To create all of the projects, click the Save icon ( ) to save your edits and
then click Create Projects.
For successfully created projects, the Status/Project Code column displays the
assigned project code. For projects that cannot be created this column displays
Failed.

10. Click Back to Summary to return to the Summary tab of the project you
cloned.

All of the newly created projects are given a status of Not Started. To use the
project to collect and share information, you change its status. See “To start a
project.”

To start a project

You can start any project you own.
v The projects you create.
v The projects you create when you accept a project request.
v The projects that include you as an owner.
1. Select Operations > Projects or, if you are already working with projects, click

the Actions icon ( ) and select All Projects and Requests. The All Projects
and Requests page opens.

2. Use the check boxes to select one or more projects that you own in Not Started
status.

3. Click the Status icon ( ) and select Start Project. A dialog box opens with
details about the status changes possible for each of the projects you selected.

4. You can also start projects individually: click the name of the project to go to its
Summary tab, then click the Status icon.

After you start a project, all project participants can work with their assigned tasks.

Project attachments tab

The Project Attachments tab is broken into two sections, one for attachments for
the project as a whole and one for attachments to individual tasks in the project.

Table 5. Columns on the Project Attachments tab

Column Description

Icon, file name Icon of the file type and the file name of the attached file. The file type
and file size are listed in brackets.

Description The name of the person who attached the file, the date and time
added, and the description for the file.

Task Available in the Task Attachments section of the page only. Displays a
link to the task the file is attached to.
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Table 5. Columns on the Project Attachments tab (continued)

Column Description

Actions This column contains the following links:

v Send as Mail Attachment: Click to send the attachment using email.

v Remove: A user with privileges to remove the attachment can delete
the attachment using this link. The task or project owner receives an
alert when an attachment is removed. Removed attachments do not
appear on the Project Attachments tab.

Project requests
A project request is similar to a work order or creative brief. It represents a
request for someone else to do work according to the specifications supplied by the
requester.

Users within an organization and outside vendors can request a project. For
example, an outside vendor can submit a project request to the marketing services
organization requesting some collateral. The marketing services representative
accepts the request and creates a project, organizing tasks and assigning resources
to the project in order to manage the creation of the collateral.

If you request a project, you are a requester. You then submit the request to a
recipient for approval. When the recipient accepts the request, the recipient owns
the resulting project and is called the owner.

Note: A project request does not contain a workflow. When the request is
approved and transitions to a project, it contains the appropriate workflow.

To request a project

When adding a project request, note the following.
v To request a project, you must create the request and then submit it.
v To add a request you must have the appropriate security permission.
v If you request a project, you are a requester. You then submit the request to a

recipient for approval. After the recipient accepts the request, the recipient owns
the project and is called the owner.

To create a request

If you do not have permission to create a project yourself, you create a project
request. After you create the request, you must submit it.

When you create a request, the pages in the wizard that you complete differ
depending on the type of project you want to create. A typical request can contain
the following sections:
v Summary information about the request.
v Tracking information.
v Attachments that are part of the request.
1. Select Operations > Projects.

2. Click the Add Request icon ( ). The Add Request dialog opens.
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3. Select a template for your request.
Your administrator sets up project templates that correspond to the types of
projects that fit the needs of your organization. To request a project that uses
any of the IBM Unica Marketing Operations and IBM Unica Campaign
integration features, you must select a template configured as a campaign
project template.

4. Click Continue.
5. Complete the Add Request wizard: supply values for required and optional

fields. Each request identifies recipients to review and redraft or approve the
request. However, depending on the template, you may or may not be able to
add a recipient or change supplied values for each recipient's role, the sequence
number that defines the order in which they receive and must approve the
request, how long they have to respond (duration), or whether their approval is
required.

6. Click Next to access all pages of the wizard.
7. Click Finish.
8. When you save the request, the system verifies that all required fields have a

value. It also completes optional fields by supplying default values from the
template when available. To save your request, use one of the following
options.
v Click Finish. The Summary tab displays for the new request.
v Click Save and Duplicate. The system saves the initial request and then uses

the same information to create another request. The Summary tab displays
for the duplicate request: edit the default name supplied for the duplicate
and other fields as needed, then save that request as well.

v Click Save and Return to List on any page. The All Projects and Requests
page displays.

9. Submit the request to the first reviewer.

v If you created a single request, click the Status icon ( ) and select
Submit Request.

v If you created multiple requests, submit them as described in “To change the
status of projects and requests” on page 52.

When the last required recipient approves the request, IBM Unica Marketing
Operations creates the project.

To submit a request

To submit a request, you must first add the request. You then submit the request to
the request recipients. If the request is accepted, then one of the recipients becomes
the owner of the project.
1. Add a request.
2. If the request template does not supply recipients, add one or more recipients

and select a User or Team as each recipient.

3. On the Summary tab, click the Status icon ( ) and select Submit.
4. Enter any comments that you want the recipient to view regarding the request.
5. Click Continue.
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The recipients are notified of your request and the status of the request changes to
submitted. If the recipients were assigned sequence numbers, they are notified in
sequence. The recipients appear in the Recipient section of the Summary tab for
the request.

To monitor the status of a project request

You can view the following information about project request recipients.
v Role
v User assigned to the role
v The sequence number assigned to the recipient
v The status of the response from the recipient (Not yet notified, Waiting,

Accepted, or Returned)
v Any comments added by the recipients (click the User comments link)
1. Select Operations > Projects.

The Active Projects and Requests page appears.
2. Click the project request you want to monitor.

The Summary page for the project request appears, with information about the
recipients and the status of their responses.

To re-draft or cancel a request

You can re-draft a request before it has been accepted or if it has been returned by
a required recipient. To re-draft or cancel a request, do one of the following.

v To add or change information, click the Status icon ( ) and select Re-draft.
While you re-draft the request, the recipient cannot respond to the original
request. If you need to change recipients, select Edit.

v To cancel the request, click the Status icon ( ) and select Cancel.

When you re-draft or cancel a request, you can add comments indicating the
reason for the re-draft or the cancellation.

If you re-submit a request, recipients are notified of the re-submission according to
the re-approval rule selected when the request was created. If the re-approval rule
allows you to select recipients, and if you have not changed recipients when
re-drafting the request, when you re-submit the request you can select from a list
of required recipients who have accepted the request. If the recipients have been
assigned sequence numbers, recipients are notified in sequence.

To respond to a request as an individual

When someone creates a request for a project and names you as the recipient of
the request, you receive an alert message in the My Alerts page and an email
message notifying you of the request.
1. Navigate to a request by selecting Operations > Projects.

The Active Projects and Requests view appears. If the request you want to
accept is not in the list, click All Projects and Requests.

2. Click the request to open it.
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3. Review the request and decide whether you want to accept it or return it to the
submitter.

4. Enter any comments in the Comments field and click Accept or Return.
5. If you are accepting a team request, in the Assign to field select the user who is

responsible for the resulting project.

6. Click the Actions icon ( ) and select All Projects and Requests:
v If you accepted, both the accepted request and the not yet started project appear

in the list. You are the owner of the not yet started project.
v If you returned the request, Marketing Operations notifies the requester. The

status of the request changes to Returned.
v If the request is returned, the requester has options to resubmit or cancel the

project request.

To copy a project or request

To create a project or request that is similar to an existing one, you can copy that
existing project or request. You can make the copy when the project or request is in
any state, including before or after you submit a request. You can then edit the
copied project or request as needed. To copy a project you must have the
appropriate security permission.
1. Navigate to the Summary tab of the project or request you want to copy.

2. Click the Copy icon ( ).
The Copy to dialog box opens.

3. Select either the project or the project template as the source of the metrics to
use in the new project.

4. If the project you selected to copy is linked to a parent program or project,
choose whether the same relationship link applies to the new project:
v Select Copy parent program link to copy the parent program link.
v Select Copy parent project link to copy the parent project link.

5. Click OK.
The Summary tab opens for the new project or request. The name defaults to
Copy of original project name.

6. Modify any information you want to change in the copy, including the default
name, and click Save Changes.

The new project or request appears in your All Projects and Requests view and
your My Projects or My Requests view. Projects are created with Not Started
status; requests with Draft status.

Team projects and requests
Users can submit requests to a team, rather than an individual. Such requests are
called team requests. When someone accepts a team request, the resulting project is
called a team project.

Team projects lifecycle

The following table describes the lifecycle of team requests and projects.
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Note: The following steps are dependent upon the routing model used for the
particular team involved in the request.

Table 6. Lifecycle for team projects

User action System action

1 A user submits a request to a team. v Creates a team request.

v Populates the My Team Routing field
for the request.

v Sets the status of the request to
Submitted.

2a A team manager assigns the request to
a team member.

Sets the owner of the team project to
the team member selected during the
assignment.

2b A team member accepts or returns the
request.

Sets the owner of the team project to
the team member selected during the
assignment.

3a If accepted, the owner of the team
project sees it through to completion.

Updates the status for the team project
as applicable.

3b If the owner becomes unavailable, a
team manager or member can reassign
the project.

v Sets the owner of the team project to
the newly assigned team member.

v Updates the My Team Routing field
for the project.

To reassign a team project

A team project can be reassigned, for example if the team member responsible for
the project goes on vacation or otherwise becomes unavailable.
1. Navigate to the Projects list page by selecting Operations > Projects.

The Active Projects and Requests view appears. If the project you wish to
reassign does not display, click All Projects and Requests.

2. Select the team projects to reassign by checking the box next to each project.
3. Click Reassign Team Projects.

A dialog box appears. Note that you can only reassign team projects for which
you have the proper authorization (via team membership and routing options).

4. In the Assign to field for each project, select the user to whom the project
should belong (this user becomes the owner of the project).

5. Optionally, enter comments into the Comments text box.
6. Click the Reassign Project(s) button to complete the reassignments, or click

Cancel to close the dialog box without changing any project ownerships.

To respond to team requests as a team manager

When someone submits a request to a team on which you are the manager, you
may be required to assign a team member to the request. The assigned team
member becomes the owner of the resulting project.
1. Select Operations > Projects.
2. Respond to team requests in either of the following ways:

v Select a single project and click the Assign Team Request icon ( ).
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v Click the Actions icon ( ) and select All my teams project requests.
From this view you can respond to one or multiple project requests by
selecting the requests you want to assign and clicking the Assign Team

Request icon ( ).

Note: You can respond only to team requests for which you have the proper
authorization (via team membership and routing options).

3. In the dialog box, assign the request or requests to the appropriate team
members.

4. Optionally, enter comments into the Comments text box.

To navigate from a project to a program

You can link a project to a program. Programs help you organize projects in logical
groups. Once you link a project to a program you can navigate to the program
from within that project.
1. Open the All Projects and Requests view (by selecting Operations > Projects

and clicking All Projects and Requests in the breadcrumb).
2. Click a project to open it.

The Summary tab has a field called Parent Items and Code. This field contains
links to the ancestors of the project (its container program and plan).

3. Click the link to open the program.
The Summary tab of the program appears. Scroll to the bottom of the
Summary tab of the program to view a list of all the projects contained in the
program.

4. Click the name of the project you were just in to go back to that project.

Linking projects
Marketing projects often involve people from outside the marketing department,
making it difficult to track everything with a single, comprehensive project.

For example, work for an upcoming trade show involves the following tasks, each
a project in its own right.
v Identify and assign individuals to attend, present, cover the booth, etc.
v Produce marketing collateral.
v Design, build, and test a demonstration.
v Set up training sessions and speaking engagements.
v Generate the customer invitation list, create the invitation, send the invitation,

track the responses, etc.
v Create and maintain the trade show web pages.

These individual tasks are tracked and managed within the respective
departments, but this method never truly gives the coordinator a full view of
whether the trade show will occur on time and without problems.

Using IBM Unica Marketing Operations, you can organize projects by creating
parent-child relationships between them. A project coordinator can create a trade
show project and all of the necessary individual projects, assign owners to each,
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and then create links from the trade show project to each of the subprojects. This
method provides the project coordinator with a single view into the entire project.

Note: No data is exchanged between parent and child projects; the relationship is
for organizational purposes only.

Subprojects overview
From the summary page for a project, you can manage subprojects using the
following menu items that display when you click the Manage Linked Objects

icon ( ).
v Add Project: creates a child project.
v Add Request: creates a child project request.
v Link Existing: creates a child link to one or more existing projects or requests.
v Remove: removes existing links to one or more child projects or requests.

Note the following.
v Security policies must be the same for parent and child projects.
v The summary page for a project contains an area showing the links to all of its

direct children.
v A project can have a child-parent relationship with either another project or a

program, but not both. That is, if a project is linked to a program, it cannot be
linked to a parent project.

v After you add a subproject, you cannot change the security policy of the parent
or child project; you must first remove the link.

Details on the project-subproject relationship
The project-to-subproject relationship has the following characteristics.
v Any project or request can be linked to another project with the same security

policy.
v A project can have at most one parent project or program, but not both.
v A project can have an unlimited number of child projects.
v A project can have both a parent and children; this option makes it possible to

have an n-level deep hierarchy for projects (parent-child-grandchild etc.).
However, requests can be children to projects only. A request cannot be a parent.

v You cannot delete a project that is linked to either a parent or child; you must
first remove all parent-child (and project-program) relationships before you can
delete a project.

v When copying a project that is either linked as child or parent, the new project
is not linked.

v Metrics, budgets, and workflow do not roll up from a child project to a parent
project.

To create a child project/request
1. Navigate to the Summary tab of the parent project.

2. Click the Manage Linked Objects icon ( ) and select Add Project or
Add Request.
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Note: These options are available only if you have the appropriate security
permissions.

3. Choose a template for the a new subproject or request.
The wizard for adding a project or project request appears.

4. Complete the wizard.
v As the user completing these steps, you are the owner of the new subproject,

so the owners of the parent and child projects can be different.
v The security policy defaults to the value for the parent project.
v If you use the Save and Duplicate option to create multiple projects or

requests, they are linked to the same parent.

When you complete the wizard, the project request or project is open to the
Summary tab. The Summary tab has a field called Parent Items and Code. This
field contains links to the ancestors of the project.

To link a child project or request to a project
1. Navigate to the Summary tab of the parent project.

2. Click the Manage Linked Objects icon ( ) and select Link Existing.
Note this link only appears enabled if you have the appropriate security
permission.
A dialog box appears, where you specify project(s) to link.

3. Enter search criteria in the Find by name or code field.
4. Click Find.

IBM Unica Marketing Operations displays search results of only those projects
and requests that have the same security policy and budget granularity as the
project. For example, if your project uses the global security policy, only
projects and requests that also use the global security policy appear after a
search. Additionally, projects with a status of Cancelled, Deleted, or
Completed never appear in your search results.

5. In the Search Results field, select the project(s)/request(s) to link as children.
6. Use the >> and << buttons to move projects/requests into or out of the

Selected Items to Link list box.
7. Click Save Changes to create child links to the project(s) or request(s) you

selected.

Security considerations for linking projects
Linked projects and subprojects must have the same security policy. After you link
a project to another project, you cannot change the security policy of either object
without first removing the relationship.

In order to link, add, or remove parent-child projects and requests, you need to
have the appropriate security permission. If you do not have the appropriate
permission for the task you attempt, ask your administrator for help.

To remove a parent-child project link

You can remove N-level deep child relationships using this procedure. That is, you
can remove “grandchild” and “great-grandchild” relationships, and so on.
1. Navigate to the Summary tab of the parent project.
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2. Click the Manage Linked Objects icon ( ) and select Remove.
A dialog box appears, where you specify project(s)/request(s) to remove.

Note: The list contains children from all levels; that is all children, direct and
indirect, appear on the list.

3. In the Linked Project... field, select the project(s) to remove as children.
4. Use the >> and << buttons to move projects into or out of the Selected Items

to Remove list box.
5. Click Save Changes to remove child links to the project(s) you selected.

The project requests and projects no longer appear in the list on the Summary tab
of the project.

Note: Removing the link does not remove or delete the project; it simply removes
the relationship.

To assign work

Once a project exists, users can assign work (tasks) to people or teams.
1. Navigate to a project.
2. Add people and teams to the project. To assign work to an individual or team,

they must be members (or reviewers) of the project.
3. Assign tasks in any of the following ways:

v Use the Assign Work By Role icon ( ) on the People tab of the project to
assign all tasks based on user roles.

v Use the Find And Replace Task Members icon ( ) or the Find and

Replace Task Reviewers icon ( ) on the People tab to reassign work for
certain people or teams.

v Use the Workflow tab to individually assign tasks to users and or teams.

v Use the Members/Roles icon ( ) on the People tab of the project to
assign a team.

When users login, they can act on the work (tasks) that have been assigned to
them.

Selecting projects or requests
When you select check boxes on the Projects list page, IBM Unica Marketing
Operations retains your selections during a session as follows.
v In View mode, your check box selections are retained until you navigate to a list

page for a different object. For example, if you make a selection on page 1 of a
multi-page project list, go to page 2, and then return to page 1, either by clicking
the page number at the bottom of the page or using the Recent menu, your
selections are retained. However, they are discarded if you navigate to the Tasks
page.

v If you edit a project by clicking the Edit a Tab icon on the list page, your
selections are retained if you click Save and Return to List.
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To change the status of projects and requests

You can change the status of one or more projects or requests. Your change must
meet the following prerequisites; if it does not, a warning message describes the
possible problems.
v The new status must be a valid transition from the existing status.
v You must have appropriate permissions to change the status. If you are

accepting or rejecting a project request, you must be an appropriate approver.

Your administrator can set up IBM Unica Marketing Operations to send an alert to
owners and members of a process when its status changes.
1. On the Projects and Requests list page, select the check box next to each item

whose status you want to change.
Although you can select items on more than one page, the status change is
applied only to the items selected on the page you are viewing when you select
the new status.

2. Click the Status icon ( ) and select the new status. A dialog box appears in
which you can add comments.

3. Enter any comments, and click Continue to close the dialog box and apply the
new status.

To reconcile a project

After you complete (or cancel) a project, you can edit certain portions of the project
by placing it into a temporary state, In Reconciliation.
1. Navigate to the Summary tab of a cancelled or completed project.

2. Click the Status icon ( ) and select Reconcile.
A dialog box appears in which you can add comments.

3. Click Continue to close the dialog box.

The status of the project is set to In Reconciliation.

To delete a project

When you delete a project, IBM Unica Marketing Operations checks to see if you
linked the project to a program. If you did, you cannot delete the project until you
remove it from the program.
1. Open IBM Unica Marketing and select Operations > Projects.

By default the Active Projects and Requests page appears.
2. Select the checkbox next to each project you want to delete.

3. Click the Delete this Item icon ( ).
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Chapter 6. Workflows

When you create a project, you use the Workflow tab to customize the workflow
provided by the project template. When you participate in a project, you use the
Workflow tab to track your work. If you have the appropriate permissions, you
can save a workflow as a workflow template.

Any member of the project (with the appropriate access permission) can edit any
column of the Workflow tab.

The workflow tab has an edit mode and three view modes.

v To edit the workflow on the tab, click the Edit icon ( ).
v You can view the workflow as a spreadsheet, a timeline, or a process flowchart.

Workflow concepts
Workflows contain approvals and tasks. Approvals are described in “Approvals”
on page 5

Tasks

Tasks are steps in the workflow where a user must take action. The task is not
complete until the action is complete.

Tasks have several types of data associated with them, described in this chapter.

Stages

You can group workflow tasks under headings called stages. Stages can help you
with task organization. For example, you can create a stage that has all tasks
performed by your users. Stages are the headings in bold that group the tasks
together.

Dates

Workflows contain the following types of dates.
v Actual/Forecast dates begin as forecast dates: the dates a task owner plans on

starting and completing a task. These dates are specified while the task is still
pending. When a team member actually starts and completes a task, the same
dates can be used or different dates supplied as the actual dates.

v Target dates are dates used to plan the project schedule. Typically, they are set at
the beginning of the project.

v Anchored dates are fixed dates that cannot change, even if the dates of the tasks
upon which they are dependent change.

v Non-work time represents dates when people do not work, so the system skips
those dates when calculating durations for tasks. Marketing Operations currently
supports system-wide non-work time that applies to all tasks. It is up to the
project manager to determine whether overriding any of these dates is necessary.
System administrators enter and maintain these dates.
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v Weekend dates are dates you use to specify work that occurs on a weekend on
a per-task basis. You can schedule work on a weekend date using the Schedule
Through option for each task.

Effort

The work effort in days (as opposed to duration) that it takes a user to complete a
task. For example, a task takes three calendar days to complete, but the task owner
only spends half a day on the task for each of the three days. The effort for the
task is one and a half days even though its duration is three days.

Locked tasks

When you edit a task, the task is locked so no other user can edit it at the same
time. Additionally, when someone creates an approval from an approval task, the
approval task becomes locked permanently.

If anyone attempts to edit a locked task, they receive a warning message,
indicating that it is currently in use.

People and roles

You can assign tasks to individual team members or you can assign tasks to all
team members in a given role. When you assign a task to one or more team
members, they are considered to be the task owner.

Workflows use the following concepts to identify the people who perform work.
v Task owners are the people responsible for executing or managing tasks. For

approval tasks, these members become the owners of the approval.
v Reviewers are reviewers of approval tasks. These members become the

approvers of the task.
v are reviewers of approval tasks.
v Roles are used as a bridge between tasks and people. They are useful for

assigning work on a generic basis. For example, each type of project you create
can have its own workflow template, and the template can contain standard
roles for certain tasks. Then when you create a project, some (or all) of the tasks
have a default role already associated with them.

About My Tasks
IBM Unica Marketing Operations allows users to view the list of tasks assigned to
them. This list is called My Tasks, since each user gets a customized view when
selecting Operations > Tasks.

On the My Tasks list you can see all tasks to which you are assigned, allowing you
to view tasks across multiple projects. This feature consolidates the information
that you would otherwise retrieve by navigating to each project individually,
clicking its Workflow tab, and searching for all tasks to which you are assigned.

From this screen, you can perform the following actions.
v Get a summary view of all your tasks and approvals.
v Mark selected tasks as completed or skipped.
v Navigate to the Workflow tab for a task.
v Update task properties.
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v Search or filter the task list by criteria you choose.

Filtering My Tasks

By default, the My Tasks page displays all of your tasks, for all projects and
requests. You can filter the list of tasks displayed by clicking the Actions icon (

) at the top of the page.

This table describes the available filters.

Table 7. Task Filters

Filter Description

All My Teams
tasks

Lists the tasks assigned to all teams of which you are a member.

All My Teams
Unassigned Tasks

Lists the tasks that are assigned to a team of which you are a member
but that are not yet assigned to an individual.

All Tasks Lists all tasks in the system.

My Active Tasks Lists your assigned tasks for all projects that are currently active
(started but not yet completed).

My Completed
Tasks

Lists tasks assigned to you that are marked as completed.

My Future
Milestones

Lists tasks where all the following criteria are met.

v The task has a milestone flag specified.

v The task is assigned to you.

v The task is not completed or skipped.

My Milestones Lists all milestones in tasks that are assigned to you.

My Recent Tasks Lists all upcoming and in progress tasks meeting the following criteria.

v The task is assigned to you.

v The task is not completed or skipped.

v The task has a start or end date that falls within the past 14 days.

My Pending
Approvals

Lists all the approval tasks waiting for your response.

My Tasks Lists all assigned tasks. This list is the default view when you select
Operations > Tasks.

My Upcoming
Tasks

Lists tasks assigned to you that are scheduled to end within the next 14
days.

About the task pane
When you click a task in the My Tasks page, its parent object opens on the left
and the task pane opens on the right. The task pane provides shortcuts to many
IBM Unica Marketing Operations functions, context for the task you are working
on, and tools that allow you to move directly through the workflow.

Depending on the parent object you are working on and your permissions, you can
click links in the task pane to do the following tasks.
v Edit project tabs.
v Add attachments. See “Working with attachments” on page 17.
v Read and post messages. See “To read a message on the message board” on

page 196 and “To post a message on the message board” on page 196.
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v Manage team members and reviewers. See “Managing project members” on
page 103 and “To manage reviewers” on page 112.

v Find and replace task owners.
v Edit the workflow. See “To edit the default workflow” on page 67.
v Edit budget allocations and line items. See “To allocate funds” on page 150 and

“To add or edit line items” on page 151.
v Edit tracking.
v Add a child object or request. See “To create a project” on page 40 or “To create

a request” on page 43.
v Link an existing program, project, or request to the parent object. See “To link a

program to a plan” on page 27.

The task pane also provides context while you work by showing the next task in
the workflow (that you have permission to see) on the bottom of the task pane. If
you do not have permission to edit it, the task is in view mode. You can also
record effort time and write hand-off comments.

The following tools allow you to move through multiple tasks and approvals
directly on the task pane.
v Save the task to work on later by clicking Save for Later.
v Mark the task complete by clicking Finish.
v Skip the task by clicking Skip.

About schedules
There are two options for scheduling in workflows.
v Baseline
v Up-to-date

Baseline scheduling

You use baseline scheduling when you want to compare actual dates to fixed
target dates. With baseline scheduling, you never change the target dates, allowing
them to serve as a baseline. Users who are assigned tasks receive reminders on
completing the actual/forecast dates.

Up-to-date scheduling

You use up-to-date scheduling when you want to use actual dates to update the
official schedule (defined by the Target Start and End dates) regularly. This mode
enables project managers to capture the most up-to-date, official schedule;
however, it does not provide an easy way of viewing a baseline version of the
schedule.

To use a baseline schedule

Before creating your projects, have the system administrator set up permissions
and reminders as follows.
v Set permissions so that only project owners can update Target dates.
v Set reminders (alerts) based on the Actual/Forecast dates.

While working with a baseline schedule, team members perform the following
high-level steps.
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1. The owner sets the Target Start and End dates for each task.
These dates stay fixed throughout the entire project.

2. As the project progresses, team members update the Actual/Forecast dates with
real data.

To keep an up-to-date schedule

Before creating your projects, have your system administrator set up permissions
and reminders as follows.
v Set permissions so that only project owners can update Target dates.
v Set reminders (Alerts) based on the Target dates.
v Set reminders to be sent only to the owner or owners.
v Optionally, set reminders on the Actual/Forecast dates to be sent to team

members.

While working with an up-to-date schedule, team members perform the following
high-level steps.
1. The owner sets the initial Target Start and End dates for each task.
2. As the project progresses, team members update the Actual/Forecast dates with

real data.
3. If a task is delayed (the owner receives reminders based on Target dates), the

owner assesses the situation and adjusts the Target dates and durations as
necessary.

About date dependency calculations
When you enter or change the date for a task, Marketing Operations can calculate
other dates based on your entry. It uses an internal algorithm to bidirectionally
calculate the dates of dependencies, starting with the cell where you entered the
date.

When you initiate date dependency calculations for a workflow, note the following.
v In addition to factoring in non-work days and hours, date dependency

calculations use two additional system-wide properties: start time of day and
number of hours per day. Your system administrator configures these
parameters.

v If a task row is anchored, the date dependency calculation does not update its
dates (even if the date columns are empty).

v Date dependency calculations do not affect active and finished tasks; only tasks
with a status of Pending.

v Date dependency calculations observe the per-task options for non-work time.
The calculation algorithm takes into account whether a task is scheduled to
progress during non-work time, weekends, or both.

v Do not log forecast times outside of business hours if you intend to do date
dependency or other automatic calculations afterward. That information is
overwritten by the automated process.

To automatically calculate workflow dates

When you enter or change the date of a task, Marketing Operations can calculate
other dates based on your entry.
1. Enter or change the date for a task in any of the date fields.
2. Select the date and click anywhere on the screen except for another date field.
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The Date Dependency Calculation icon ( ) appears next to the end date.
3. Click the Date Dependency Calculation icon.

Alternatively, you can select one of the toolbar icons for recalculating
dependency dates.

The other dates in the workflow change based on the new entry.

To calculate date dependencies above a locked task

If a workflow has a locked task, and you change the date of a task that is located
above that task, you receive a warning when you calculate date dependencies.

To clarify this task, the procedure that follows assumes:
v Task 1.8 is locked.
v You need to change the duration of task 1.5 from 5 days to 10 days.
v All tasks are dependent on the previous task.
1. Open the workflow for editing, and change the duration on task 1.5 from 5

days to 10 days.

2. Click the Date Dependency Calculation icon ( ) next to the end date of task
1.5.
The system displays a warning message, saying you cannot recalculate through
the locked row.

3. Click the start date of task 1.8

4. Click the Date Dependency Calculation icon ( ).

The system calculates the dates below the locked task.

Workflow links

The Workflow tab displays the following links.

Table 8. Links on the Workflow tab

Link Description

Breadcrumbs Click any active link in the breadcrumb trail to go to that page.

Breadcrumbs (links to the pages you visited before arriving at the
current page) are located above the project name.

Edit

Click the icon to add, remove, or change workflow stages
and tasks.

View as spreadsheet
Click the icon to view the workflow as a spreadsheet.

This view provides access to granular information about a task,
presented in table format. For example, you can easily look up the
status, duration, forecasted end date, and team members for a task
using the column headers. The View as spreadsheet view is the
default view.
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Table 8. Links on the Workflow tab (continued)

Link Description

View as timeline Click the icon to view the workflow as a timeline.

This view provides a graphic view of information such as task
duration and status. From the Project Timeline dropdown list,
select various options such as Dates/Progress to show this
information about the timeline.

View as process
flowchart

Click the icon to view the workflow as a process flowchart.

This view shows the workflow tasks as a network diagram.

Layout

Click the icon to open a dialog for adding and removing
columns from the spreadsheet view.

Save as template Click to save the workflow definition directly into the template
library (if you have the permission to do so).

A dialog opens for you to name the template. For more details, see
the Marketing Operations Administrator’s Guide.

Tasks and stages In the spreadsheet view, tasks are links that behave as follows:

v Clicking an approval task pops up the summary page for the
approval in a new window.

v Clicking a workflow task pops up the Post Task Update dialog
in a new window.

About the workflow spreadsheet view
When you display the workflow as a spreadsheet (the default), information about
the stages and tasks in your workflow appear in a list in a spreadsheet. You use
this view to update task status, add reviewers, and change dates, among other
tasks.

Workflow tab fields

When the workflow appears in spreadsheet view (the default view), it includes the
following fields and columns.

Table 9. Fields on the Workflow tab

Field Description

Tasks and stages Lists the task stages and tasks that make up the project.

When in edit mode, click a stage or task to revise or change.

When in view mode:

v Clicking an approval task opens its summary page in a new
window.

v Clicking a workflow task opens the Post Task Update screen in a
new window.
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Table 9. Fields on the Workflow tab (continued)

Field Description

Status The status of the task.

Standard tasks can have one of the following statuses.

v Pending

v Active

v Skipped

v Finished

v Approved

Approval tasks can have one of the following statuses.

v Not started

v In Progress

v On hold

v Completed

v Canceled

When an approval task has a status of In Progress, On hold, or
Completed, this field is read-only.

When an approval task has a status of Not started, in edit mode you
can change the status to In progress or Canceled.

% Complete The percentage value that represents how complete a task is.

When in edit mode, click the measuring bar for a task and enter a new
% Complete number. The measuring bar expands to display a
comparable level. For approval tasks, this field is read-only.

Forecast/Actual
Start

For tasks in the pending state, this field represents the Forecast Start
date. Forecast Start dates are in italicized font. After you change a task
from Pending to Active, this field represents the Actual Start date.
Actual Start dates are in regular font.

In edit mode, use the pop up calendar to select a date and time.

Forecast/End For tasks in the pending state, this field represents the Forecast End
date. Forecast End dates are in italicized font. After you change a task
from Active to Finished, this field represents the Actual End date.
Actual End dates are in regular font.

In edit mode, use the pop up calendar to select a date and time.

Forecast/Dur. The duration of the task, in days, hours, and minutes.

If you enter both start and end dates, the system automatically
calculates a value for this field (the Forecast/End date minus the
Forecast/Actual Start date).

Actual Effort The actual effort it took to complete the task, as opposed to calendar
duration. Effort is measured in days, hours, and minutes.
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Table 9. Fields on the Workflow tab (continued)

Field Description

Anchored Dates Indicates whether the task is anchored. If a lock appears in this field,
the dates for the task are anchored.

To specify anchored dates for a task, click the column, then select
Anchored from the menu. The task date cannot move even if the dates
of the tasks it is dependent on change.

If a dependency is not met, the dates in conflict appear with a different
icon and in a different font.

For example, suppose task 2.2 is dependent on task 2.1. If the target
end date of task 2.1 is after the target start date of task 2.2, both the
target end date of 2.1 and the target start date of 2.2 appear in red, if
you anchored the date for task 2.2 by selecting the lock icon in the
Anchored Dates column.

Schedule Through Indicators for which dates to use when determining task dates. The
following options are available.

v Business: indicates that this task includes only standard,
non-holiday, non-weekend dates. This schedule is the default for all
tasks.

v Weekends: indicates that this task includes weekends. The system
includes weekends when it calculates dates for this task.

v Off.: indicates that this task includes system-wide non-work time
that is defined. The system takes into account these times when it
calculates dates for this task.

v All: indicates that this task includes all dates. No dates are ignored
when dates are calculated for this task.

Target Start The targeted start date of the task. In edit mode, use the pop up
calendar to select a date.

Target End The targeted end date of the task. In edit mode, use the pop up
calendar to select a date.

Target Dur. The duration of the task, in days, hours, and minutes. The Target End
minus the Target Start dates.

Target Effort The targeted effort estimated to complete the task, as opposed to
calendar duration.

Milestone Type A task milestone that you choose from a dropdown list. Example
options might be Meeting, Event, and Job Start. System administrators
set the milestone types that appear on the list.

For more information about setting up milestones, see the Marketing
Operations Installation Guide.

Member Role(s) A role or roles associated with the task. These roles can be loaded
automatically from the project template used to create the project, or
the project owner can set them up manually.

When an approval task has a status of In Progress, On hold, or
Completed, this field is read-only.
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Table 9. Fields on the Workflow tab (continued)

Field Description

Members The people associated with the task.

If a workflow task has a role in its Member Role(s) column, when you
assign people to roles, the workflow automatically adds a person in the
corresponding Members column.

You can also add people to the Members column manually while
editing the workflow.

When you edit the workflow for an approval task, teams are not listed
in this field because a team cannot be the owner of the approval task.

Typically, standard tasks have members.

When an approval task has a status of In Progress, On hold, or
Completed, this field is read-only.

Reviewer Role(s) A read-only field that shows the role or roles associated with an
approval task.

These roles can be loaded automatically from the project template used
to create the project, or the project owner can set them up manually.

Reviewer roles are used to pre-populate an approval process.

Reviewers A read-only field that shows the reviewers associated with an approval
task. Reviewers are used to pre-populate an approval process.

If a workflow task has a role in its Reviewer Role(s) column, when
you assign people to roles the workflow automatically adds a person in
the corresponding Reviewer column.

Enforce Dep. If this task is dependent on other tasks, determines how strictly the
system interprets dependencies. When this option is selected, the
system restricts project members from updating this task until the tasks
it depends on are finished.

Required Whether this task is required. Required tasks cannot be skipped or
deleted and their names cannot be changed.

Task Code A read-only code that identifies each task uniquely within a project.
System integrators use this code to implement custom business logic
involving tasks.

Notes Any comments about the task.

Workflow toolbar

When the Workflow tab is in edit view, a toolbar appears. You use the toolbar
icons to change the workflow. For example, you can insert and delete tasks, add a
stage, or clear all entries.

The following table explains each button.

Table 10. Icons on the Workflow toolbar

Icon Description

Add Task Row. Adds a new standard task in the spreadsheet.
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Table 10. Icons on the Workflow toolbar (continued)

Icon Description

Add Approval Row. Adds a new approval task in the spreadsheet.

Click a dependency option.

v No dependencies

v In series

v In parallel

This option determines how IBM Unica Marketing Operations behaves
when adding new tasks.

Add Stage Row. Adds a new stage in the spreadsheet. Tasks are
grouped in stages.

The Tools menu contains the following choices.

v Copy: copies the contents of the selected cells to the clipboard.

v Paste: pastes the contents of the clipboard, beginning at the selected
cell.

v Paste Rows After: pastes the contents of the clipboard below the
selected row.

v Mark as: marks the selected task appropriately. For example,
selecting Mark as Finished changes the status of the selected task to
Finished. You can mark the task Skipped, Finished, Active, or
Pending.

v Fill Down/Up: copies cell values to a range of cells.

v Clear: erases all entries in the selected cell or group of cells.

v Clear Column: erases all entries in the selected column.

v Clear All: erases all entries in the workflow.

Click to recalculate dependent dates while preserving slack time.
Recalculates all date dependencies based on your changes; leaves any
existing slack time between dependent tasks.

Click to recalculate dependent dates while removing slack time.
Recalculates all date dependencies based on your changes; removes
any slack time between dependent tasks.

Click to undo your last change.

Click to reapply a change you undid with the Undo action.

Move row up. Click to move the selected task or stage upward. If you
move a stage, the associated tasks move with it.

Move row down. Click to move the selected task or stage downward.
If you move a stage, the associated tasks move with it.

Delete row. Click to delete the selected task or stage. Note the
following.

v If you delete a stage, all of its associated tasks move up one stage.

v If you delete the first stage, the first task associated with it becomes
the stage for the rest of the tasks.
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To set first column width on workflow spreadsheet

You can change the width of the first column in the workflow spreadsheet view,
and keep this setting for your entire session. That is, your changes remain after
you navigate to other pages and then return to this tab.
1. Navigate to the Workflow tab of the project.
2. Use the column width control to resize the first column to your preferred

width.
3. Click the Layout link in the upper right section of the screen.
4. In the Project Workflow Tab Layout dialog, do the following:

a. In the First Column Width section, select the Remember Last Setting radio
button.

b. At the bottom of the dialog, check the Make these the default settings for
this project's workflow tab box.

5. Click Apply and Close to save your changes and close the dialog.

The first column width is now set for this project for the remainder of your
session. No matter which pages you navigate to, when you navigate back to this
workflow tab, the first column width remains as you set it.

About the workflow timeline view
The timeline view of the workflow tab presents a view of the project over a period
of weeks or months. To view the project schedule in a timeline view, click the
View as Timeline icon.

You can customize the timeline view by using the Layout link from the workflow
tab. Use this dialog box for the following purposes.
v Select the captions, if any, to appear next to each bar in timeline.
v Choose a weekly or monthly view of the timeline.
v Select the types of dates to view.

Note: If you click the Edit link from the timeline view, the spreadsheet opens for
editing.

About the workflow process flowchart view
The process flowchart view shows displays the tasks in a network diagram style,
as follows.
v Each task is displayed as a box with a task number and ID.
v Tasks that have dependencies are connected to any tasks they depend on.
v Sequential tasks are displayed on the same line.
v Parallel tasks are displayed on different lines.
v Independent/orphan tasks are displayed on their own line, with no connections.

Workflow tab layout page

Use this page to set the appearance for both the spreadsheet and timeline views of
a workflow tab.
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Note: To hide the Spreadsheet Layout or Timeline Layout section, click the icon
next to the title. To view a hidden section, click the icon.

Spreadsheet layout section

Table 11. Fields in the Spreadsheet layout section

Field Description

Columns Check a column to display, or clear to hide.

Preset Column
groups

Click to select a preset group of columns to display.

v All: default setting; all boxes checked (all columns display).

v Targets: hides Status, % Complete, and Actual date columns.

v Actuals: hides Target Dates/Effort and Member/Reviewer roles
columns.

v All dates: displays all columns related to target and actual dates.

v Responsibility: displays columns related to who is assigned to
complete the tasks.

First Column
Width

Select either:

v Remember Last Setting: When viewing the workflow spreadsheet,
you can adjust the first column width to see more or less of the task
names.

v Exactly: Select to enter a number that sets the column to an exact
width in pixels.

Timeline layout section

Table 12. Fields in the Timeline layout section

Field Description

Time Scale The increment of time used for measurement. Select either Weeks or
Months. The default setting is Weeks.

Bars Represent The bars in the timeline view indicate durations. You can choose to
display Actual/Forecast dates, Target dates, or both. The default is to
display both.

Bar Captions By default, the bars do not have captions. Select one of the choices
from the dropdown menu to display certain information as bar
captions. For example, you can have the task name or milestone type
display as a caption.

First Column
Width

See the description for the Spreadsheet Layout section.

Buttons

Table 13. Buttons on the Layout page

Button Description

Make these the
default

Check this box to keep your settings as the default for the workflow.
This option ensures that whenever you navigate away from and back
to this tab, your display setting will not change (until the next time
you make changes and check this box).
Note: Your settings become the defaults for all users for this workflow,
until someone changes the defaults.

Apply and Close Click to apply your changes and close the dialog.
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Table 13. Buttons on the Layout page (continued)

Button Description

Apply Click to apply your changes. Your changes display on the workflow,
and the dialog remains open for further editing.

Restore Defaults Restores all settings to their default values, undoing any customization
you made.

Cancel Click to close the dialog without changing any settings.

Scheduling work time
IBM Unica Marketing Operations offers the following settings to help manage and
allocate resources effectively.
v Specify non-work time: allows your organization to define a set of dates that, by

default, are not included when the system calculates task dates and durations.
v Include weekends in work time: by default, weekends are not included when

calculating task dates and durations. However, you can override the default to
schedule certain tasks through weekends.

By default, tasks do not include weekends or non-work dates when calculating
their start or end dates.

To view a list of defined non-work dates, click Non-working Business Days from
the Administration page.

Note: When viewing the IBM Unica Marketing Operations calendar, any day
specified as non-work time is indicated by a gray X in the background. In timeline
view, non-work time appears in a gray-shaded column. Additionally, the name of
the non-work time (for example, Labor Day) displays when you point to the date.

About non-work time
You can set days on which no work is typically done by employees as non-work
time in IBM Unica Marketing Operations. Marketing Operations supports a set of
system-wide non-work time, separated into user-defined types.

For example, assume that you have the following non-work dates set in Marketing
Operations.

Table 14. Non-work time example categories and dates

Category Dates

Corporate Holiday 1/1/2006, 7/4/2006, 12/25/2006

State Holiday 4/15/2006, 10/3/2006

Corporate Off-site 8/15/2006

After you define non-work time, you can elect whether to schedule work on these
days, for each project and its tasks.

If the active time for a task includes any non-work time, its end date is pushed out
by an extra day for each of these dates. For example, assume 7/4/2006 is defined
as non-work time. If Task 1.3 is scheduled to start on 7/3/2006, and has a duration
of three days, its end date is 7/7/2006; work is not scheduled for 7/4, since it is
defined as non-work time.

66 IBM Unica Marketing Operations: User's Guide



For any task, you can choose to ignore the non-work time; if so, the workflow
includes any non-work time as normal work days. So, if you choose to ignore
non-work time for Task 1.3, its end date becomes 7/6/2006.

About including weekends
For certain tasks, you might need to schedule work to proceed on weekends. For
example, print shops often work 24 hours a day, 7 days a week, so if you have
tasks that go to a print shop, you can have these tasks take into account weekend
days.

For example, you have a task called “Print Brochures at print shop.” This task
might start on Friday 6/15, and have a duration of three days. If you choose to
include weekends for this task, its end date is end of business Monday, 6/18. If
you choose not to include weekends for the task, it ends on end of business
Wednesday, 6/20.

Work and non-work time settings

By using the Schedule Through indicator on the workflow, you have many
options for scheduling tasks. You can schedule tasks in any of the following ways.

Table 15. Options for scheduling tasks

Flags Behavior

Bus. (Business) Non-work time and weekends are excluded from task scheduling.

Note: This option is the default setting for all tasks.

Wkd. (Weekends) The task is scheduled to include weekends, but not system-wide
non-work time.

Off. (Days off) Weekends are excluded from task scheduling, but work is expected
to be done during other non-work time.

All (All calendar days) The task is scheduled to include all days.

Note: The Schedule Through column is a planning and targeting tool; it should
not be altered after actual dates and times are logged on a task. Doing so can
overwrite the actual dates and times.

To edit the default workflow

When you create a new project, the system guides you through a wizard based on
the template you selected. When you finish with the wizard forms, you might need
to customize the default workflow provided by the project template. The ability to
customize default workflows is controlled by your user permissions.

When you open the Workflow tab in edit mode, if any of the toolbar icons are
disabled or the values in the columns are read-only, it means that you do not have
the appropriate security permissions to edit the workflow.
1. Open the project that has a workflow to set up and open the Workflow tab.

This tab displays the workflow as designed in the template.

2. Click the Edit icon ( ).
3. Edit the names listed in the first column to change the default task and stage

names to specific tasks and stages.
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Stages are the headings in bold that group the tasks together.
4. Add any stages or tasks as necessary.

v To add a stage, click the Add Stage Row icon ( ).

v To add an approval task, click the Add Approval Row icon ( ).

v To add a user task, click the Add Task Row icon ( ).
5. Enter target or forecast actual dates, depending on how you want to use the

schedule.
v You can enter start dates, end dates, and duration for a task. Enter any two,

the third value is calculated automatically. For example, if you enter a target
start and a target end date, the system calculates the duration.

v You are not prevented from picking any dates that are not in agreement with
the per-task options for non-work-time. For example, even if a task is not
scheduled to include weekends, you can still pick a Sunday as an end-date
for the task.

6. To specify that a task is a milestone of some sort, for example, a drop date,
select the Milestone Type column and select a milestone that appears in the
drop-down list.
Your administrator can set the milestones that appear in the list.

7. Select members or roles to assign the task to in the Members and Reviewers
columns.

8. Enter any notes about the task in the Notes section.
9. Perform one of the following actions.

v Click Save to save your changes and remain in edit mode. If you are making
extensive edits, it is a best practice to click Save occasionally to prevent any
loss of work.

v Click Save and Finish to save your changes and return to view mode.
v Click Cancel to undo any changes and return to view mode.

About adding a stage or task
To add a task or stage to a workflow, your security role must grant you the
permission named Add/Edit/Delete Tasks/Approvals, Dependencies, and Targets
for the template you select. If the Add icon is missing from the toolbar, contact
your administrator about obtaining the appropriate access rights.

Note the following about stage and task rows.
v When adding a stage or task, if you place the number of the task in front of the

task name, the task is inserted in the place that the number indicates.
For example, if you enter 2.3 Have team meeting anywhere in the task list, the
task is placed under the task labeled 2.2 and the numbers of subsequent tasks
shift, so that the step previously labeled 2.3 is now 2.4.

v You can add a stage or task anywhere in the list and then use the up and down
icons on the toolbar to move the stage or task to the appropriate place in the list.

v There are several options for managing dependencies on tasks as new rows are
added and existing rows are removed.

v After you create an approval from a workflow task, you can edit only the
approval itself; you cannot edit the corresponding task in the workflow.
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If you try to edit the approval from its workflow task, you receive an error
stating the task row is locked. You must navigate to the approval to update any
of its fields.

To add a stage or task

Before adding a stage or task, open a workflow in edit mode.
1. In the workflow, select the stage or task above the place to insert the new stage

or task.
2. Add a stage, approval task, or standard task.

v To add a stage, click the Add Stage Row icon ( ).

v To add an approval task, click the Add Approval Row icon ( ).

v To add a user task, click the Add Task Row icon ( ).
3. Optionally, to make a task dependent on another task, enter the number of the

task it is dependent on after the task in parentheses ( ).
For example, suppose that task is named Deliver draft to vendor. To make
this task dependent upon task 1.3, name the task 2.5 Deliver draft to vendor
(1.3).

4. When you finish editing the workflow, save your changes.

The stage or task is added to the workflow, after the insertion point.

If the date of one task changes, it changes the dates of all the dependent tasks. For
example, if task 2.2 Setup Milestone Schedule is dependent on task 2.1 Kickoff
Meeting w/Creative Team, enter (2.1) after you enter, Setup Milestone Schedule.

If a task has more than one dependency, separate the task numbers with commas.
For example, use 2.2 Setup Milestone Schedule (1.1, 2.1).

To add a stage or task below a locked task

Before adding a stage or task, open a workflow in edit mode.

If you select a locked task, the insert task or stage links do not work. To add a task
directly below a locked task, you must perform the following steps.
1. Navigate to the workflow page to change and click Edit.
2. Select any task row that is not locked.
3. Add a stage, approval task, or standard task.

v To add a stage, click the Add Stage Row icon ( ).

v To add an approval task, click the Add Approval Row icon ( ).

v To add a user task, click the Add Task Row icon ( ).
4. Change the number of the task or stage so that it directly follows the locked

task it should follow.
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For example, suppose that the locked task is 2.5 Review copy - informal
(2.3). You would set the number of the new task to 2.6. After you finish
naming the task, the system moves it so it is after task 2.5.

To create an approval process for a workflow approval task

From the spreadsheet view of a workflow, you have the option of adding an
approval process to a particular task. A task with an approval process attached to

it has the approval icon ( ) in the Linked Step field.
1. Navigate to the Workflow tab of the project that contains the approval task.
2. In view mode, click the name of an approval task. The Start Approval dialog

appears as a popup.
3. Complete the details for the approval.
4. Click one of the following to complete the process.

v Send Approval: saves the approval and submits it (changing the status from
Not Started to In Progress).

v Save for Later: saves the approval process and sets the status to Not Started.
v Cancel: discards your changes and does not create an approval.

The dialog closes and the system displays the workflow tab where you initiated
the approval process.

After you create an approval from a workflow task, you can edit only the approval
itself; you cannot edit the corresponding task in the workflow.

About editing a stage or task
If you change the number for a task or stage, the task is inserted before the row
matching the new number.

For example, assume the stage order as shown here.
1. Planning
2. Collateral Design
3. Lead Generation
4. Show Setup-to-Breakdown
5. Marketing Review

If you edit task 5, Marketing Review, changing its number to 3, the new order is as
follows.
1. Planning
2. Collateral Design
3. Marketing Review
4. Lead Generation
5. Show Setup-to-Breakdown

Now suppose that you edit task 2, Collateral Design, changing its number to 4.
The new order is the following.
1. Planning
2. Marketing Review
3. Collateral Design
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4. Lead Generation
5. Show Setup-to-Breakdown

To move a task or stage to the end, give it any number higher than the final task
or stage. For example, to move stage 2, Marketing Review to the end, change its
number to 6 or higher.

Updating and finishing tasks
When you create a task, or open a new workflow with existing tasks, the status of
the task or tasks is Pending. As project members work on tasks, they update the
status to indicate the current progress.

To place a task into any status, ensure that the workflow is in edit mode, and click
the Status column of the task, then choose the appropriate status from the
dropdown list.

Table 16. Task Statuses

Status Description

Pending Indicates that a task is not yet in progress. When you create a task,
it defaults to the pending state. The pending state is symbolized
by a blank status field.

Active
Indicates that a task is in progress. Symbolized by the icon.
You can also type A to place a task in the active state

Skipped
Indicates that a task was skipped. Symbolized by the icon.
Skipped tasks are tasks for which members no longer do work.
Any dependencies of this task are also disregarded. You can also
type S to place a task in the skipped state.

Finished
Indicates that a task is complete. Symbolized by the icon. You
can also type F to place a task in the finished state.

Note the following behavior.
v If you enter 100 in the % Complete column for a task, the status is updated to

Finished.
v If you enter 0 in the % Complete column for a task (if it was previously

finished), the status is updated to Pending.
v If you enter any number from 1 to 99 in the % Complete column for a task (if it

was previously finished), the status is updated to Active.
v If you mark the status for a task as Skipped, all of the dates for the task are

cleared. Until you hit Save (or Save and Finish), you can retrieve the dates by
canceling the editing session. However, after you save the spreadsheet with the
dates cleared you cannot retrieve them.

Approval tasks

After you create an approval task, you cannot change its status from the workflow
tab. The status of an approval task is automatically set depending on the status of
the approval itself.
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To skip an approval task

This topic describes how to skip an approval process from a task on the Workflow
tab.
1. Navigate to the Workflow tab of the project that contains the approval to skip.
2. Click the name of the approval task to skip. The Approval dialog appears as a

popup.
3. Click Status > Cancel Review.
4. Close the dialog.

The approval task is crossed out and can no longer be accessed. If necessary, you
can also delete the approval.

To skip multiple tasks

You can perform this task when you are assigned tasks for one or more projects.
1. Open the Tasks list page to view all of your assigned tasks.
2. Select the check box for each task to skip.
3. Click Skip Selected.
4. In the confirmation dialog box, click OK to skip the selected tasks, or Cancel to

return to the list page without making changes.

Any tasks you selected and skipped are removed from the Tasks list page, and
their status is changed to Skipped.

To complete multiple tasks

You are assigned tasks for one or more projects.
1. Open the Tasks list page to view all of your assigned tasks.
2. Select the check box for each task you want to complete.
3. Click Complete Selected.
4. In the Complete Selected Tasks dialog box, select one of the following:

v Leave all dates as they are. The tasks are marked as complete, but no end
dates are modified.

v Set all actual end dates to now. Each selected task is marked complete, and
its actual end date field is set to the current date and time.

5. Click Continue to complete the selected task or tasks, or Cancel to return to
the list page without making changes.

Any tasks you selected are removed from the Tasks list page, and their status is
changed to Complete. Additionally, their end dates are set, if you selected that
option.

To add an attachment to a task

To add attachments for a task, a project owner must enable adding attachments for
the task. The following users can add or remove task attachments.
v Task owners can only add attachments to their tasks.
v Task owners and users with the Delete Attachment security permission for

projects can delete task attachments.
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Adding attachments to tasks is similar to adding attachments to other objects (such
as programs). However, note the following behavior that is specific for adding
attachments to tasks.
v You cannot use markup on task attachments
v There is no versioning for task attachments: uploading a new version overwrites

the existing version of the attachment.
v It is possible to have multiple task attachments with the same name for the same

task. This situation can occur if multiple owners of the task each upload a file
with the same name. You can differentiate the files by the user who created the
attachment.

v You can add and remove attachments no matter the state of the task. That is,
even if a task is marked complete or skipped, you can still add and remove
attachments.

v The Attachments tab for projects is divided into two sections: one for files
attached to the tasks in the project, and one for files attached directly to the
project.

v If a task owner adds task attachments, and later the project owner sets the
Enable Task Attachment flag to false, nobody would be able to add or remove
attachments from the Post Task Update dialog. However, task attachments for
the project could still be removed from the project attachment tab.

1. Navigate to the task to which you would like to add an attachment.
Click the task from a project workflow or from the Tasks list page. The Post
Task Update dialog box opens.

2. Click the Attachments tab.
The tab displays any attachments that exist for the task.

3. In the File to Attach field, select From My Computer, From the Asset Library,
or URL.

4. Do one of the following:
v Click Browse to attach a file that is on your computer. When the dialog box

appears, navigate to the file you want to attach and click Open.
v Click Browse Library to attach a file in an asset library. Click the library that

contains the file you want to add. Use the tree in the left pane of the screen
to navigate to the folder and then the asset that you want to attach. Click
Accept Asset when viewing the asset in the right pane.

v Enter the URL in the field provided.
5. Add any comments about the attachment.
6. Click Add More to display an additional set of fields for each additional

attachment you want to add.
7. After you add all your attachments, click Save and Return to close the dialog

box.

Any new attachments are added to the Attachments tab for the task.

To add roles to tasks

Normally, when you create a project, the workflow automatically contains member
and reviewer roles for all tasks if the template selected contains this information.

However, you can also assign roles to workflow tasks that are different from the
template settings.
1. Navigate to the Workflow tab of your project.
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2. Click Edit ( ).
3. Select the Member Role cell for the task you want to assign.

4. Click the turndown icon ( ) to expand the list of available roles, and select
the one to assign to this task. Repeat this step until you assign all the tasks.
If you have the View people tab and Edit team members and roles
permissions, then all system users, system teams, and member roles are
available in the Members and Member Roles drop downs even if they were
not previously included on the people tab; adding a user to the project
workflow automatically adds the user to the people tab.
By contrast, Reviewer and Reviewer Role cannot be edited directly on the
workflow spreadsheet. Add new reviewers and reviewer roles on the Approval
popup.

5. Save your work.

About roles, people, and approval tasks
You can assign an order to roles when you add them to an approval task in a
workflow. This order is saved if you save the workflow as a template.

When you add people to the roles and then assign work, the spreadsheet lists the
people alphabetically by their name. When you create an approval from the task,
the reviewers are ordered according to their role order. However, in the To field of
the approval, they are still listed in alphabetical order. If more than one user is in a
role, those users are sorted alphabetically by their name.

Example ordering of reviewers for an approval task

Assume that your workflow has approval task 1.5 Review printed Brochure. For
reviewer roles, you add roles in the following order.
1. Legal reviewer
2. Marketing manager
3. Content reviewer

If you save this workflow as a template, and then later create a project using this
template, this order is preserved.

Now assume that you assign people to roles as follows.
1. Legal reviewer: Nancy Chan
2. Marketing manager: Brian Doyle, Andy Proctor
3. Content reviewer: Elaine Jones, Mark Davis, Brad Johnson, Wilson Alverez

When you click task 1.5 and create the corresponding approval task, the reviewers
are listed in the following order (alphabetically within their respective roles):
1. Nancy Chan
2. Andy Proctor
3. Brian Doyle
4. Brad Johnson
5. Elaine Jones
6. Mark Davis
7. Wilson Alverez

74 IBM Unica Marketing Operations: User's Guide



To list the reviewers in a different order, move them up and down within the
approval task.

About copying and pasting tasks
When copying and pasting tasks, note the following.
v For copying, you must select a continuous range of tasks, rather than selecting

multiple, disconnected tasks (by using Ctrl+click).
v If you do not insert enough blank tasks to correspond to the ones you are

copying, existing tasks are overwritten.
v To paste rows at the insertion point, you can click Paste from the Tools menu or

press Ctrl+V. To paste rows after the selected row, you must click Paste Rows
After from the Tools menu.

v You can copy the status from one approval task and paste it in another approval
task status column (but not in a standard task status column).

v If you copy the status from one approval and paste it in a new row of an
approval that is not saved, the Not started status is supplied regardless of what
you copied.

To copy tasks on Macintosh/Safari

Copying and pasting tasks on a Safari browser is slightly different than the
procedure described for Internet Explorer. The following procedures describe the
steps involved.

Note: When selecting multiple task rows on the Macintosh using the Shift key, it
can be difficult to determine which rows are selected by their appearance. Take
extra care to make sure that you know which rows you selected.
1. Select and copy tasks.

a. Select the task, tasks, or the block of cells to copy.
b. Select Copy from the Tools menu or press Ctrl+C. The Text To Copy dialog

appears with the information from your selection already highlighted.
c. Press Apple+C to copy all text in the dialog to your clipboard.
d. Click Continue to close the dialog.

You can now paste the information to another application or to another area on
your spreadsheet.

2. Paste selected tasks.
a. Copy information from another application or from another area on your

spreadsheet.
b. In IBM Unica Marketing Operations, select the destination row, rows, or

block of cells in the workflow.
c. Select Paste from the Tools menu or press Ctrl+V. The Text To Paste dialog

appears containing an empty text box.
d. Press Apple+V to paste your clipboard information into the text box.
e. Click Continue to paste that information into the spreadsheet at your

previous selection location.

To copy tasks in Internet Explorer

You can copy a continuous group of tasks to another place in the same workflow
or into the workflow for another project.
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1. Open the project that has the tasks to copy and click the Workflow tab.
2. Click Edit.
3. Select the first source task. If this task is the only task you are copying, skip to

step 5.
4. Point to the final source task, then press Shift and click over this task. A range

of tasks you selected is highlighted.
5. From the workflow toolbar, select Copy from the Tools menu item to copy the

selected task or tasks.
If you are pasting the tasks into the same workflow, skip to step 7.

6. If you are copying the tasks to another project workflow, navigate to the
destination workflow tab, and open it for editing (click its Edit link).

7. Optionally, insert enough blank rows below the destination to act as
placeholders for the tasks you are copying.
For example, if you are copying six tasks, make sure that there are six blank
rows available. If you do not create the necessary rows, existing tasks below the
insertion point are overwritten.

8. Click the destination task.
9. From the workflow toolbar, select Paste from the Tools menu item to paste the

task.

The source tasks are placed in the workflow, starting from the selected destination
task.

To fill data into a range of cells

You can copy a value in one or more cells to a group of continuous cells above or
below the selected cells. This feature can greatly reduce the data entry time for
adding duplicate information. For example, assume that you have a workflow that
contains 10 consecutive tasks all having the same target start, target end, target
duration, and target effort.

You can enter this data for the first task. Then, copy the values to all the other
tasks by selecting these four columns for all 10 tasks and using Fill Down.
1. Open the project that has the task values to duplicate, and click the Workflow

tab.

2. Click the Edit icon ( ).
3. Select the first cell.
4. Point to the final cell, then Shift+click this cell.

The range of cells you selected is highlighted.

Note: You must select a continuous range of cells, rather than selecting
multiple, disconnected cells.

5. Click the Tools icon ( ) and select Fill Down or Fill Up.
v Fill Down copies the values in the top-most cell (or cells) to all the other

selected cells, including the bottom-most.
v Fill Up copies the values in the bottom-most cell (or cells) to all the other

selected cells, including the top-most.

All the selected cells now contain the same value.
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Remember to save the workflow to keep your changes.

To print the Workflow tab

You can print all information found on your project Workflow tab, or select certain
columns of information to print.

1. From the Workflow tab, click the Print icon ( ).
A window appears with a list of columns from which you can choose to print.
By default, all columns are selected.

2. Clear any columns you do not want to print.
By default, the Shrink to Fit Landscape Page Width check box is selected.

3. Optionally, clear this check box to print the columns at a size of 100%.
If you keep this option checked, all selected columns print on a single page. If
you use this feature, change your printing preference (for this print job) to
landscape.

4. Click Print Selected Columns.
5. Click Print.
6. Select your printer and printer options, then click Print to print the selected

workflow columns.
Choose landscape mode for best results.

7. In the preview window, click Close to close the print preview.

Post task update dialog box

This dialog appears when you click a workflow task in view mode. Use this dialog
as a quick alternative to editing the entire workflow, when you need to update a
single task only. From this dialog, you can update certain items, add task
attachments, and add comments to the revision history of the project.

The Post Task Update dialog box contains two tabs, Status and Attachments.

Status

The Status tab contains the following fields.

Table 17. Fields on the Status tab

Field Description

Owner(s) The task owner or owners. At the task level, project members are
referred to as task owners.

That is, in the workflow spreadsheet, you use the Members column to
add people to a task; this column refers to project members. When you
open the task in the Post Task Update screen, these members are listed
as Owners (which refers to task owners).

Target Dates The target start and end dates and duration for the task. You can edit
either or both of the date and time selectors to update the information.

Status The status of the task. Edit this field by selecting a value from the pull
down menu.

% Complete The current progress for the task. Enter a number 0-100 to change the
value.
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Table 17. Fields on the Status tab (continued)

Field Description

Actual Effort The effort for the task, measured in days. Enter a value to update the
field. This field can contain partial days, for example, 3D-2H-0M.

Forecast /Actual
date and time
fields

The Forecast/Actual begin and end dates and times for the task. You
can edit either or both of the date and time selectors to update the
information.
Note: Begin and end dates are mandatory; you receive a warning if
you attempt to save without entering values for both fields.
Additionally, the system checks to ensure that the end date is not
earlier than the begin date.

Comments Displays comments for the task. You can enter text to update the field.

These notes go in to the revision history of the project and any
notifications that may be sent about the task.

Enable Task
Attachments

A flag to determine whether the task can contain attachments. This
field is visible to project owners only. Check the box to allow the task
to contain attachments.

Note: Make sure that you close the dialog box by clicking either Save and Return
or Cancel; if you do not use one of the buttons to close the dialog box, the task can
remain locked, and no one else can edit it.

Note: To change the state of a finished task back to active, you must set both the
Status to Pending, and the % Complete field to an integer less than 100. If you do
not change both fields, after you close the dialog box, the task is still marked as
completed.

Attachments

The Attachments tab contains the following fields.

Table 18. Fields on the Attachments tab

Item Description

Current
attachments
section

The top portion of the page describes the current attachments of the
task. It contains the following columns of information for each
attachment:

v File: Contains a link to the attachment file and describes the file type
and size.

v Description: Contains revision history and description for the
attachment.

v Actions: Contains links for deleting the attachment or for sending
the attachment by email.

File to Attach Contains a dropdown menu that allows you to specify the source of
the file to attach.

Browse Click to browse your computer or the asset libraries for the file to
attach.

Comments Use this text box to add any comments for the attachment.

Attach Selected
File

Click to attach the selected file or URL.
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Managing task dependencies
IBM Unica Marketing Operations has several options for managing dependencies
on tasks as new rows are added to the spreadsheet and existing rows are removed.
v Normal: no dependencies are automatically created. If you need dependencies

for the new tasks and stages, create them manually.
v Sequential: insert the new task in an existing chain of tasks.
v Parallel: insert a new task branch parallel to an existing chain of tasks.

Inserting tasks in sequence

Insertion in sequence makes the new task dependent on the task before it, and
then makes all items that were dependent on that task dependent on the new task.

You insert a task in sequence when it can start only after the previous task is
complete. For example, in this figure, if task X cannot be worked on until task B is
complete, you insert task X in sequence.

A B C

A B C

becomes

becomes

A B

A B

C

C

Insert a step after 
"B" in Sequence

DD

X

X

Inserting tasks in parallel

Insertion in parallel makes the task dependent on the items (tasks or stages) that
the task before it was dependent on, and makes the items dependent on the
previous task dependent on the new task as well.

You insert a task in parallel when it can be worked on at the same time as another
task. For example, in this figure, if task X can be worked on simultaneously with
task B, you insert task X in parallel.

A B C

A B C

becomes

becomes

A B

A B

C

C

Insert a step after 
"B" in Parallel

DD X

X
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Deleting tasks

Deleting a task removes the selected task from the chain, but relinks the two
remaining segments of the chain together so that it is one continuous chain again.

A B X D

E

A B X D

becomes

becomes

A B

A B

D

D

Remove step "C"
preserving chains

E

When a task is deleted its dependents are made dependent on its dependencies
before the deletion takes place. This practice preserves all sequential chains of
dependencies.

Default and "last used" modes

To make adding a task as simple and consistent as possible, IBM Unica Marketing
Operations provides the following behavior.
v The default mode is "in series"; when you begin an editing session, this mode is

used as the insertion mode.
v The "last used mode" is remembered for each editing session. After you select a

mode from the menu, this mode is used each time you add a task during the
remainder of your session.

For example, to add several tasks in parallel, you need to select in parallel mode
only once. Then, every time you insert another task, the system inserts it in parallel
unless you explicitly select another mode.
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Chapter 7. Approvals

An approval allows you to streamline and track the process of having your work
reviewed and approved. This feature allows many users to review work in parallel
or in an order that represents your business processes. Reviewers (or approvers)
can electronically mark up content submitted for review. IBM Unica Marketing
Operations then records approvals and denials for audit purposes. You can tie
approvals to a project or they can exist independently from any project.

About approvals
An approval is an item or group of items that approvers review and respond to,
either by approving, suggesting changes, or denying. IBM Unica Marketing
Operations contains two types of approval processes: stand-alone approvals and
approval tasks in workflows.

The approval process is the lifecycle of an approval. It is set up by a project owner,
and contains all the details about what to approve, who approves, and when to
approve. Typically, an approval goes through four stages: it is created, submitted,
active, and completed. The system notifies the required approvers by sending
alerts and emails. The approvers can pose comments or questions before they
decide. And when the approval is completed (either approved or denied) the
approval owner or reviewer gets notified about the results.

Note: You can create an approval process without any approval items, and
approvers can still respond to it.

The following are valid approval statuses.
v Not Started: an owner creates an approval, beginning the approval process.
v In Progress: when ready, an owner submits the approval, changing its status

from Not Started to In Progress.
While the status of the approval is In Progress, approvers review it, comment on
it, and respond. Additionally, if the approval is linked to a task in a workflow,
its progress is tracked in the % Complete column.

v On Hold: an owner can temporarily stop an approval, if necessary, changing the
status of the approval to On Hold.

v Cancelled: an owner can cancel the approval, changing its status to Cancelled.
v Completed: the owner marks the approval as finished, changing its state to

Completed.

An approval owner is the person who created the approval. Normally, the owner
has all the capabilities associated with the approval (such as being able to delete it
or change its status), although this feature set can be different depending on the
security policy associated with the approval.

An approver is someone who is designated to review a particular deliverable and
approve or deny it. There are several ways an approver can be designated:
v Add the person directly to the approval process itself.

Add the person as a reviewer to the project. This procedure can auto-populate
approval processes created from the workflow, depending on how your
administrator set up the project templates.
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A required approver is an approver who is designated as required, as opposed to
optional. For an approval process to be marked complete, all required approvers
must respond to the approval.

An approval round indicates how many times an approval is submitted. The first
time an approval owner submits an approval, its round number is 1; the system
increments the round number each time the approval is resubmitted.

Stand-alone approvals
Stand-alone approvals exist apart from any projects or other business process. They
are not connected to any workflows and their security permissions are configured
differently.

To create a stand-alone approval, select Operations > Approvals and click the Add

Approval Process icon ( ).

Approval tasks
An approval task is an approval process that is connected to a step in a workflow.
An approval that is linked to an approval task in a workflow can be updated in
either the workflow or in the approval itself. Additionally, changes made to one
are automatically propagated to the other.

If you want the approval process to be connected to an approval task in a
workflow, create the process from the Workflow tab of the project. To add an
approval task to a workflow, your security role must have the Add/Edit/Delete
Tasks/Approvals, Dependencies and Targets setting enabled.

An approval created from a workflow task can have some information filled in
already, based on the approval task it represents.

Approval dates
When you create an approval from a workflow task, note the following behavior
concerning the Forecast/Actual and Target dates for the approval.
v If the task contains a date in either the Target End Date or Forecast/Actual End

Date field, the system automatically copies the date into the Target Due Date for
the approval.

v If you modify the date in the Target Due Date field, the Forecast/Actual End
Date in the corresponding workflow approval task is updated with the new
date.

Note the following about the way IBM Unica Marketing Operations calculates
duration when the project owner enters the start and end dates for an approval
from a workflow task.
v If the duration is less than what is specified in the approval for each approver,

an equal amount of time is deducted from each required approver.
v If the duration is more than what is specified in the approval for each approver,

an equal amount of time is added to each required approver.
v When an approver responds, the duration for that approver is not adjusted. The

durations for the remaining approvers are adjusted if possible or an error
message displays.

v If for any reason the duration for an approver cannot be adjusted automatically,
an error message displays requesting different values.
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v The Forecast/Actual Duration field in the workflow is overwritten with the sum
of approver durations if the duration for an approver is changed and saved.

v Marketing Operations automatically calculates the approval start date if the
Forecast/Actual duration and Forecast/Actual end date are changed.

Due dates for approvals
Approval due dates are determined differently for required reviewers than they are
for optional reviewers.
v For optional reviewers, the due date is the date the approval was submitted plus

the duration specified for the reviewer, regardless of the sequence the reviewer
has in the process.

v Due dates for required approvers do not include durations for optional
reviewers and are calculated as follows:

Approval submission date
+ sum of previous required approvers’ durations
+ duration for this required appprover
= current approver’s due date

For example, if there are three required approvers and each one approves in
sequence, and the duration for each is one day, then the due date for the third
approver is three days after the approval was submitted.

The durations for approvers working in parallel (that is, they have the same
sequence number in the process) is calculated as follows.
v The duration is counted once; it is not summed.
v If the durations have different lengths, the longest duration is used.

For example, consider an approval process configured as follows.
v Approval submission date: 25 August 2008 03:00 PM
v Target due date: 30 August 2008 05:00 PM
v Four approvers:

Table 19. Sequences and durations for example

Approver Sequence Duration Required?

A 1 01D-00H-00M yes

B 2 01D-00H-00M yes

C 2 01D-00H-00M yes

D 3 01D-00H-00M yes

The due dates for the approvers are:
v Approver A: 26 August 2008 03:00 PM
v Approver B: 27 August 2008 03:00 PM
v Approver C: 27 August 2008 03:00 PM
v Approver D: 28 August 2008 03:00 PM

Now, if the duration for Approver C was two days, then the due date for C would
be 28 August and the due date for D would be 29 August. That is, there would be
three days between Approvers A and D, not two.
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Note: While calculating dates, the system-wide setting for non-work time is
considered. Depending on the value of this setting, weekend or other non-business
days can also be included in the calculation.

Approval views

IBM Unica Marketing Operations organizes approvals in views as described in the
following table.

Table 20. Views for approvals

View Description

All Approvals Lists all approvals. It also contains links to the other approval views.
Additionally, if there are any saved searches for approvals, they appear
as links on this page.

My Active
Approvals

Lists any active approvals to which you can respond. It also contains a
link to the Approvals Pending My Response view. The My Active
Approvals view is the default view.

Approvals
Pending My
Response

Lists all the approvals waiting for your response. This list is a subset of
the My Active Approvals view. It includes any approvals that are
waiting for your approval (that you have not responded to already).
You can also see approvals pending your response on the My Tasks
page.

All My Teams
Approvals

Lists all approvals assigned to members of your team.

All My Teams
Un-Assigned
Approvals

Lists all approvals that are assigned to your team but not yet assigned
to an individual team member by your team leader.

Reviewing attachments in IBM Unica Marketing Operations

The markup tools play an important role in the review process, enabling you and
others to add feedback directly on top of an attachment. IBM Unica Marketing
Operations allows users to mark up attachments for plans, programs, projects, and
marketing objects in either of the following ways.
v Marketing Operations can open a PDF document in Adobe Acrobat. Users can

use all of the markup features in Acrobat to make comments, then save the
comments in Marketing Operations.

v Marketing Operations can be set up to use native markup functionality, which
allows users to mark up the following file types.
– PDF (each page of the PDF is converted to an image for markup)
– GIF
– JPG (RGB only, not CMYK)
– PNG
– BMP
– HTML pages and hosted websites

During installation, an administrator chooses which type of markup to enable
throughout the application.

For both types of markup, note the following:
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v You access the IBM Unica Marketing Operations markup tool by clicking the
View/Add Markup link for an individual approval item.

v Marketing Operations tags markups with the name of the person who made the
comments, so everyone can view all review comments at once, or one reviewer's
comments at a time.

About HTML and native markup

You can upload an entire website for review. However, the following limitations
apply.
v IBM Unica native markup does not support markup on websites that include or

are built entirely using Flash.
v Pages that require server-side processing, such as CGI, ASP, ASPX, CFM, do not

work properly in the markup tool.
v Framed sites are not supported.

As an alternative to uploading HTML files, consider a URL to link to externally
hosted content.

About using Adobe Acrobat markup in IBM Unica Marketing
Operations

To use the Adobe Acrobat markup feature effectively, you or your IBM Unica
Marketing Operations administrator must perform the following setup activities.
v If you are working on a Microsoft Windows platform, the customized

UMO_Markup_Collaboration.js file must be placed in the JavaScripts subdirectory
of your Adobe Acrobat installation directory. If you cannot view comments by
other approvers, it is likely that you are missing this file.

v If you use Internet Explorer to access IBM Unica Marketing Operations, you
must set your Internet Explorer preferences to display PDF files in the browser.

v Additional setup steps are required if you are using the Safari browser on a
Macintosh to access IBM Unica Marketing Operations. For more information, see
“Using Adobe markup on the Apple Macintosh”

Note: IBM Unica does not support using the Save and Work Offline option in
Adobe Acrobat. As a result, if you use Save and Work Offline, add markup, go
back online, and try to send and receive your comments, your edits may be lost.

Using Adobe markup on the Apple Macintosh
This section describes behavior for users working on Macintosh, using the Safari
browser, and Adobe Acrobat markup functionality.
v You must have Adobe Acrobat Standard or Professional 6.0 or higher.
v You must configure Acrobat as follows. You must perform this configuration

when Acrobat is opened on its own, not through the browser.
– Select Edit > Preferences > Reviewing and select Custom in the ServerType

dropdown list.
– Select Comments > Show Comment & Markup Toolbar.

v IBM Unica Marketing Operations tags comments with the Macintosh login name
of the approver, which can be different from the Marketing Operations user
name.

v If you use Notes, Text Annotations, or other Acrobat markup functionality where
text is entered, after you mark up a page of the item to be approved, you must
click outside the text field (outside the Notes text field, for example) before you
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click Send Comments. If you do not perform this action, the Macintosh does not
send the text portion of the markup back to the server, and the field appears
empty when a user opens it in Acrobat.

v When you use Acrobat markup on the Macintosh, the stamp tool always
displays the name of the user currently viewing the markup, not the name of
the user who is doing the markup.

v Each time you open a PDF, a blank Safari window opens.
v When using the markup capabilities within IBM Unica Marketing Operations

with the Safari browser, temporary internet files are stored on the Macintosh
desktop.

v There are two Send icons: one is the same as seen in Windows, and the other is
an IBM Unica Marketing Operations custom icon specific to the Safari browser

on Macintosh: . Use this icon to capture markup comments; the
Windows icon does not work.

v If you are using Acrobat version 6, when you click the markup link for an
approval, the Safari browser opens the PDF inline, rather than in an Acrobat
screen.

Note: This behavior does not exist if you are using Acrobat version 7. Upgrade to
version 7, if possible.

If you want to view the PDF in an Acrobat screen, perform one of the following
actions:
v To open the current document in an Acrobat screen, right-click (hold the CTRL

key down while clicking the mouse if using a one-button mouse) on the PDF
and choose Open with Acrobat 6.0 Professional.

v To always open PDFs in an Acrobat screen, run the following command in
Terminal:
$> defaults write com.apple.Safari WebKitOmitPDFSupport-bool YES

About native Unica Marketing Operations markup
The native IBM Unica Marketing Operations markup tool uses the following icons
and controls. All icons include mouse over help.

Note: If another user is marking up a document at the same time as you, refresh
the browser page to see their comments.

Menu bar

This table describes the items in the menu bar.

Table 21. Icons and controls for the IBM Unica markup tool

Icon Description

Click Add Note, then drag to a specific location on a page to add
feedback.

You cannot move a note once saved. Each note is fixed to a location
that is important to the context of the feedback and any replies.

You can attach a file to a note.

Use the action links in a note to reply to, update, or delete the note.
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Table 21. Icons and controls for the IBM Unica markup tool (continued)

Icon Description

Click Add Scribble, then drag to add a free-from "scribble" on the page

Click Zoom In to zoom in.

Click Zoom Out to zoom out.

Click Zoom Reset to reset the size of the page to the original display.

Click Download Original to acquire a copy of the original attachment
that you can save to your local machine.

Click Toggle Annotations to display or hide comments.

Click Help for tips on using native markup.

Click Close Markup Window to close the markup tool.

Annotations list

This table shows the items available in the annotations list. You can sort on any
column by clicking its header.

Table 22. Columns in the annotations list

Item Description

Page filter A drop-down list where you can choose to view annotations for the
current page only, or for all pages in the document. If you select All
Pages, you can sort in ascending or descending order by clicking the
heading of the Source column.

Annotations filter A drop-down list where you can choose to view all annotations, only
active annotations, or only archived annotations.

Author filter A drop-down list where you can choose to view annotations from all
authors or only a single selected author. If you select Any Author, you
can sort by ascending or descending order by clicking the heading of
the Author column.
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Table 22. Columns in the annotations list (continued)

Item Description

Actions column On the page you are viewing, contains the following options.

v : Show Reply Dialog allows you to reply to the comment. Your
reply can include a heading, a body, and an attachment.

v : Update allows you to edit the comment. You can archive the
comment, change the text in the heading and body, and add an
attachment.

v : Delete allows you to delete the comment

If you are viewing all pages, the Actions column for comments on
pages you are not viewing contains a V (View) option that allows you
to jump to the page on which the comment exists.

Created Date
column

Shows the date on which the comment was added.

Author column Shows the author of the comment.

Title Shows the title of the comment.

Attachments Provides links to any attachments to the comment.

Archived A check in this column means that the comment is archived.

About enabling markup for approval items
Owners of approvals can choose whether to enable markup for attachments. If
markup is enabled for an attachment, and if IBM Unica Marketing Operations is
configured to enable markup for the file type of the attachment, anyone who can
view the attachment can use the markup functionality to comment on the object.

Approval owners enable markup functionality on attachments in two ways.
v When an owner adds an item to an approval, the system prompts to enable

markup for the PDF.
v For an existing approval screen, each approval item has Enable/Disable Markup

links. Click the link to toggle the markup functionality.

To allow users to add comments, choose Enable Markup when prompted.

To use markup

During installation, IBM Unica Marketing Operations was configured to use either
Adobe Acrobat markup or native Marketing Operations markup.

Anyone who has permission to view an approval can add comments to items
attached to the approval.

Note the following.
v Markup is only for latest/last version of the approval item.
v You can mark up items for an approval with a status of In progress or On hold

only.
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1. Navigate to the approval that contains the item to edit.
2. Click View/Add Markup next to the item on which to add comments.

If the link is unavailable, the owner of the approval chose not to enable
markup for the item. The item opens in a browser containing the document.

3. Mark up the item using either Adobe Acrobat or the native Marketing
Operations markup tool, depending on your installation.
v If your system uses Adobe Acrobat markup, only PDFs can be marked up.

Click Review & Comment in the Acrobat toolbar and click Note Tool in the
Commenting toolbar to start adding comments to the PDF.

v If your system uses the native Marketing Operations markup, use the icons
and controls in the markup tool. All icons include mouse over help. Inactive
controls are gray and cannot be selected.

4. Close the window that contains the marked-up item.

Any member can see the marked-up item by opening the container object and
clicking View/Add Markup. Members keep adding markups to the file this way.
To view the original file without the markups, click the link containing the name of
the attached item instead of View/Add Markup.

Approval process workflow

The lifespan of an approval process includes the following general stages.
1. You create the approval process, either as a stand-alone approval or as an

approval task in a workflow.
2. Add the items to be approved.
3. Add approvers.

v You can add as many approvers as you need.
v You specify whether each approver acts in parallel with other approvers or

before or after any other approver by specifying a sequence number.
v You specify approvers as required or optional.
v You can create individual instructions for each approver.
v If you are adding an approval workflow task, you may need to select project

roles for the approvers, for example legal approver and subject approver.
4. Submit the approval.
5. The system immediately notifies all the approvers with the sequence number of

"1."
No other required approver can respond to the approval yet; they must wait
their turn, which is based on the sequence order you specified when creating
the approval. However, optional approvers can respond at any time; optional
approvers are not tied to the established approver order.

6. Approvers respond to the approval. Depending on how IBM Unica Marketing
Operations is configured, the approver may also be able to place comments in
approval items.

7. Approvers assess each item attached to the approval and then post their
completed response.

8. The system notifies the next approver, based on the sequence numbers set in
the approval.

Several things to note about approval processes.
v The approval owner can cancel the approval process at any time in the process.
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v Approvers provide a separate opinion about each item in the approval: approve,
approve with changes, or deny. They then post the entire response.

v Marketing Operations organizes approvals in views. When you click Operations
> Approvals, by default the My Active Approvals view appears. This list shows
only approvals that are active and you are a member of (as either an owner or
approver).

You can click the Actions icon ( ) and select All Approvals, All My Team's
Unassigned Approvals, or All My Team's Approvals.

v In any view, you can change the sort order by clicking the column you want to
sort by. Click the column a second time to reverse the sort order.

v If an approval is linked to a task in the workflow, then the system considers the
Schedule Through setting for the task in addition to the system-wide setting for
non-work days.

v Approvals do not appear on the approval list of required approvers until it is
their turn to respond, at which time they receive a notification.

To submit an approval for review

After you add an approval process, you must submit the approval to notify the
approvers that the approval exists and they need to approve it.
1. Navigate to the Summary tab of the approval you want to submit.

2. Click the Status icon ( ) and select Submit for Review.
The Approvals window appears.

3. Enter any comments you want the approvers to see when they receive
notification of your approval, and click Continue.
The Summary tab of the approval appears with In Progress at the top of the
page.

Note: After an owner submits an approval, its status changes to In Progress. If
an owner makes any further changes to the approval, IBM Unica Marketing
Operations sends notifications to all owners and approvers.

About modifying approvals
The owner of an approval can make changes to the approval after it is created and
even submitted. For example, the owner can add new items for approval, or new
approvers to the list. The owner can also delete items and approvers, or update
existing items to be reviewed.

The process of modifying an approval is similar to creating one. Keep in mind the
following rules and behaviors for modifying an approval.
v Any owner of the approval process can modify it.
v By default, approvers cannot modify the information in the approval; they only

can respond to the approval (unless the security policy allows it).
v When modifying a submitted approval, the Approvals screen appears and

prompts you to add comments to send to new and existing approvers.
v If you want an approver who has already responded view your changes, check

the approver’s Request Reapproval check box.
Whenever you want an approver to reapprove, the system increments the
approval round number.
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To cancel an approval process

You can cancel the approval process at any time. Canceling the process does not
delete the approval. You might decide to cancel rather than delete a review if you
think you will need to see its details in the future.

If you cancel the approval process you cannot submit it for review at a later time.
Any responses or comments made before cancelation are saved, essentially
“freezing” the approval with all of its current details.
1. Select Operations > Approvals.

The My Active Approvals view appears by default.

2. Click the Actions icon ( ) and select All Approvals.
3. Click the approval you want to cancel to open it to the Summary tab.

4. Click the Status icon ( ) and select Cancel Review.
The Approvals window appears.

5. Enter any comments you want to add to the approval, for example, why you
want to cancel the review, and click Continue.
The Summary tab of the approval appears. The All Approvals view shows the
approval as Cancelled.
If you cancel an approval that is linked to a workflow task, the task is “crossed
out” on the workflow tab. That is, the font for the task and all of its details
changes to italics, strikethrough. Additionally, there is an ‘x’ in the status
column, indicating the workflow is considered "Skipped."

To copy an approval

You can copy an approval to create another approval that is similar to an existing
approval. You can make a copy of the existing approval and modify the copy,
leaving the original approval intact.
1. Navigate to the approval that you want to copy.

2. Click the Copy this Item icon ( ).
3. Click OK when Marketing Operations prompts to copy the approval.

The copy of the approval opens to the Summary tab. The copy appears as "Copy
of original approval name". The new approval has a status of Not Started.

Modify any information you want to change in the copy and click Save Changes.

The copy appears in your All Approvals view.

Details copied

The following details are copied.
v List of approvers and whether they are required or optional
v List of owners
v The subject, with “Copy of” before the original approval name
v Target Due Date
v Sequence
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v Description
v Items to approve

Details not copied

The following items are not copied.
v Any instructions for individual approvers are not copied.
v The contents of the message board are not copied.
v Information from the Analysis tab is not copied.
v The copy is not linked to any project workflow, even if the original is. That is,

copying an approval creates a stand-alone approval

To delete an approval

As the owner of the approval, you can delete the approval at any time.
1. Select Operations > Approvals.
2. Select the check box next to the approvals you want to delete.

3. Click the Delete this Item icon ( ) and click OK when IBM Unica
Marketing Operations prompts you to confirm the deletion.
You cannot delete an approval that is linked to a workflow task.

To complete an approval

After some criteria are met, it is a good idea to mark the approval complete.
Unless the approval was created with the Enable approval auto completion flag
enabled, it is entirely up to the approval owner as to when to complete the
approval. If auto-completion is enabled, the approval is automatically marked
Complete when the last required approver approves.

The following are some examples of when you might want to mark an approval as
complete.
v After all approvers have responded
v After the Target Due Date has passed
v After all suggested changes to approval items have been made
1. Select Operations > Approvals and then click the approval that you would like

to complete.

2. From the Summary page, click the Status icon ( ) and select Finish
Review.

3. Enter a comment about why you want to complete the review in the Approvals
window, and click Continue.

The approval appears with a status of Completed, and IBM Unica Marketing
Operations sends a notification that the approval process is finished.

To put an approval on hold

At any time after you submit an approval for review, you can put the approval on
hold. You can put an approval on hold to revise the approval items and request
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re-approval. Putting an approval on hold is different than canceling a review of an
approval process because you can make modifications and continue the approval
process.

Note the following behavior when you put an approval on hold.
v IBM Unica Marketing Operations notifies the approvers that the approval is on

hold.
v Approvers cannot approve or reject the approval during the time it is on hold.
v Owners can view the approval and add comments to any items submitted for

approval while the approval is on hold.
1. Select Operations > Approvals and then click the approval you want to put on

hold to open it.

2. Click the Status icon ( ) and select Stop Review.
3. Enter a comment about why you want to stop the review in the Approvals

window.
4. Click Continue.

The Summary tab of the approval appears with the status set to On Hold. IBM
Unica Marketing Operations sends a notification to the approvers informing them
that the approval is on hold.

To reactivate an approval that is on hold
1. Select Operations > Approvals and then click the approval you want to

reactivate.
Click the Actions icon and select All Approvals to see approvals that are
currently on hold.

2. Click the Status and select Continue Review.
3. Enter a comment about why you want to continue the review in the Approvals

window, and click Request Approvals.

Note: Whenever any approver is checked and you want them to reapprove, the
approval round number is incremented.

The approval appears with a status of In Progress and IBM Unica Marketing
Operations sends a notification to the approvers that the approval is active and
they can respond.

To respond to an approval

When it is your turn to respond to an approval or complete an approval task, IBM
Unica Marketing Operations notifies you through the Alerts window and by email.
Both the alert and the email contain a link to the approval. You can view the
approval in various views in Marketing Operations, such as the My Active
Approvals view.

Complete the following steps.
1. Click the link to the approval.
2. At the top of the Approval Response form, examine the approval description

and the instructions.
3. View an approval item by clicking the thumbnail image or the link for the item.
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The item opens in a browser.

Note: Select View/Add Markup to add in-document comments to the item. If
you do not choose this link, any comments you make are lost when you close
the item.

4. For each item listed, complete the following steps.
a. Click Post Feedback.
b. In the Response window, enter your review comments in the Your

Response section.
c. As an alternative to entering comments in this form, you can attach a

document that contains your comments. Under Additional Comments, click
Attach Comments File and upload the file that contains your comments.

d. Select the appropriate response for the item.
v Approve: indicates that you approve of the item as it is.
v Approve w/Changes: indicates that you made comments in an item or

added comments in the text box and you approve the item with those
exceptions

v Denied: indicates that you made major comments or suggestions
necessitating fundamental editing of the item by the approval owner.

5. After you respond to every item in the list and you are sure that you are
finished commenting, click Post Complete Response. At this point, you cannot
change your response.
The response form appears with your response listed next your name in the list
of approvers. IBM Unica Marketing Operations sends an alert and an email
message containing your response to the approval owner and sends an alert to
the next reviewer, if any.

To reassign a team approval

A team can be assigned as an approver. The routing options for the team
determine whether team members can respond to such an approval, or whether
the team manager must assign it.
v If the team has Managers can route approvals to members enabled, the

manager can assign approvals to members.
v If the team has Members can accept team-assigned approvals enabled, team

members can assign themselves approvals, without the manager needing to do
so.

v If the team has Members can return team-assigned approvals back to the team
enabled, team members can return approvals back to the queue for the team.

1. Select Marketing Operations > Approvals.

2. Click the Actions icon ( ) and select one of the following searches.
v All My Team Approvals or
v All My Team Unassigned Approvals

3. Select the approval or approvals to assign.

4. Click the Reassign Selected icon ( ).
5. For each selected task, select a team member for the assignment in the Assign

To field.

Note: Team members only can assign tasks to themselves or back to the team.
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6. After you make all the assignments, click Save Assignments to save your
changes and return to the Approvals list page.

After you or your team manager assigns an approval to you, you respond to it in
the same way you respond to approvals assigned to you as an individual IBM
Unica Marketing Operations user.

To add comments to an approval item

The owner can open an approval at any time and add in-document comments to
approval items. Approvers or other team members who can access the approval
can also use the markup capabilities to add comments to the item. Approvers can
view the comments added by other approvers.
1. Click the link in an alert or email notification message to open the approval, or

select Operations > Approvals and click the approval that has an item you
want to modify.

2. Click View/Add Markup next to the item that you want to add comments to.
3. The exact steps for adding in-document comments depend on whether you use

Marketing Operations or Adobe markup. In either case, add any comments to
the document.

4. After you finish marking up the document, close the window that contains the
marked-up item.

Any team member of the approval can see the marked up approval by opening the
approval and clicking View/Add Markup. Team members keep adding markups to
the file this way. To view the original file without the markups, click the link
containing the name of the attached item instead of View/Add Markup.

Editing an approval that is linked to a workflow task

Both stand-alone approvals and workflow approvals are listed in the approval
views. When you select an approval from either the view mode of a workflow or
from a list in an approval view, IBM Unica Marketing Operations displays the
approval in a pop-up window. When you edit an approval that is linked to an
approval workflow task, your work is reflected in the workflow task as follows.

Table 23. Results of editing an approval to a linked workflow task

Your action Changes to the linked workflow task

Cancel the
approval

The task status changes to Canceled.

Change the
approval due date

The task Forecast/Actual End Date changes to match.

Start the approval The task status changes to Active, and the Forecast/Actual Start Date
is set to the current date.

Pause the
approval

The task status changes to On Hold.

Complete the
approval

The task status changes to Finished, and the Actual End Date is set to
the current date.

Delete the
approval

You cannot delete a linked approval from the approval itself. You must
delete the approval task row from the workflow.

Chapter 7. Approvals 95



Approval response form
The Approval response form has two main areas, the Approval Summary and
Responses.

Approval response header

The header displays the name of the approval, the user that sent it, and the date
the approval is due. For example:
Handouts for Leads, sent by asm admin (due 03/20/2009)

The following icons can appear, depending on the user's permissions.

v The Edit icon ( ) is visible, if the user has edit permission for approvals.

v The Status icon ( ) is disabled, unless the user has Alter approval status
permission.

Approval summary

This section of the Approval Response form displays the items for review and their
accompanying descriptions.

Note: On the right side of the section, the state of the approval (for example, In
Progress) is displayed.

You can select an item to view. If commenting is enabled, you can also view
comments by other approvers and add your comments to the file.

Table 24. Approval summary

Item Description

Description Displays the description for the entire approval.

List of items Displays all the items for the approval. Note that you can:

v Click the item name to open the item in its own window.

v Click View/Add Markup to add comments to a PDF. This link is
available for PDFs only, and only if markup is enabled for the item.

v Click Post Feedback to add comments for the item. A new page
appears so that you can enter comments.

Use the feedback page to add comments, attachments (such as screen
captures), or add or view markup if applicable.

v Click Send as Mail Attachment to send the item using your email
application.

v Click the status of the approval item (for example "2 of 3 Approved")
to view the details of each response.

Instructions Displays any instructions for the approver.

Approval status
bar

Displays your progress for the current approval. For example:

You have approved 1 item(s), denied 0 item(s)
and pending 1 item(s).
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Table 24. Approval summary (continued)

Item Description

Post Complete
Response

Click after you respond to all of the approval items. A confirmation
page appears where you can add any final comments.

Note the following.

v If the approval owner requires disposition of all items, and you click
Post Complete Response before responding to all items, the system
generates the following warning message: "Please respond to all
documents before marking the process as complete."

v If the approval owner does not require disposition of all items, you
must respond to at least one approval item, or the system generates
the following warning: "Please respond to at least one document
before marking the process as complete."

v You can respond to an approval item multiple times before you
complete your response to the entire approval process. However,
after you click Post Complete Response to complete the review you
cannot respond to the approval again.

Approval responses

This section lists overall status of the approval for each approver, in the following
format.
v Name of the approver
v (Required) if the approver is marked as required.
v Response status: either Approved, Denied, Approved w/Changes, waiting, or

not yet notified.
v Date of response, if the approver has responded.

Note the following.
v Overall approval response status is dependent on the response status of each

approval item. For example, if an approval contains two items to approve, and
approver approves (or approves with changes) both the items, then the overall
response is Approved. But if approver denies one of the items, then the overall
response is Denied, and the approval state is changed to Rejected.

v After you complete your review, the Post Feedback link changes to View Item
Responses. You can then view the item responses and response history only.

Notes on responding to an approval
Approval processes can contain sequential and parallel portions. For example,
suppose that the following approvers are set with the following sequence numbers.
v Mary Manager: 1
v Connie Contact: 2
v Larry Lawyer: 2
v Pablo Picasso: 2
v Charlie CFO: 3

Mary Manager, Larry Lawyer, and Charlie CFO act sequentially; that is, Mary
Manager must act before Larry Lawyer, who must act before Charlie CFO.
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Connie Contact, Larry Lawyer, and Pablo Picasso all act simultaneously, in parallel.
That is, Larry Lawyer can respond even if Pablo Picasso has not yet responded,
and vice versa.

Note the following approval behavior.
v You cannot respond to the approval if it is not your turn. When selecting such

an approval, you get a message that you cannot yet respond to the approval.
After the required approvers ahead of you respond, you are notified and can
complete your review.

v If it is not your turn to respond, but you navigate to the approval and click
View/Add Markup for an approval item, you receive a warning message.

v If a required approver denies the approval, the approval is put On Hold and no
other required approvers can respond. For example, if the third of five required
approvers denies the approval, the fourth and fifth required approvers cannot
respond. Instead, the system sends a notice to the approval owner and the first
two approvers that the approval changed to On Hold.
An approval owner must update the approval and request reapproval from the
person who denied the approval in order for the next required approver to be
able to respond.

Important: IBM Unica Marketing Operations does not support using the Save and
Work Offline button in Adobe Acrobat. That is, if you use Save and Work Offline,
add markup, go back online, and try to send and receive your comments, your
edits may be lost.

New/edit approval page

This page appears when you begin to add an approval process. It also appears
when you open an existing approval process for editing. It contains two sections,
Approval Summary and Approvers.

Note: If you do not see the Approvers settings, click the turn down ( ) next to
the Approvers label.

Approval Summary

This section of the New or Edit Approval Process form contains some summary
information for the approval.

The name of the approval contains a round number, if the approval round is
greater than 1. For example, assume that an approval titled Handout: Final
Approval that has been resubmitted one time. On its summary page, the title is
Handout: Final Approval (Round #2).

The Approval summary page contains the following fields.
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Table 25. Approval summary page

Field Description

Sent By Displays a list of the owners of the approval.

By default, this field is auto-populated with the user name of the
person creating the approval.
Note: While the system allows an owner to also be an approver, this
selection is not typical; we recommend specifying people as either
owners or approvers, but not both.

Add/Remove
Owner(s)

Click to add or remove owners for the approval process.

The Select Member Access Levels dialog box appears. Browse to a
user in the one of the folders and use the arrows to add the user to the
Selected Team Members list and click Save Changes.

Security Policy Select the security policy you want to apply to the approval. If this
approval is already part of a project (or being linked to a workflow
task), IBM Unica Marketing Operations defaults to the security policy
for the project and you do not have to change it.

If creating a stand-alone approval, this setting defaults to the security
policy in your preferences (in the Administration > Basic Settings
screen). If you do not know which security policy to select, contact
your administrator.

Enable Mark up When viewing the Summary tab, use this link to toggle the setting to
either enabled or disabled. After you enable this option, the item can
be marked up using IBM Unica Marketing Operations mark up
functionality. This option is available only for file types for which
markup is supported.

Approvers

This portion of the New or Edit Approval Process form contains a list of approvers
and items to approve, as well as other options to configure the approval process.

List of approvers

This section of the page displays a list of approvers. By default, this field is empty.
Add approvers by using the Add Approvers link.

Note the following:
v Individual users or teams can be set as approvers.
v By default, approvers are added as Required.

Table 26. Information in the list of approvers

Field Description

Approver role A role or roles associated with the approval task. These can be loaded
automatically from the project template used to create the project, or
the project owner can set them up manually. This field is not available
in stand-alone approvals.

Approver Name Displays the user name of the approver. You can use the drop-down
menu to update the approver.

Default Duration Displays a duration selection control. Specify the actual duration for
each approver or approval step.
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Table 26. Information in the list of approvers (continued)

Field Description

Sequence Displays the order in which the approvers need to respond. Enter
integer values in the field for each approver, as follows.

v Assigning the same number to more than one approver means that
these approvers act in parallel, and can respond to the approval
simultaneously.

v When a user revisits this page, approvers are listed by their
sequence number, rather than the order they were added to the
approval.

v Use the sequence numbers to specify the order in which approvers
act, as well as whether some approvers act in parallel or in sequence.

Required Check the box next to each approver who must approve. If this box is
not checked, the approver is optional. Note the following behavior for
required approvers.

v If an approver is required, the next approver in sequence is not
notified (and cannot respond) until the current approver responds.

v If an approver is required, and that approver denies the approval,
then the next sequential approver is not notified. Instead, the
approval is placed on hold and the owners are notified.

v If multiple approvers have the same sequence number (and therefore
can act simultaneously), and one of the required approvers rejects
the approval, a notification is sent to the approval owner. However,
the approval process continues until all the required approvers of the
simultaneous process respond.

v At least one approver must be set to Required. Although a user can
save the approval with all optional approvers, such an approval
process cannot be started. The system generates a warning message
if someone tries to start an approval that does not contain a required
approver.

Instructions for
approvers

Add any instructions or comments for the approver to see when they
open the approval.

Note: This field is not available in a stand-alone approval.

Add approvers Clicking this link opens the Select Approvers dialog box, where you
can edit the list of approvers.

Other fields

The bottom portion of the page, above the list of approval items, contains the
remainder of the approval settings.

Table 27. Other approval fields

Field Description

Subject Add a short subject for the approval. This text should be fairly
descriptive, as it shows up in the Approval List for help in
differentiating between all the approvals on the list.
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Table 27. Other approval fields (continued)

Field Description

Target Due Date Enter a target date by which you want the overall approval process
completed. Use the calendar icon in the drop-down list to choose a
date from the calendar.

Note the following.

v This field is required to start the approval process.

v Depending on project reminder settings, a reminder is sent to
approvers on the date you enter here.

v If the approval is sequential, the Target Due date should be equal to
today’s date plus the sum of the values in the Default Duration field
for each approver.

v If the approval is simultaneous, the Target Due Date should be equal
to today’s date plus the maximum of the values in the Default
Duration field for each approver.

For example, suppose that the following approvers are added to the
approval.

Name Seq. Dur.
A 1 1 day
B 2 2 days
C 3 1 day

If the approval is started on 14 July 2008, the Target due date would
be 18 July. If you set the Target due date earlier than the correct
calculation dictates, the system generates an error, and the approval
cannot be saved until the durations and dates are reset to
appropriate values.

v You cannot start an approval process if its Target due date is past.
You must first change the target date to some future date.

Description Displays the text details for the approval.

Re-approval Rules Select the rule to use for this approval. You can restart the approval,
continue from current review step, or select the approvers who need to
review again.

Disposition on all
approval items
required

Check box that determines whether all approval items need to be
reviewed. If this box is checked, each approver must approve or deny
all approval items.

Enable comment
attachments

Check this box to allow approvers to add comments attachments while
responding to the approval. By default, this option is selected.

Enable approval
auto completion

Check this box to have the system automatically mark the approval
Completed after the last required approver approves. By default, this
option is not selected.

Items to approve

This section contains a list of actual items to be reviewed, and controls to add and
configure approval items.

Table 28. Items to review for an approval

Field Description

Item Thumbnail Displays a thumbnail image of the item, if one was added when
adding the item. If the item is a PDF, the image is the one your system
uses to represent PDFs.

Item Description Text box displays the comments for the item.
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Table 28. Items to review for an approval (continued)

Field Description

File Update

Asset Update

URL Update

When editing an approval, use these links to update items with a new
version.

v Use File Update to upload an item stored on your computer or
network.

v Use Asset Update to upload an item from an asset library.

v Use URL Update to change a URL pointing to a website.

When you use one of these links, you attach a new version of the item;
users can then access the older version and the newer version of the
item in the approval.
Note: There is no limitation placed on what kind item you select when
you update. That is, the system does not object if you update a
brochure with a logo image. However, if you are updating an item
with something that is different from the original item, it is best
practice to add it as a separate item rather than updating the original
item.

Remove When editing an approval, use this link to delete an item. It will no
longer be available for review.

Add Item(s) to
approve

Attach documents or URLs for approvers to review by clicking this
link.

The Add Item(s) to Approve page appears.

v In the Add Item to Approve field, select one of the following
options: From My Computer, From the Asset Library, URL, or
Marketing Object.

v Do one of the following.

– Browse to the file you want to attach and click Open.

– Click Browse Library to attach a file in an asset library. Click the
library that contains the file you want to add and use the tree in
the left panel of the screen to navigate to the folder and then the
asset that you want to attach. Click Accept Asset when viewing
the asset in the right panel.

– Enter the URL in the field provided.

– Click Browse to search for a marketing object. When the dialog
box appears, search and select a marketing object. Click Accept
and Close to close the dialog or Accept to temporarily accept the
marketing object and search for more.

v Add any comments in the Comments field. Click Add More to
display an additional set of fields for each additional attachment you
want to add.

v Click Save Changes when you have added all your attachments.

Note the following.
v To add an item from your computer or network, choose Add Item(s) to

Approve.
v If IBM Unica Marketing Operations is configured to use Adobe Acrobat markup,

and if you want the approvers to be able to electronically add comments to a
document, then the document must be a PDF. If you attach any other file format,
approvers cannot use the markup capability. You can use Adobe Distiller to
convert a document to a PDF.
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Chapter 8. People and teams

In IBM Unica Marketing Operations, you assign work to individual users or to
teams.

About people and teams
You assign people or teams to units of work. You make assignments primarily
through the People tab on a project. You can also add and assign members, teams,
and roles when editing the workflow tab.

Note: You may see only a subset of the people and teams available. Your
organization can limit the view of available resources.

About the People tab
Each project contains its own People tab. Use this screen to do the following.
v Manage the members of a project.
v Edit access level for a member.
v Replace a person in a role when a team member becomes unavailable.
v Add or remove a role.

A project template can contain information about the functional roles for the
project. A template can reduce some of the work necessary to assign people or
teams to units of work within the project.

Managing project members
Use the People tab to perform the following tasks.
v Add a project member.
v Remove a member from the project.
v Change a role for a member.
v Additionally, use this page to add and remove roles.

Note: A role must exist within the project before you can assign it to a team
member.

Security permissions for the People tab are as follows.
v View People tab.
v Edit Team Members, Roles, and Access Levels.
v Assign Work by Role. Users with this permission can also access the Assign

Work by Role and Find/Replace dialog boxes.

Note: Users with View People tab and Edit Team Members, Roles, and Access
Levels permissions can automatically add members and member roles on
workflow spreadsheets without adding them to the People tab first.
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Notes on managing project members
v To assign an unlisted role, create it using the List Definitions section of the

Administrative Settings if you have the appropriate permission to access this
item.

v The list of people in the Folders section of the Select Project Members dialog box
is populated from IBM Unica Marketing Platform, and may be limited based on
your role and permissions. For details, consult your IBM Unica Marketing
Operations administrator or the IBM Unica Marketing Platform Administrator’s
Guide.
The list of teams in the dialog box is based on the teams defined in Marketing
Operations. As with the list of people, the teams you can view may be limited
based on your role and permissions.

v The email address appears only if this information has been entered for the user
in the platform.

v You cannot remove project members (or roles) who have tasks assigned to them.
You must remove them from all future work before removing them from the
project.

v In the Project Members column, teams are in italics and are preceded by the

icon. Individuals are preceded by the icon.

To manage project members
1. Navigate to the People tab of the project.

2. Click the Edit Member/Role Settings icon ( ).
The Select Team Members dialog box opens.

3. Do one of the following.
a. To add a person or team, select the name from the left pane of the dialog,

and click >>.
b. To remove a person or team, select the name in the Select Team Members

list box and click <<.
c. To change the role for a person or team, select the name in the Select Team

Members list box and use the Up and Down controls to move them to the
required role.

Note: You cannot remove a user or team assigned to a task.
4. Click Save Changes.

The Select Team Members dialog box closes. The People tab becomes the
active window.

The changes you make are reflected in the list of people and roles. For example, if
you added a creative lead, the screen would contain a line similar to the following.
Member/Access Level Role Email Address
P Picasso (participant) Creative Lead ppicasso@unica.com

Managing teams
Selecting Operations > Teams opens the My Teams page. Use this page to do the
following.
v Create and remove teams
v Assign team managers and members
v Set the work routing model
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v Enable and disable teams

These groups of people are available across templates and object instances. Project
Managers can assign tasks to teams, in addition to being able to assign them to
individual members.

Wherever you can assign or work with individuals, you can also work with teams.
For example, the procedure “To assign people to roles” on page 115 can be used to
assign individuals or teams to roles.

About team alerts: IBM Unica Marketing Operations sends alerts for team-related
events in the same way it sends alerts to individuals.

Additionally, alerts have the following behavior as applied to teams:
v For tasks assigned to a team, all the team members and managers receive the

alert
v After a task is assigned to a team member, only the member and managers

receive the alert

For the following events, only the specific team member affected by the event
receives the alert
v A member is added to the team
v A member is removed from the team
v A team-task is assigned to a member of the team
v A team-task assigned to a user is reassigned back to the team or to another

member

Team summary page:

When you first navigate to a team, its summary page appears. This page contains
the following items.

Table 29. Team summary page

Field Description

Name Displays a name for the team. This name appears on the Teams list
page, as well as selecting project members or reviewers.

This field is required.

Description Displays a short description for the team.

Skill Sets Displays a list of skills associated with the team.

Add terms here that might be useful when describing teams. For
example, you can enter Photoshop as a skill, so that anyone viewing
the team knows that the team has this skill.

Suggested
Security Policies

Displays the security policy or policies that apply to the team.

This field is required.

Routing Models Check any combination of the work routing option check boxes.

Members and
Managers

Displays the managers and members of the team. Use the scroll bar to
page through the list.

From the Team Summary screen, you can perform the following actions.
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Table 30. Actions available from the Team summary page

Action Details

Edit the team Edit the fields for the team and members by clicking the Edit icon (

).

Change alert
subscriptions Click the Manage icon ( ) and select Set Alert Rules to change the

way team members and managers are notified of task assignments.

Delete the team
Click the Delete this Item icon ( ) to remove the team.

Copy the team
Click the Manage icon ( ) and select Create a duplicate Team to
create a copy of the team. The system opens the summary page of the
new team in edit mode.

Add a team
Click the Actions icon ( ) and select Add Team to add a team.

Navigate back to
the Teams list
page

Click All Teams or My Teams in the breadcrumb; either or both of
these links are displayed, depending on how you navigated to the
current summary page.

Or, click the Action icon ( ) and select All Teams or My Teams.

Print team details

Click the Print icon ( ) to print the details of the team.

To add or edit teams:

If you have the appropriate permissions, you can add or edit teams.
1. Select Operations > Teams.

The Teams list page appears.
2. Do one of the following.

v To create a team, click the Add Team icon ( ).
v To edit an existing team, click a team to display its summary page, then click

the Edit icon ( ).
3. Complete the fields on the Team summary page.
4. Click Save Changes to save your changes to the team.

To edit members of a team:

If the people you want to add to a team do not appear in Select Team Members
and Roles, you must add them as IBM Unica Marketing Operations users in IBM
Unica Marketing Platform.

You can set team members and managers when you create a team. Additionally,
you can edit the members of a team any time during its existence.
1. Select Operations > Teams.

The Teams list page appears.
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2. Click the team to edit from the Teams list page. To edit a team that is not listed,
click All Teams to display all available teams. If it is still not visible, you may
not have the appropriate permissions to view it.
The Teams summary page appears.

3. Click the Edit icon ( ).
4. Click Add/Remove Managers and Members. The Select Team Members and

Roles page appears.
5. Move people into and out of the team as appropriate.

About routing work for teams: When you edit a team, you can choose how tasks,
approvals, and project requests are routed for that team.

Task routing options: You can check any of the following options under the Task
Routing Model section of the Team summary.
v Managers can route tasks to members

Tasks assigned to the team appear on the team manager tasks page. The
manager can then assign these tasks to team members.

v Members can accept team-assigned tasks

Tasks assigned to the team appear on the My Tasks page for each team member.
Team members can then assign a task from the list to themselves.

v Members can return team-assigned tasks back to the team

Members can return their tasks back to the team.

When you set up a team, you must select one or both of Managers can route tasks
to members and Members can accept team-assigned tasks.

Note: To view team tasks, you must apply either the All My Team Tasks or All My
Teams Unassigned Tasks filter from the Tasks list page.

The task routing options function independently, and you can choose any
combination for the team. For example, you want the manager to be able to assign
tasks to members and the members to be able to return assigned tasks back to the
unassigned queue. Therefore, you select both Managers can route tasks to
members and Members can return team-assigned tasks back to the team. If you
want the manager to be able to assign tasks to members, but not allow the
members to return assigned tasks back to the unassigned queue, select only
Managers can route tasks to members.

Approval routing options: IBM Unica Marketing Operations provides the same
routing options for both task approvals and stand-alone approvals as for standard
tasks. As for standard tasks, a team can have any combination of options for
routing approval tasks.

You can check any of the following options under the Approval Routing Model
section of the Team summary.
v Managers can route approvals to members

The manager can assign these approval tasks to team members.
v Members can take ownership of team-assigned approvals

Team members can then take ownership of these approval tasks.
v Members can return team-assigned approvals back to the team

Members can return their approval tasks back to the team.
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When you set up a team, you must select one or both of Managers can route
approvals to members and Members can take ownership of team-assigned
approvals.

Request routing options: IBM Unica Marketing Operations provides similar routing
options for project requests as for tasks. You must select at least one of the
following options under the Project Request Routing Model section of the Team
summary.
v Managers can route project requests to members

The manager can assign these requests to team members.
v Members can accept team-assigned project requests from the team.

Team members can take ownership of these requests.
v Members can return team-assigned project requests back to the team

Members can return requests they previously accepted

Virtual project participants:

If a user is a member of a team that participates in a project, but the user is not a
participant of the project, the user can see team tasks assigned for the team, and be
assigned such tasks. Additionally, such a user can view the project and all of its
tasks.

Consider the following scenario.
v Don is a member of the Major Accounts team.
v The Major Accounts team has Members can accept team-assigned tasks

enabled.
v The Major Accounts team is assigned in the Members column of the Handouts –

design workflow task for the Fall 2007 Tradeshow project.
v Don is not a project member for the Fall 2007 Tradeshow project.

Even though Don is not a member of the Fall 2007 Tradeshow project, he can view
and update the Handouts – design task, by navigating to his All My Team Tasks
page and selecting the Handouts – design task. In this case, Don is a virtual
participant for the Fall 2007 Tradeshow project, and can view all of its project and
task information.

Assigning team tasks:

Depending on the work routing options, team managers can assign tasks to team
members, or members can pull tasks off the queue themselves.
v If the team has the Managers can route tasks to members option enabled, team

managers can assign tasks to team members.
v If the team has the Members can accept team-assigned tasks option enabled,

team members can assign themselves any unassigned team tasks.
v If the team has the Members can return team-assigned tasks back to the team

option enabled, team members can return tasks assigned to them back to the
pool of unassigned team tasks.

1. Select Operations > Tasks.

2. Click the Actions icon ( ) to display all saved searches/filters for tasks.
3. Choose one of the following searches.
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v To display all tasks assigned to the team, grouped by assignment, click All
My Team Tasks.

v To display all tasks assigned to the team that are not assigned to any team
members, click All My Team Unassigned Tasks.

Note: You cannot reassign tasks from the All Tasks page. To reassign tasks,
select another filter; for example, All My Team Tasks.

4. Check the boxes for all the tasks to assign. To select all listed tasks, you can
check the box for the Name column.
The Reassign Selected page appears. If you do not have permission to assign
the selected tasks, the page contains a message to this effect.

5. For each selected task, select a team member for the assignment in the Assign
To field.

Note: Team members only can assign tasks to themselves or back to the team.
6. After you make all the assignments, click Save Assignments to save your

changes and close the page.

Assigning team requests:

You must have appropriate permissions to assign a team to a project request.

1. Go to the People tab of the project and click the Members/Roles icon ( ).
A dialog box opens listing teams and team members to assign.

2. Select a role in the Selected Members and Roles area, and move a team from
the list of teams and team members to assign that team or team member to the
selected role.
If you assign a team member to a role, the team is not automatically assigned.

To change the access level for a project member

While all IBM Unica Marketing Operations objects have access levels, it is useful to
change access levels for projects only.
1. Navigate to the people tab of the project.

2. Click the Change Member Participation Level icon ( ).
This icon is unavailable unless you have the appropriate permission. Typically,
project owners and IBM Unica Marketing Operations administrators have this
permission, but it may be assigned differently depending upon the security
policy for the project.
The Change Member Participation Level page appears.

3. In the Selected Team Members list box, select the member who has an access
level to change.

4. Use the Up or Down controls to move the member to the new access level.
5. Repeat Steps 3–4 as necessary.
6. Click Save Changes.

The Change Member Participation Level dialog box closes, and your changes are
applied. The people tab becomes the active window.

Note the following.
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v The list of people in the Folders section of the Change Member Participation
Level page is populated from IBM Unica Marketing Platform, and may be
limited based on your role and permissions. For details, consult your IBM Unica
Marketing Operations administrator or the IBM Unica Marketing Platform
Administration Guide.
The list of teams in the dialog box is based on the teams defined in Marketing
Operations. As with the list of people, the teams you can view may be limited
based on your role and permissions.

v You can also use the Change Member Participation Level link to add users to
the project. They are added with the selected access level and placed by default
into the Unassigned role.

v Access levels are associated with objects, and cannot be created or removed. For
example, approvals always have two access levels: owner and approver.

Finding and replacing task members or reviewers

After you click the Find and Replace Task Members icon ( ) or the Find and

Replace Task Reviewers icon ( ), the Find and Replace Task Members or Find
and Replace Task Reviewers page opens.

You can replace any member or reviewer with any other current member of the
project. To replace with someone not on the project list, you first need to add that
person to the project. (This requirement applies only to owner-assigned task
members and reviewers. To remove a member or reviewer assigned by an
administrator when a template was created, you must go to the approval and
remove them, assuming you have permissions to do so.

Note: When accessing the Find and Replace Task Members/Reviewers page, the
project Workflow is locked; any other user who attempts to access it receives a
warning message, indicating the workflow is currently in use.

The following table describes some uses for the search and replace feature.

Table 31. Search and replace use cases

Goal Select Replace with

Switch specific resources:
replace a given user, in a given
role, with another user for all
tasks in the project.

task member/reviewer =
Karen

role = Project Manager

Connie Contact

Switch specific users: replace
a given user, anywhere on the
project, regardless of role.

task member/reviewer =
Karen

role = Any Role

Mary Manager

Add a backup to a role: add
another person to a role, as a
backup or additional resource.

task member/reviewer =
Karen

role = Project Manager

Connie Contact

Assign tasks to a role: newly
assign a given user to tasks,
by role.

task member/reviewer = Any
User

role = Project Manager

Mary Manager
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Note: To delegate tasks to another user temporarily, each user can define Out of
Office settings. For more information, see “Defining out of office settings” on page
14.

This page contains the following sections.
v Filters: Allow you to filter the search by role, task member, or a date range.

Filters are at the top of the page.
v Buttons: Allow you to preview and update the search. The buttons are at the

center of the page.
v Search results: Displays tasks that meet the search criteria. Use it as a preview

of the tasks that will change if you click Update All Occurrences.

Filters

Use the top-most fields in the Find and Replace Task Members/Reviewers dialog
to filter the results. You can search by role, task member, or project date ranges.

Table 32. Filters on the Find and Replace Task Members/Reviewers dialog

Field Description

Task member or
reviewer is

Select the name of the member to replace.

The list contains all team members and reviewers on the project. It also
contains a choice for any user, which is the default.

Role is Select the role of the task member to replace.

The list contains all roles in the project, and also contains a choice for
any role, which is the default.

Date Constraint Check this box to search using a date range. If selected, you can choose
the following information.

v Type of task: supply the type of date to search, either forecast or
target, in the for tasks box.

v Range: choose dates for the search range.

Status Select the status on which to filter. You can choose
Pending/NotStarted, Active/In progress, or both.

Replace
with/Add this
task member

Select one of the radio buttons, depending on whether to replace or
add members/reviewers. Then, enter the person you want to fill the
selected role on the tasks in the search results.

Buttons

Table 33. Buttons on the Find and Replace Task Members/Reviewers dialog

Button Description

Find All
Occurrences

Preview search results. You can view the list of tasks that meet your
search criteria in the Search Results area of the page.

Update All
Occurrences

Update members, after you confirm that the list of tasks is correct. As a
best practice, click Find All Occurrences before doing the update.

Cancel Close the page without making changes.
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Select project members/reviewers

The Select Project Members page appears when you are adding or removing
project members, and the Select Reviewers page appears when you are adding or
removing reviewers.

Note: You may see only a subset of the people and teams available in IBM Unica
Marketing Operations, since your organization can limit the view of available
resources.

Table 34. Fields on the Select Project Members/Reviewers page

Field Description

Folders Displays a list of users you can choose from.

v The list of people is set up by an administrator in IBM Unica
Marketing Platform.

v The list of teams is based on the teams defined in IBM Unica
Marketing Operations.

Roles Displays a list of roles in your system. It is set up by an administrator
and contains all the roles defined in IBM Unica Marketing Platform
and IBM Unica Marketing Operations template files.

In the Select Project Members or Select Reviewers page, use the Roles
tab to add roles for the members and reviewers.

Selected Project
Members /
Reviewers

Displays the current list of members or reviewers for the project. You
can move people and roles to and from the list and reorder them using
the buttons.

Note: An asterisk (*) next to a role indicates that the role is used in the workflow,
and therefore cannot be deleted.

To manage reviewers

Reviewers are different from project members because they do not have access to
the project. The reviewer roles and users are defined in the people tab to be used
in the workflow, mostly for approval tasks.

Use the Select Reviewers page to perform the following tasks.
v Add a reviewer
v Remove a reviewer from the project
v Change the role for a reviewer
1. Navigate to the people tab for the project.

2. Click the Reviewers/Roles icon ( ).
The Select Reviewers dialog box appears.

3. In the Selected Reviewers list box, select a person or team.
4. Do one of the following.

v To add the person or team to the project, select them from the left pane of
the page, and click >>.

v To remove the person or team from the project, click <<.
v To change the role for a person or team, use the Up and Down controls to

move them to the required role.
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5. Click Save Changes.

The Select Team Reviewers dialog box closes and your changes are applied. The
people tab becomes active.

Editing access levels for a member

IBM Unica Marketing Operations is a collaborative tool, and people using the
software may need varying degrees of access to projects. Marketing Operations
accomplishes this requirement, in part, with the ability to assign different object
access roles to project members. Object access roles are also sometimes called
access levels.

Access levels are default roles that exist for different types of objects. For example,
a project has an owner, participant, requester, and approver. A request has an
owner and recipient. While the names of the object access roles are fixed, the
security permissions granted by them depends on the security policy assigned to
the object.

IBM Unica Marketing Operations objects contain the following access levels.

Table 35. Object access levels

Access level Description

Owner All object types have owners, usually the person who created the
object. Owners can typically perform any function associated with an
object, such as adding members to the team or editing the properties of
the object.

Participant Can typically view the object, but not edit it.

For projects, when a project is created using the wizard, all members
added to the project become participants by default.

Requester
(projects only)

Can typically view the project, but not edit it.

If you create a project from a request, the owner of the request
becomes the requester of the project.

Recipient
(requests only)

Can accept or return a request. A requester submits a request to the
recipient, who then decides what to do with the request.

Approver
(approvals only)

Can approve, deny, or suggest changes to an approval assigned to
them.

Sometimes, a project owner needs to change the access levels of a member or
members. For example, after assigning people to roles, there are many people with
the Participant access level. You can grant some of them owner-level access or
deny some of them even participant privileges.

About roles
Ask your IBM Unica Marketing Operations administrator if you need help with
permissions.
v View People tab. Users with this permission can view the People tab.
v Edit Team Members, Roles, and Access Levels. Users with this permission can

edit members, roles, and access levels
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v Assign Work by Role. Users with this permission can assign tasks to roles and
people, and access the Assign Work by Role and Find/Replace dialog boxes.

To assign work by role

Typically, at the beginning of a project, the project owner or manager assigns work
to the members of their team. The section describes how to perform this task for
owner-assigned approvers (as opposed to approvers assigned in the template).

1. Click the Assign Work By Role icon ( ).

Note: If the project started, a warning dialog box appears; click OK to proceed
or Cancel to cancel the assignment process.
The Assign All team members and reviewers to their respective tasks page
appears.

2. Select one of the following.
v Select append the new user to add members to the existing assignments.
v Select replace the existing assignment to replace anyone currently in a role.

3. Click OK.
A confirmation dialog box appears.

4. Click Close.

In the workflow, all users assigned to roles are also assigned to the tasks associated
with their role.

Note the following when you assign work.
v When you access the Assign All team members and reviewers to their

respective tasks dialog, the project Workflow is locked; that is, any other user
who attempts to access it receives a warning message, indicating the workflow is
currently in use.

v Only tasks with a status of pending have people assigned to them when
performing this task; all other tasks remain unchanged.

To remove a role

If you are removing a role, note the following.
v If you delete a role that has people or teams assigned to it, they are not removed

from the project. Instead, they are reassigned to the Unassigned role.
v The Unassigned role cannot be removed.
v You cannot remove a role that has work assigned to it. You must first either

assign a person or team to that role, or assign the work to a different role.
v You cannot remove a user who is assigned to a workflow task.
1. Navigate to the People tab for the project.
2. You can remove a member or reviewer role.

v To remove a member role, click the Members/Roles icon ( ).

v To remove a reviewer role, click the Reviewers/Roles icon ( ).
3. Select a role to remove, and click <<.

If the role selected for removal has people or teams assigned, a warning dialog
box opens. Click OK to remove the role, or Cancel to keep it.
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4. Click Save Changes.

The Select Project Members/Reviewers dialog box closes. The People tab becomes
the active window. Your changes are reflected in the list of people and roles.

To add a role

Occasionally, a project owner or manager realizes that the project needs another
project role. For example, the organization decides that a certain project needs the
Legal department to approve its collateral. If this role is not added when the
project is created, the project owner can add it to the project later.

Note the following.
v The system does allow you to add a role that exists in the project already.

However, this action does not result in a duplicate or copy of the role.
v Permissions based on project roles can be configured at the template level only.

You cannot configure custom security for project roles that are added to a project
after the project was created.

v A project role must exist before you can add it to a project. To create a project
role, select Administration > List Definitions > Roles (note that you must have
the appropriate permission in order to access this item). Then you can add the
role to your project using the steps that follow.

1. Navigate to the People tab for the project.
2. You can add a member or reviewer role.

v To add a member role, click the Members/Roles icon ( ).

v To add a reviewer role, click the Reviewers/Roles icon ( ).
3. Click the Roles tab in the list box on the left side of the page.
4. Select a role to add, and click >>.
5. Click Save Changes.

The Select Project Members/Reviewers dialog box closes. The People tab becomes
the active window. Your changes are reflected in the list of people and roles.

To assign people to roles

Before you can complete this task, the workflow must be set up to include the
necessary tasks and approvals, and a role must be assigned to each task that
should have one. The requirements for a project derive from the template that it is
based on.

Note the following.
v Administrators create roles using the List Definitions section of the

Administration menu item.
v The list of people in the Folders section of the Select Project Members page is

populated from IBM Unica Marketing Platform, and may be limited based on
your role and permissions. For details, consult your IBM Unica Marketing
Operations administrator or the IBM Unica Marketing Platform Administration
Guide.

v Administrators can define assignments using the Request tab of the template.
Therefore some roles can be pre-assigned.
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v The list of teams in the Select Project Members page is based on the teams that
defined in Marketing Operations. As with the list of people, the teams you can
view may be limited based on your role and permissions.

1. Navigate to the People tab of the project.
2. You can assign work to project members or reviewers.

v Click the Members/Roles icon ( ) to add project members.

v Click the Reviewers/Roles icon ( ) to add reviewers.
The Select Project Members or Select Reviewers dialog box appears.

3. The template used to create the project may contain the necessary roles. If so,
skip this step. Click the Roles tab on the left side of the dialog and add all the
roles you might need for the project.

4. In the Selected Team Members/Reviewers list box, select the role you want to
assign.

5. Click the Folders tab, and navigate to the person or team to assign.
6. Select the person or team and click >>.

The selected person or team is assigned to the selected role.
7. Repeat Steps 4 through 6 until each member and reviewer role has at least one

person or team assigned to it.
8. Click Save Changes.

The Select Project Members/Reviewers dialog box closes. The People tab becomes
the active window.
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Chapter 9. The calendar

Marketing organizations typically organize their work with calendars. For example,
seasonal events drive marketing programs, as well as other external dates, such as
store openings, and seasonal product announcements.

Historically, organizations produced paper-based calendars and updated them with
the latest calendar-driven data. The calendar feature provides marketing groups
with an electronic means of viewing and updating this data.

You can customize the appearance of the calendar in the following ways.
v You can set your default view of the calendar by using the Calendar/Timeline

Settings screen.
v You can choose the look of the calendar by using the Set View Options dialog

box.
v You can filter the items displayed on the calendar by using an Advanced Search.

Configuring display options for the calendar
Selecting Marketing Operations > Calendar opens a time-centric view of your
business processes. When you view the calendar, its appearance depends on
several options that you (or your administrator) previously set:
v Set the default calendar view: Use the Calendar/Timeline Settings page in the

Administrative Settings to set the default appearance for the calendar.
v Set the initial calendar view: After setting the Calendar options, you can change

the initial view by clicking the View icon ( ) on the Calendar page.

v Toggle between calendar views: You can use the View icon ( ) on the
Calendar page to choose timeline or calendar and the time range to display.

Note: The View icon ( ) is also available from the Projects, Programs, Plans,
and Tasks list pages.

Setting the appearance of the calendar

You can set the appearance of the calendar in either of these ways.
v You set your initial and default view of the calendar.
v You can change most of the options while viewing the calendar.

Use the Calendar/Timeline Settings page to set these parameters.
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Table 36. Fields on the Calendar/Timeline Settings page

Field Description

Include Weekend
Days

You choose whether the calendar shows a five-day week or a
seven-day week by specifying this option.

Select Yes to display a seven-day week.

Weeks Should
Begin On

You can specify whether the calendar displays Monday as the first day
or Sunday as the first day, even if weekends are shown on the
calendar.

Select either Sunday or Monday. Sunday is the default.

Default Content
of Calendar
Section

You can choose which objects to display on the calendar. Select:

v Plans (the default)

v Projects

v Programs

v Tasks

Default Search of
Calendar Section

Allows you to choose the filter for the objects displayed on the
calendar.

Select a saved search to be the default when you click the Calendar
menu item. The list of available items depends on which objects you
selected for the Default Content field. For example, if you selected
Projects for the default content, you could choose Active Projects for
the default search.

The following parameters are available on both the Calendar/Timeline Settings
page and the Set View Options dialog box.

Table 37. Fields on the Calendar/Timeline Settings page and Set View Options dialog box

Field Description

Default Layout of
Calendar Section
/

Display as and
Time Scale

Allows you to choose timeline or calendar view and the time range to
display.

On the Calendar/Timeline Settings page, you choose the calendar view
using the Default Layout of Calendar Section field. On the Set View
Options dialog box, you use the Display as and Time Scale fields to
perform the same action.

Enable Color
Coding

Allows you to color code the calendar based on an attribute you select.

First, check the Enable Color Coding check box. Then, select the
attribute to use for color coding the objects on the calendar.

When displaying
tasks, only show
milestones

Allows you to limit the amount of information when displaying tasks
on the calendar. Check this box, then choose the milestone types to
hide most tasks when displaying project tasks. Only the selected
milestone types display.

The following option is available only on the Set View Options dialog box.

Table 38. Fields on the Set View Options dialog box

Field Description

Brief/Detailed Allows you to determine the amount of information displayed for
tasks. This option is available for tasks only.
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To set your default calendar options

You set all available options for the calendar using the Calendar/Timeline Settings
page. The settings you choose remain in effect between your sessions. That is, if
you log out of IBM Unica Marketing and then log back in later, your calendar
appears with the options you last set on this screen
1. Select Settings > Marketing Operations Settings.
2. Click Calendar/Timeline Settings.

The Calendar/Timeline Settings page appears.
3. Supply the details on the Calendar/Timeline Settings page.
4. Do one of the following:

v Click Save Changes to save your changes.
v Click Revert to Saved to discard your changes, and reload the settings from

your previous save.
v Click Cancel to exit the page.

To change your view of the calendar

You can access the different views of the calendar by clicking the View icon (

) on the Calendar page.
1. Select Operations > Calendar.

The calendar appears in the default view. This view depends on settings in the
Calendar/Timeline Settings page.

2. Click the View icon ( ). The Set View Options dialog box appears.
3. Supply the details on the Set View Options dialog box.
4. Do one of the following:

v Click Apply to view your changes.
v Click Reset to discard changes.
v Click Close to exit the screen and keep your changes.

Your changes are applied. However, unlike the Calendar/Timeline Settings page,
the changes you make here do not persist. After you leave the Calendar page, your
settings return to the default values.

Viewing the timeline
If you choose a timeline view, you can choose from several date ranges. The screen
can display data for a single week all the way up to data for an entire year.

About timeline view of the calendar
The timeline view displays a grid-like view of the objects (Projects, Programs, or
Plans) you selected and filtered (for example, Active Projects) by some unit of time,
depending on which timeline view you selected.

Each object is displayed in a horizontal bar across its date range. The name of the
object displays on the bar.
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Note: If you select Enable Color Coding from the calendar view options screen,
the bar for each object appears in a color based on an attribute you chose.

Choose a date-range for the timeline.
v Week: displays one week, with each day listed as a column. The starting day is

either Sunday or Monday depending on the option selected in the
Calendar/Timeline Settings screen.

v Month: displays a single calendar month. Each day is listed as a column, and
days are grouped into weeks.

v Quarter: displays three calendar months. Each week is listed as a column, and
those weeks are grouped into months.

v Fiscal Year: displays a fiscal year (starting month depends on a configuration
setting, firstMonthInFiscalYear). Each month is listed as a column, and the
months are grouped into quarters.

v Calendar Year: displays a calendar year (starts in January and ends in
December). Each month is listed as a column, and the months are grouped into
quarters.

Note: Any day that is specified as non-work time has its column disabled.
Additionally, the name of the non-work time (for example, Labor Day) displays
when you point to the date. This feature is not available when the time scale is
Quarter, Fiscal Year, or Calendar Year.

Viewing the text or graphical calendar
The calendar views display data for a selected month. The page displays a grid
containing a column for each day of the week: either five columns representing the
weekdays, or seven, if you choose to display weekend days. You set this option on
the Calendar/Timeline Settings page. The page contains either five or six rows,
each representing a week.

The view contains a cell for each day of the selected month. The cell for a day
contains either a list of items active on the day (text) or a portion of a horizontal
bar for each active item (graphical).

About the monthly calendar
The monthly calendar view displays a calendar of the selected month. It lists the
objects (Projects, Programs, or Plans) you selected and filtered on (for example,
Active Projects).

Choose either of these monthly calendar views.
v 1-Month Text: Each day contains a list of objects. An object is displayed for all

days in its date range.
v 1-Month Graphical: Each object is displayed in a horizontal bar that begins on

its start date and ends on it end date. If you select Enable Color Coding from
the calendar view options page, the bar for each object appears in a different
color.

Note: Any day that is specified as non-work time is indicated by a gray X in the
background. Additionally, the name of the non-work time (for example, Labor
Day) displays when you point to the date.
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About calendar color coding
You can display objects in a color-coded manner on either the graphical calendar
or in the timeline views.

You first select the Enable Color Coding check box in either the
Calendar/Timeline Settings page or the Set View Options dialog box. After you
check the box, the Based on values for menu displays. This list contains attributes
for your projects, programs, or plans (depending on which objects you are
currently displaying in the calendar).

From this list, you can choose any attribute that is an enumerated type. For
example, consider the following attribute:
v Name: Product Family
v Valid values: CDs, Credit Card, Home Mortgage

If you choose to group objects by this attribute, your calendar contains four colors:
one for each valid value plus N/A, corresponding to any objects that do not
contain a value for the Product Family attribute.

The calendar also displays a legend in the lower-right corner of the screen. The
legend lists all valid values (plus N/A) along with the color corresponding to that
value.

Note: You can also color code by the template on which the project or program is
based.

About horizontal bars on the calendar
The timeline view and graphical calendar view display horizontal bars.

Note the following.
v The bars represent the date range for objects displayed on the calendar.
v The name of the object displays on the bar.
v The bars can be colored based on an attribute you select.
v The shapes of the bars indicate the following:

– Rounded-end "start": indicates that the object starts on the date where the bar
has a rounded end.

– Rounded-end "end": indicates that the object ends on the date where the bar
has a rounded end.

– Flat-end "start": indicates that the object starts before the visible date range.
– Flat-end "end": indicates that the object ends after the visible date range.

Brief and detailed views of tasks
Use the Set View Options dialog box or the Calendar/Timeline Settings page to
choose brief or detailed mode to view information about tasks on the calendar.

In brief mode (the default), the text contains the following items.

v Task ( ) or approval ( ) symbol
v Task ID
v Name of the task

In detailed mode, the text contains the following items.
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v Task ( ) or approval ( ) symbol
v Name for the project that contains the task
v Code for the project that contains the task
v Task ID
v Name of the task

To publish the calendar

To get a snapshot of the current calendar, save it in HTML format (into a ZIP
compressed archive file).
1. Choose the calendar view to publish.

Select the objects, time range, and appearance for the calendar view. You can
make selections in either of the following ways:
v From the Operations menu, select Calendar, then select items to view.
v At a list page for plans, programs, projects, or tasks, click the View icon (

) and choose a calendar view.

Note: If the current calendar view includes projects, Project data is exported as
well. The exact data exported depends on how the project template was set up;
Summary and custom tabs may be exported for some or all projects.

2. Click the Print icon ( ) and select Export.
3. Do one of the following.

v Click Open to open the compressed file of the calendar.
v Click Save and choose a location, to save the calendar to disk.
v Click Cancel to return to the Calendar page without publishing.

The system publishes the calendar into a compressed file archive. You can use any
application for working with compressed files to access the calendar HTML pages.
You can navigate to the next and previous pages of the calendar view in your web
browser. If you exported any project data, you can also navigate to that data from
the calendar HTML pages.
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Chapter 10. Grids

A grid is a spreadsheet-like presentation of data. Grids allow IBM Unica Marketing
Operations users to store all campaign- and project-related data within the project.

With grids, users no longer need to search through email, a file folder, or another
computer to find information about a campaign or project. IBM Unica Marketing
Operations serves as the system of record and offers enterprise-wide access to data
stored in grids. Any Marketing Operations user who has access to the project can
view and edit the grid, if that user has appropriate security permissions.

Users can move the traditional spreadsheet information into a grid within IBM
Unica Marketing Operations. Then, marketing managers can analyze, measure, and
report on the project- and campaign-related information within and across multiple
projects or campaigns.

Depending on how your templates are defined, grids can appear on marketing
object, plan, program, and project tabs. Campaign projects include a TCS tab that
displays a special grid called the Target Cell Spreadsheet (TCS). You can create
campaign projects only if IBM Unica Marketing Operations-Campaign integration
is enabled.

A template creator configures grids, specifying the data source, whether data is
grouped, whether a user can sort the data, and other grid characteristics. Then,
administrators and users can use them when they create marketing object tabs and
project tabs.

A grid can also be read-only, displaying data that you cannot edit.

About editing grid data
When you work with grids in edit mode, you can add rows, delete rows, and edit
existing data. In a single editing session, you can perform all of these tasks if you
have the appropriate permissions.

Permissions

You must have the following permissions to work with grids. Ask your
administrator if you need help.
v To add a row, you must have the View Tab, Edit Tab, Edit Grid, and Add Grid

Row permissions for the tab with the grid.
v To edit a row, you must have the View Tab, Edit Tab, and Edit Grid

permissions for the tab with the grid.
v To copy and paste a row, you must have the View Tab, Edit Tab, and Edit Grid

permissions for the tab with the grid.
v To delete a row, you must have the View Tab, Edit Tab, Edit Grid Row, and

Delete Grid row permissions for the tab with the grid.

Locked data

The system prevents you from editing a row that is currently being edited by
another user. For a Target Cell Spreadsheet in a campaign project, the entire grid is
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locked for editing instead of individual grid rows.

Revision history

Marketing Operations maintains an audit log for grids. The audit log contains the
user details and the time it was saved. This information is available on the
Analysis tab.

Grid controls

The following tables describe the controls you use when working with grids in the
View and Edit modes.

The following features are available in both modes.
v Data displays in pages. To navigate, click the arrows to go to the next, previous,

first, and last pages, or enter a number in the box and press Enter.
v You can sort by column by pointing to the column heading, clicking the down

arrow, and selecting Sort Ascending or Sort Descending in the drop-down
menu. Depending on how the grid was designed, some columns do not have
sorting enabled.

v You can view or hide columns by pointing to any column heading, clicking the
down arrow, pointing to Columns in the menu, and selecting or clearing the
check box next to the column name.

v You can reorder columns by dragging and dropping the column heading. (This
ability is not available in grids that have column grouping.)

v You can change column width by dragging the edge of the column headings.

View mode

Table 39. View mode controls

Control Description

Switch to Edit mode.

Copy selected grid rows. Click in the first column to select a row.

Import a CSV file that contains grid rows.

Export all the data in the grid in a comma-separated list.

Use advanced search to filter grid data.

Select the calculation used for each column in the Summary row. The
options are: Sum, Avg (average), Min (lowest value in the column), and
Max (highest value in the column). In a multi-page grid, calculations
are performed across all the data, not just for individual pages. This
control is available only in view mode.

Save Preferences Save your customized view of the grid.

In addition, the following controls are available for the Target Cell Spreadsheet
(TCS) available in campaign projects. You can create campaign projects only if IBM
Unica Marketing Operations-Campaign integration is enabled.
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Table 40. View mode controls (Target Cell Spreadsheet grids only)

Control Description

Approve All Approve all the rows in the TCS.

Deny All Deny approval to all the rows in the TCS.

Clear All Delete all the rows in the TCS.

Publish Send the current TCS data to Campaign so the flowchart designer can
access it.

Get cell status Retrieve the latest flowchart and cell count information from
Campaign.

Edit mode

In edit mode, you can click single line text, multi-line text, or numeric and money
type column contents, and then begin typing to overwrite existing data. For any
editable column, you can double-click a cell to open the content editor for that
column type.

If the row is currently in use by another user, the system displays an error
message. Before you save your changes, edited cells contain a small red triangle in
the corner; these markers disappear after you save.

Table 41. Edit mode controls

Control Description

Add a row. The row is added below the currently selected row. The
first row is selected by default when you enter edit mode.

Copy selected grid rows. To select a row, click in the first column.

Paste grid cells and rows.

Mark a selected row for deletion. The row is deleted when you save.
Within a row, the same icon indicates the row status.

Unmark a selected row for deletion. Within a row, the same icon
indicates the row status.

Save your changes and remain in edit mode.

Save your changes and return to view mode.

Revert all changes made since your last save and return to view mode.

To import grid data

To quickly add data to a grid, use the import feature. You can import data to a
grid in comma-separated value (.csv) format.
1. Navigate to the grid for the import.

2. Click the Import icon ( ).
3. Browse to the CSV file that contains the data to import.
4. If the first row of the file contains header information, select the First row is

header row box.
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The confirmation screen appears.
5. Click Save to import the file or Cancel to quit the import process.

If the CSV data does not match the number and data type of the grid columns,
you receive an error message. The message describes the differences between
the grid and the CSV file.

6. Click Finish to close the dialog and return to the grid tab.

To export grid data

You can export grid data in comma-separated value (.csv) format. Note the
following.
v All pages (if the data is paginated) are exported.
v All rows except the Summary row are exported.
v All columns (including hidden columns) are exported.
v Exported rows are in the same order as in the current view. If you are viewing

the grid alphabetized by ID, the exported data is also alphabetized by ID.
1. Navigate to the grid to export.

2. Click the Export icon ( ).
3. In the File Download dialog box, choose one of the following.

v Click Open to display the file in Microsoft Excel.
v Click Save to save the file to disk.
v Click Cancel to close the dialog box without exporting the data.

To post read-only grid data to a URL

If the template creator enables a read-only grid for data posting, the screen
contains a Post Data link.
1. Navigate to the read-only grid whose data you want to post.
2. If the grid contains more than one page, click Show All to view the entire grid

on the screen.
3. Check the box for each row you want to post.

Note: As a shortcut, you can check the box in the grid header to select all
currently displayed rows.

4. Click Post Data.
Marketing Operations calls the specified URL with the selected data.

To group read-only grid data

If the template creator enables data grouping for a read-only grid, you can group
data in the grid by any of its columns.
1. Navigate to the read-only grid you want to view.
2. Click View.

Set View Options appears.
3. Check Enable Grouping. To turn off grouping, clear this field.
4. In the Group By Column field, select the column for grouping.
5. Click Apply to save your changes and close the dialog box.
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Chapter 11. Marketing objects

You can create new marketing objects if you have permission to do so. After you
create a marketing object, you can start it at any time. Starting the marketing object
makes it active.

A marketing object is any work product a team develops and reuses in the course of
its marketing activities. A marketing object can represent a physical item (such as a
letter, credit card, or banner ad), or a business component (such as a credit card
offer, a target segment definition, or a rewards program definition).
v You define and manage marketing objects that represent all reusable work

products.
v You can perform basic operations (create, edit, change state, copy, link, and

delete) on marketing objects.
v You enter and manage all of the attributes that define a particular marketing

object, such as name, owner, state/status, description.
v You can define and manage business processes (such as projects) that produce,

modify, and retire marketing objects.
v You can construct robust projects which define multiple marketing activities by

“assembling” each discrete marketing activity from existing marketing objects.

IBM Unica Marketing Operations marketing objects are defined in stages, and how
they are defined influences how they are organized and presented to users. The
following terms are important in understanding the definition and organization of
marketing objects.

Marketing object type

A marketing object type is the highest-level division for marketing objects. An
administrator creates marketing object types. Each marketing object type has a
menu item, but the menu on which it appears depends on how the administrator
configured the marketing object type.

Marketing object template

A marketing object type is broken down into one or more marketing object templates.
Typically, an administrator creates a marketing object template for each significant
characteristic for the marketing object type.

Marketing object instance

A marketing object instance is a single marketing object. Users with appropriate
security permissions create marketing object instances from marketing object
templates. Marketing object instances are called “marketing objects” in this guide.

About the offer object type
If your system includes the IBM Unica Marketing Operations application only,
your system administrators can set up a custom marketing object type to represent
offers or promotions.
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If your Marketing Operations environment is integrated with IBM Unica
Campaign, it includes a system-provided marketing object named "offer." However,
there are two options for offer management:
v If your system is configured with optional offer integration enabled, offers are

managed through Marketing Operations: you use the Offers option from the
Operations menu. For information about creating offers in this way, see the IBM
Unica Marketing Operations and Campaign Integration Guide.

v If your system is configured so that offer integration is not enabled, offers are
managed through Campaign: you use the Offers option from the Campaign
menu. For information about creating offers in this way, see the "Offers" chapter
in the IBM Unica Campaign User Guide.

Ask your system administrator about how your system is configured for offer
management.

To create a marketing object

You must have the appropriate permission to add a marketing object. When you
add a marketing object, you become an owner of that marketing object.

Marketing object types are specific to each organization. The marketing object
types that are available to you and how they are organized on the menus depend
upon your template creator.
1. From the menus, select the marketing object type that you want to create.

The list page for that marketing object type appears.
2. Click the Creation icon.

The Select a Template dialog box appears, containing all the templates
available for this marketing object type.

3. Select a template and click Continue.
The first step of the wizard for the selected marketing object template appears.

Note: Each marketing object can contain any number of custom pages and
fields. All marketing object templates contain at least one page, with a name,
membership list, and security policy field, as a minimum.

4. Follow the wizard, entering information on each page.
5. When you finish configuring your object, do one of the following.

v Click Finish to save the object. The system displays the list page for the
marketing object type, with the new marketing object included in the list.

v To create another object that is similar to the one you just created, click Save
and Duplicate. The current object is saved, and you then see the Summary
page of a new object, with data already populated. Change the default name
and edit the new object as needed.

About the marketing object cross-reference report
All projects and marketing objects contain a report describing cross-references to
and from other marketing objects. This report appears on the Analysis tab, and is
titled Marketing Object Cross-Reference.

For projects, the report contains the following sections.
v Marketing objects referenced by this project
v Marketing objects modified by this project
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For marketing objects, the report contains the following sections.
v Marketing Objects that Reference This Item: other marketing objects containing

a link to this marketing object.
v Marketing Objects that This Item References: other marketing objects to which

this marketing object links.
v Projects that Modify This item: projects that can change this marketing object.
v Projects that Refer to This Item: projects containing a link to this marketing

object
v Approvals that Refer to This Item: approvals containing a link to this

marketing object.

About the modifies and references relationships
Whether a project references or modifies a marketing object is determined by how
the template creator configured the marketing object reference field.
v Modifies: The project or marketing object that contains this marketing object is

intended to change or update the contents of a marketing object (a Change
Order or Work Request project, for example).

v References: The project or marketing object that contains this marketing object
does not modify it, but references it only.

Selecting marketing objects
When you select check boxes on the Marketing Objects list page, IBM Unica
Marketing Operations retains your selections during a session as follows.
v In View mode, your check box selections are retained until you navigate to a list

page for a different object. For example, if you make a selection on page 1 of a
multi-page project list, go to page 2, and then return to page 1, either by clicking
the page number at the bottom of the page or using the Recent menu, your
selections are retained. However, they are discarded if you navigate to the Tasks
page.

v If you edit a marketing object by clicking the Edit a Tab icon on the list page,
your selections are retained if you click Save and Return to List.

To delete marketing objects

You cannot delete a marketing object if a project or another marketing object is
linked to it. You must first remove the link before deleting the marketing object.
1. From the menu, select the marketing object type of the marketing object that

you want to delete.
2. Select the check box next to each marketing object that you want to delete.

3. Click the Delete this Item icon ( ) in the left toolbar.
4. When Marketing Operations prompts you to verify that you want to delete the

marketing objects, click OK.

You can also delete a marketing object from its Summary tab. To do so, click the

Delete this Item icon ( ) in the Marketing Operations toolbar.
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To change the status of marketing objects

Each marketing object type is assigned a status. The status of a marketing object
changes during its lifecycle. You can change the status of a marketing object to
control its lifecycle.
1. From the menu, select the marketing object type of the marketing object whose

status you want to change.
2. On the Marketing Objects List page, select the check box next to each item

whose status you want to change.
3. Click the Status icon and select one of the available statuses. A dialog box

appears in which you can add comments. If you select a status that cannot be
changed later, the system warns you that your change cannot be undone.

4. Enter any comments, and click Continue to close the dialog box and apply the
new status.

To add a marketing object reference to a form or a grid row

Forms and grids can contain columns that hold references to marketing objects.
IBM Unica Marketing Operations makes it easy to find the specific marketing
object to reference in such a column.
1. Navigate to a form or a grid that contains a field or column to hold a

marketing object reference.
2. If the marketing object reference field is on a form, switch to the Edit tab.

In the Marketing Object reference field, click Select.
3. For a grid, perform one of the following actions:

v To add a row: switch to Edit mode and click the Add Row icon. Then
double-click the Marketing Object column cell.

v To edit an existing row: switch to Edit mode, then double-click the
Marketing Object column cell.

A dialog box appears for the Marketing Object search.
4. Choose one of the tabs.

v To perform a simple search for a marketing object: In the Search tab, enter
search criteria. The system searches all of the marketing object attributes to
match your criteria. All attributes are searched except for attributes of linked
marketing objects.

v To use a predefined search for a marketing object: In the Browse tab, select a
predefined saved search.

The system returns the results of your search.
5. Select a marketing object and click one of the available buttons.

v To accept the selected object and close the dialog box, click Accept and
Close.

v To accept the selected object and continue selecting objects, click Accept.
v To close the dialog without choosing the selected object, click Close.

The marketing object you selected appears in the marketing object reference field.
If you selected more than one object, and the field accepts multiple marketing
objects, then all the objects you selected are listed.

Note the following.
v For simple searches, attributes of linked marketing objects are not searched.
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v Fields that hold marketing object references can be set up so they are limited to
holding one particular type of marketing object, such as Offer Letters. In this
case, the Browse tab contains only those saved searches that apply to that
particular marketing object type.

About marketing object references in approvals
You add marketing object references to approvals in the same way you add them
to forms and grid fields. However, the options for searching for marketing objects
are slightly different.

Simple search (Search tab)

The simple search screen in the marketing object selection box for approvals
contains an additional drop-down list. You use this control to select a single type
of marketing object for your search. A selection is required before you can begin
the search.

Saved search (Browse tab)

The drop-down list of saved searches contains previously saved searches for all
enabled marketing object types. For example, if you have marketing object types
for Creatives and Envelopes, all saved searches for Creatives and Envelopes appear
in the list.
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Chapter 12. Assets and asset libraries

IBM Unica Marketing Operations provides centralized management, secure
storage, and web-based access for digital assets.

About Assets

In IBM Unica Marketing Operations, you store your assets in libraries.
v An asset library is the highest level organizational structure in the digital asset

repository.
v You can access libraries and add assets to the libraries if your Marketing

Operations administrator granted you permission in the security policy assigned
to the asset).

v You can organize assets using folders.
v You can view all the assets that you own.
v If you do not own an asset, you can view it when it has a status of finalized.
v You must have administrative access to Marketing Operations to create a library.

You can view assets in a library in either a list view or thumbnail view. By default,
IBM Unica Marketing Operations displays assets in a list view when you select an
asset library.

Table 42. Views for assets

View Description

Asset List Displays all the assets in the current library,
listed alphabetically in ascending order.
Change the order by clicking once on the
Name column.

To sort by any of the other columns, click
that column. Click the column a second time
to change the order of the column from
ascending to descending.

Asset Thumbnails Displays a thumbnail image for each asset in
the library. You can upload a thumbnail
image for an asset when you add the asset
to a library.

About asset libraries
Digital assets are stored in libraries, which are the top-level organizational
structure in the digital asset repository. You can access libraries and add assets to
the libraries. You can only access a library if your IBM Unica Marketing Operations
administrator granted you permission in the security policy assigned to the asset.

After you click the library that contains assets or folders you want to view, the
Asset List page appears.

Note: You must have administrative access to IBM Unica Marketing Operations to
create a library.
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To change from the asset list view to the thumbnail view

By default, IBM Unica Marketing Operations displays assets in a list view when
you select an asset library. To change to a thumbnail view, perform the following
steps.
1. Open IBM Unica Marketing and select Operations > Assets.

A list of all available asset libraries displays.
2. Select an asset library from the list.

A list of assets in the current library displays.

3. Click the List View Mode icon ( ) and select Asset Thumbnails.

The thumbnails view appears. For all assets that have an associated thumbnail
image, the thumbnail is displayed next to the asset.

To add an asset
1. Log in to IBM Unica Marketing.
2. Select Operations > Assets.

A list of libraries appears. An administrator created these libraries to organize
the assets.

3. Click the library that you want to contain the new asset. The library opens. If it
contains folders, they appear at the top of the screen.

4. If the library contains folders, navigate to the folder that you want to contain
the asset.

5. Click the Add Asset icon ( ).
The New Asset screen appears.

6. Complete the New Asset screen.
7. Click Save Changes to create the asset.

The asset appears with a status of Draft.

New asset page

When you add a asset, the system displays the New Asset page.

Table 43. Fields on the New Asset page

Field Description

Asset Name Enter a descriptive name for the asset.

Description Enter a short, text description for the asset.

Owner(s) Click Add/Remove Members to use the Select Owners dialog
to designate additional asset owners.
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Table 43. Fields on the New Asset page (continued)

Field Description

Asset Code To manually enter a code for an asset, clear the Auto-generate
on save box. Then, type a code for the asset. The code can be
any alphanumeric string.

To have Marketing Operations automatically create an asset
code, leave the Auto-generate on save box checked.
Note: You can configure Marketing Operations to generate a
code according to an algorithm your administrator specifies.

Keywords Enter any keywords for the asset, separated by commas. When
users search on these keywords IBM Unica Marketing
Operations retrieves this asset.

Usage guidelines Enter any guidelines for how you want people to use this
asset. For example, if it is a logo, you can let users know where
this type of logo should appear.

Expiration date Enter an expiration for the asset or select the arrow in the
drop-down list to choose a date from the calendar.

After you enter a date, you can use the arrow icon to
incrementally move the date forward or back.
Note: Marketing Operations sends a notification to the owners
upon expiration, but the status of the asset does not
automatically change to expired. At the expiration date, you
should archive the asset or change the expiration date.

Version name Enter the version number of the asset. Note the following.

v This field defaults to version 1.0.

v Each version you add after this one, by default, increments
the version number.

v To override the default value, enter your own version
number.

Files Click Upload to open the Add Asset Files dialog. Check one or
more of the check boxes.

v File: specify the file for your asset. This field is required.

v Preview File: You may want users to access the preview file
for reasons of security, speed, or convenience. For example,
if the source file is a Photoshop file, you may want to
provide a PDF file as your preview file so that users who do
not have Photoshop can still see it. IBM Unica recommends
you use a PDF, GIF or JPEG file as a preview of the asset.
This field is optional.

v Thumbnail File: You can upload a smaller version of the file
that users see when they open the asset or when they view
their library using the Asset Thumbnails view. This field is
optional.

For each box you check, browse to the appropriate file and add
it to the Add Asset Files dialog box.

Security considerations

For more information about setting up security to allow some users to view only
the preview of an asset, see the IBM Unica Marketing Operations Administrator’s
Guide. If you have security concerns, consider watermarking the preview file, using
a low-resolution version, or using some other method that protects the file and
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does not allow copying and saving of the file.

To edit an asset

If you upload a new file while editing, it replaces the previous file but does not
create a new version of the asset. It is the same version as before you edited it,
even if you change the Version Name field to a higher number. This procedure
allows you to correct the file if you accidentally added the wrong one previously.

You can only edit assets in draft state.
1. Select Operations > Assets.
2. Select the library that contains the asset you want to edit.
3. Click the asset you want to edit.

4. Click the Edit icon ( ) and change any of the fields on the page.
5. Click Save Changes when you finish editing.

The asset is saved, with the same version number it had before the editing session.

About asset versions
Rather than replace an existing asset, you can add a new version of the asset. Note
the following.
v You can download, preview, or delete older versions of an asset in the Version

History section.
v If you delete the current version of an asset, the previous version becomes the

current version.
v The current version of an asset displays when users navigate the library and try

to attach assets.
v You cannot delete an asset version if it is the only version of the asset.

To add a new version of an asset

Rather than replace an existing asset, you can upload a new version of the asset.
1. Select Operations > Assets.
2. Select the library that contains the asset you want to edit.
3. Click the asset for which you want to add a version.

4. Click the New Version icon ( ) and change any of the fields on the page.
The Version Name field automatically increments to the next version number.

5. Click Upload under File to upload the new version of the asset.
6. Upload files for the asset. You must at least upload a source file.
7. Click Save Changes to create the asset.

The asset is saved and the version number is incremented.
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Asset statuses

You must own an asset to change its status, or have the appropriate permissions.
An asset can have any of the following statuses.

Table 44. Asset statuses

Status Description

Draft Indicates that the asset is in a draft state. All owners can edit
the asset, but other users cannot view it nor select it as an
attachment.

When you first add an asset, it has a status of Draft.

Locked Indicates that the asset is in a locked state. No one can edit the
asset until it is unlocked.

You can lock an asset for a period if you do not want anyone to
edit the asset.

Finalized Indicates that the asset is finalized. Everyone with permission to
do so can access the asset (and attach it to a business process),
but no one can edit it.

Archived Indicates that the asset is no longer available. No one can access
the asset nor retrieve it.

If this asset is attached to an object (such as a project or plan), it
is still available from that object.

To change the status of an asset
1. Select Operations > Assets.
2. Select the library that contains the asset you want to edit.
3. Click the asset whose status you want to change.

4. Click the Status icon ( ) and select one of the available statuses.

To view an asset

After an asset has a status of Finalized, all authorized users can view and use the
asset.
1. Select Operations > Assets.
2. Select the library that contains the asset you want to view.
3. Click the asset you want to view.
4. Perform one of the following actions.

v To view the asset, click Download next to the asset file.
v To preview the asset, click Preview. Use this option if you do not have

permission to download assets, or you are not sure if this is the asset you
need.

v To save the asset file or the preview file and download it to your computer,
right-click the Download or Preview link and select Save Target As to save
the corresponding file. Browse to the location where you want to save the
file and click Save.
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5. Close the window that contains either the downloaded file or the preview
when you finish viewing the asset.

To view history of an asset

When an asset has a status of Finalized, all users who have permission to do so
can view the revision history and download history for the asset. Owners can view
the revision history when the asset has any status.
1. Select Operations > Assets.
2. Select the library that contains the asset you want to view.
3. Click the asset you want to view.
4. Click the Analysis tab.

The revision history for the asset appears.
The revision history displays status changes for the asset, version changes,
updates to fields in the asset, and any comments entered during the changes.

5. Select Download History in the View field to view the download history for
the asset.

The download history displays the date, time, file name, user who downloaded it,
and the version of each asset that the user downloaded by clicking the Download
link.

To add an asset folder

Use folders as a way to organize assets in a library. You must have permission to
create folders before you can add them.
1. Select Operations > Assets.
2. Select the library to which you want to add a folder.

3. Click the Add Folder icon ( ).
The New Folder page appears.

4. Enter a name and a description for the new folder.
5. Click Save Changes.

The folder opens. You can now add or move assets into this folder.

Deleting assets
Asset folders have the following characteristics.
v From within any library, you can delete assets and folders, if you have the

appropriate permissions.
v You can delete only empty folders.
v If you have permission to delete assets as an owner of the asset, but some other

security role that you are in allows you to delete assets only if you inherit that
delete permission from another role, you cannot delete an asset from the list of
assets: you only can delete the asset from within the asset itself.

v Asset folders do not have owners. Different owners can own different assets in a
folder, therefore the permission to delete an asset folder is not based on
ownership.
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To delete assets and folders from the asset list page

From the asset list page, you can delete multiple assets and empty asset folders.
1. Select Operations > Assets.
2. Select the library that contains the assets and folders you want to delete.
3. Select the check boxes next to all the folders and assets you want to delete.

You cannot delete asset folders unless they are empty.

4. Click the Delete Selected Items icon ( ).
5. Click OK when IBM Unica Marketing Operations prompts you to confirm the

deletion.

The selected assets or folders are removed.

To delete an asset from within the asset
1. Select Operations > Assets.
2. Select the library that contains the asset you want to delete.
3. Click the asset you want to delete.

4. Click the Delete Selected Items icon ( ).
5. Click OK when IBM Unica Marketing Operations prompts you to confirm the

deletion.

To move assets and folders from the asset list page

From within any library, you can move assets and folders, if you have the
appropriate permissions.
1. Select Operations > Assets.
2. Select the library that contains the assets and folders you want to move.
3. Select the check boxes next to all the folders and assets you want to move to a

particular destination.
To move assets to a different location, repeat this procedure for each different
destination.

4. Click the Move this Item icon ( ).
5. Select the destination directory and click Save Changes or double-click the

destination directory.

The destination directory opens with the folder or asset displayed in it.

To move an asset from within the asset

If you have permission to move assets as an owner of the asset, but some other
security role that you are in allows you to move assets only if you inherit that
move permission from another role, you cannot move an asset from the list of
assets: you can only move the asset from within the asset itself.
1. Select Operations > Assets.
2. Select the library that contains the asset to move.
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3. Click the asset to move.

4. Click the Move this Item icon ( ).
5. Select the destination directory and click Save Changes or double-click the

destination directory.

The destination directory opens with the folder or asset displayed in it.
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Chapter 13. Budgets

In IBM Unica Marketing Operations, a budget allows you to plan expenses that will
occur as you execute your plan, program, or project. After setting the plan budget,
you can fund linked programs, and ultimately projects, from it. Marketing
Operations tracks budgets of child programs and projects in the form of
allocations, forecasted or committed spending, and actual expenses.

IBM Unica Marketing Operations tracks budgets of child programs and projects,
although these objects can have different owners. For example, a program linked to
a plan can have a different owner than the plan itself. As such, the person who
allocates a budget from a plan down to a program can be different from the person
forecasting expenses from a program up to a plan. Marketing Operations allows a
plan owner, a marketing manager for example, to track expected expenses from
child programs and projects as well as the plan budget itself, and remain
responsive to budgetary needs.

Note: Budgets are available only when the Marketing Operations financial module
is enabled.

Fiscal year

You can view the total budget for all years, or see a detailed view for a particular
year broken down into weeks, months, or quarters.

IBM Unica Marketing Operations keeps budget information for the current fiscal
year, the next two fiscal years, and any past fiscal years dating back to when you
first installed Marketing Operations.

On the plan level, to view or edit a different fiscal year, change the Fiscal Year
field value on the Plan Summary tab. Linked programs and projects take the
financial year from the parent plan; stand-alone programs and projects use the
system's current fiscal year.

Granularity

With IBM Unica Marketing Operations, you can break fiscal years into weeks,
months, or quarters. When creating a plan, program, or project, choose the wanted
increment from the Budget Granularity list on the Summary tab.

Users are not allowed to edit budget granularity. Plans, programs, and projects
with different budget granularities are not allowed to be linked together.

For example, if a plan’s fiscal year is broken into months, you can only link it to
programs and projects that also use months as the budget granularity. In this
scenario, programs and projects with weeks or quarters as their granularity are
unavailable for linking.

For more information about linking plans, programs, and projects, see “To link a
program to a plan” on page 27, “To link an existing project to a program” on page
33, and “To link a child project or request to a project” on page 50.
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Budget funding
Although you can plan your budget using either top-down or bottom-up methods,
the flow of actual money travels down the linked plan, program, project hierarchy.
Regardless of how you plan your expenses, plans fund programs, which fund
projects, which in turn fund any child or subprojects.

PLAN

Program A Program B

Project 1

Project 2 Project 3

Project 4

Sub-Project a Sub-Project b Sub-Project c

Sub-Project d

For more information about budget planning, see “Top-down budget planning”
and “Bottom-up budget planning” on page 143.

Note: Since stand-alone programs and projects are not linked to plans, they have
their own budgets which you enter directly on their respective budget tabs.

Top-down budget planning

"Top-down" planning is useful if a plan has predictable expenses from year to year.

For example, if every year you create a plan called New Product Launch which
includes trade shows, you can create programs such as Trade show 1, Trade show 2,
and so on, and assign funds to each program.

The Trade show 1 program may include a project called New Customer Acquisitions,
and as such, you can allocate funds from Trade show 1 to make New Customer
Acquisitions successful. Since the flow of funds is from the plan down to associated
programs and projects, top-down planning is highly useful and easy.

In summary, you manage budgeting from plans down to programs and projects in
the following way.
1. Allocate funds to the plan budget.
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2. Allocate funds from the plan budget its child programs.
3. Allocate funds from the programs to it child projects, which are grandchildren

of the plan.
4. Allocate funds from the projects to it child subprojects, which are

great-grandchildren of the plan.

Bottom-up budget planning
In contrast to top-down budget funding, "bottom-up" budget funding is useful if
you are not sure how much funding to allocate down from the plan to child
objects, but can forecast line items for the programs and projects. After predicting
all project expenses, you can roll them up to parent programs, and ultimately, to
plans.

Using the previous example, if you can predict the line item expenses of the New
Customer Acquisition project in your Trade show 1 program, you can finalize those
line items to roll them up into Trade show 1's expenses. Then, add additional line
item expenses to Tradeshow 1 if necessary and finalize them to roll expenses for
Trade show 1 up to the parent plan, New Product Launch. Starting from the
bottom-most level, continue to add expenses to projects, programs, and plans until
the parent plan accounts for all necessary allocations.

In summary, you manage budgeting from projects up to programs and plans in the
following way.
1. Create projects and forecast their line item expenses.
2. Link the projects a parent program and plan.
3. Finalize the line items on each child object in the plan to roll up the expenses.

You can now see how much funding the programs and projects need for
successful completion.

Effects of deleting links between plans, programs, and projects
In general, removing the link between a parent object and a child object affects the
budgets of both objects in the following ways.
v The parent object no longer allocates money to the child object.
v The expenses for the child no longer count against the parent.
v Funds allocated from the parent remain with the child, but have no source. In

other words, the child object still accounts for having the money, but the parent
object no longer accounts for giving it.

For example, removing the link between a program and a plan affects the budgets
of both objects in the following ways.
v The plan no longer allocates money to the program, so the budget for the

corresponding program area is decreased accordingly.
v The expenses for the program no longer count against the plan.
v The program still accounts for funds formerly allocated from the plan, so these

funds either need to be removed from the program or funded from another
source.
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Budgets and accounts
In IBM Unica Marketing Operations, budgets and accounts do not have
predetermined relationships. Accounts represent the financial element of an
organization, while budgets represent the marketing side. Typically the financial
element is not granular enough to capture marketing needs in detail. Budgets
make up for this lack. A plan, program, or project can be funded from one or more
accounts.

For more information about accounts in IBM Unica Marketing Operations, see
Chapter 15, “About accounts,” on page 163.

Budget views
IBM Unica Marketing Operations offers two budget views on all budget tabs.

v Total view ( ) is the default. It displays the total amount budgeted and
remaining for forecasted, committed, and actual spending, for all fiscal years
that the plan, program, or project existed.

v Detailed view ( ) displays budget information for a specified fiscal year
broken down by week, month, or quarter.

Across all of the budget tabs for a plan, its child programs, and their child projects,
the totals reflect the total amounts for the life of the plan, program, or project.
Therefore, the individual rows and columns in edit screens or the detailed view
often do not add up to match the values displayed in the total view. This
difference is not an error, but reflects the fact that the data, other than the total,
corresponds to values for the currently selected fiscal year.

Note: The views on the budget tab depend on the in-use budget allocation
version. By default, you navigate to the budget tab of an object for the first time
after login, the in-use version of the current fiscal year displays. The total view
shows totals for the in-use version for all previous fiscal years and the current
in-use budget allocation version. Detailed view also shows information based on
the in-use budget version. For more information, see “Budget allocation versions”
on page 147.

The Plan Budget tab
From top to bottom, the Plan Budget tab contains the following tables.
v The Plan Budget Summary table provides an overview of the entire budget.
v The Program Cost Summary table shows allocations to child programs.

Plan Budget Summary table
The Plan Budget Summary table is the topmost table on the budget tab of a plan
and summarizes funds that you expect to spend in the plan and the programs it
contains. The Plan Budget Summary table monitors finances for the entire plan.
v Plan Budget is the total budgeted amount.

In total view, the Plan Budget Summary table displays the total budget for the
plan’s entire life; detailed view separates it into increments of the
currently-selected fiscal year. Change the fiscal year on the Summary tab if
necessary.
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v Program Allocations shows the total budget of all the plan's programs.
v The Forecast Total is all predicted spending across the plan.
v The Committed Total is all the money spoken for in the plan up to this point.

Even though the money is not yet spent, the committed total represents costs
that will occur even if the plan is terminated.

v The Actual Total is all funds spent so far on the plan. IBM Unica Marketing
Operations calculates the actual amount spent through the invoice functions.
This total is likely to be much lower than the others due to time lags between
planning expenses and actually paying bills.

The Remaining column

In each row, the Remaining column is the difference between the Plan Budget and
the entry in the Amount column. For example, IBM Unica Marketing Operations
calculates the forecast remainder by subtracting the forecast total from the Plan
Budget.

Although calculated by a simple subtraction, the Remaining column provides
high-level information and potential warnings about the financial state of the
plan's budget. The remaining column summarizes how much money has already
been allocated or planned for use, how much remains for additional spending, and
how much you could recover if you canceled unfinished efforts.
v In the Program Allocations row, the Remaining column represents additional

money the plan owner has left to distribute to existing or not-yet-created
programs. If the total allocation of funds to child programs exceeds the total
budget of the plan, the remainder is negative and the plan will need more
funding to successfully complete the programs.

v In the Forecast Total row, the Remaining column indicates the amount of money
the plan owner will have left if current forecasts are accurate. If the figure is
negative, the plan will need more funding to succeed at expected costs.

v In the Committed Total row, the Remaining column indicates how much money
the plan owner will have left if the plan and all its programs and projects are
canceled. The plan owner needs to understand how much money can be
returned if associated programs do not continue to execute, in the event that
budgets are tightened.

v In the Actual Total row, the Remaining column represents the real balance that
the plan owner has at the current time. This figure can be useful for monitoring
cash flows, though it is likely lower than the forecast total or committed total
remainder due to the time lags between planning expenses and paying bills.

Note: This topic specifically references the Plan Budget summary table. Programs
and projects also have a Budget Summary table with the same layout and
information about their respective Budget tabs.

Program Costs table
The Program Costs table is underneath the Plan Budget Summary table on the
plan's Budget tab. The table rows list programs by area; the columns provide
figures for Actual, Committed, Forecast, and Allocated spending.

On the Plan Budget tab, the program costs table only shows programs without
breaking them down into their respective projects. However, even though you do
not see the project expenses directly, IBM Unica Marketing Operations accounts for
them through their parent programs.
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The program name in each row of the Program Costs table provides a direct link
to that program's budget. This link is helpful because the Program Budget tab
provides a breakdown of its child-project expenses in the corresponding Project
Costs table.

Note: This topic specifically references the Program Costs table on the plan Budget
tab. Program and project Budget tabs also have a Costs table detailing expenses for
their respective child-objects with the same layout and information.

The Program Budget tab
The Program Budget tab is similar to the Plan Budget tab, but one level down the
plan, program, project hierarchy. While the Plan Budget tab breaks down into
information about linked programs, the Program Budget tab breaks down to
information about linked projects. The Program Budget tab also contains an
additional table about the program's line items.

After budget ancestors, from top to bottom, the program Budget tab contains the
following tables.
v The Program Budget Summary table provides an overview of the entire budget.
v The Project Cost Summary table shows allocations to child projects.
v The Line Item Details table organizes line items for the program.

Navigating with budget ancestors
At the top of the Budget tab for projects and programs, Parent Budget(s) shows a
hierarchical view of the current object, its parent, and all ancestors back to its root
plan. The name and ID code displays for each object as well as direct links to each
of the ancestor objects.

Use these links for easy navigation through the plan, program, project budget
hierarchy.

Program Budget Summary table
The Program Budget Summary table is the topmost table on the Budget tab of a
program, and summarizes funds that you expect to spend in the program and the
projects it contains. The Program Budget Summary table monitors finances for the
entire program.

In total view, the Program Budget Summary table displays the total budget for the
program's entire life; detailed view separates budget information into increments
for the currently-selected fiscal year and up to two previous fiscal years.

The Program Budget Summary table contains the same data as the Plan Budget
Summary table, except on the program level. For more information about the
table's fields and their meanings, see “Plan Budget Summary table” on page 144.

Project Costs table
The Project Costs table, found on the Program Budget tab, lists total costs
associated with all of the projects that this program contains. It has the same
layout and information as the Program Costs table on the Plan Budget tab.

For more information, see “Program Costs table” on page 145.
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Program Line Item Details table
The Program Line Item Details table is the third table found on the Program
Budget tab. It summarizes line item information entered for individual expenses on
the program level; these expenses belong to the program itself, not the projects
linked to it. This table works with invoices to track spending. For more
information about line items and invoices, see “About rolling up line items” on
page 157.

If the program requires approvals for line items, the Line Item Details table shows
the approval status for each line item in the second column.

v = In Progress

v = On Hold

v = Canceled

v = Completed

Note: This topic specifically refers to the Program Line Item Details table on the
Program Budget tab. Projects also have a Line Item Details table with the same
information and layout on their Budget tabs.

The Project Budget tab
The Project Budget tab has the same tables, layout, and information as the Program
Budget tab, except down one level in the plan, program, project, subproject
hierarchy. While the Program Budget tab breaks down into information about
linked projects, the Project Budget tab breaks down to information about
subprojects if the project has any.

After budget ancestors, from top to bottom, the Project Budget tab contains the
following tables.
v The Project Budget Summary table provides an overview of the entire budget.
v The Subproject Cost Summary table shows allocations to child projects.
v The Project Line Item Details table organizes line items for the project.

For more information, see “Plan Budget Summary table” on page 144 for the
Project Budget Summary table, “Program Costs table” on page 145 for the
Subproject Cost Summary table, and “Program Line Item Details table” for the
Project Line Item Details table.

Budget allocation versions
Budget allocation versions are a powerful tool for financial planning. Budget
allocation versions allow you to explore different financial possibilities without
overwriting the previous budget. You can create multiple budget versions with
different allocations for expenses, compare versions, and then chose the most
appropriate one for the plan, program, or project.

Use the options on the budget version drop-down list ( ) to create, delete,
and compare potential budgets until you find the best fit for your plan, program,
or project. Then activate or finalize that version to mark it "in-use;" IBM Unica
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Marketing Operations rolls the allocations from the in-use version up to linked
parent objects and down to linked child objects.

The budget version drop-down list ( ) also lists all budget versions. The
name of the budget version you are currently looking at is shown in red. The
name of the in-use version is marked with a "^."

Note: Budget versions account for different allocations, not different line items.
Adding a line item to one budget version adds the item to all versions. However,
you can use budget versions to determine how much to allocate to the line items.
Budget versions allow you to explore the effects of spending different amounts of
money on the same expenses. For more information, see “Program Line Item
Details table” on page 147 and “To add or edit line items” on page 151.

Note: To view and compare budget versions, you must have the security
permission "view budget tab." To create, edit, delete, update, and mark in-use, you
must have the security permissions "edit budget tab."

To create budget versions

Create different budget versions for financial forecasting of different scenarios.
Then you can choose the most appropriate budget by comparing them.
1. Navigate to the budget tab of the plan, program, or project.

2. Click the versions icon ( ). Choose the new version option most helpful to
you from the drop-down list.
v Create a new version creates a blank allocation version and opens it in edit

mode.
v Copy Current Version copies allocation data from the version currently

being viewed and opens it in edit mode. This method is helpful for making
subtle changes between versions.

v Copy Version From Different FY opens a dialog box on which you can
choose to copy any version from any fiscal year and opens the copy in edit
mode. This tool is useful if the budget you are working with closely
resembles the one for a prior fiscal year; for instance, if the budget decreased
significantly from year A to years B and C, but the budget for year D
resembles year A, you can copy that budget and use it as a starting point.

3. Give the new version a unique, descriptive name.
IBM Unica Marketing Operations's default names are of the form "version #x,"
where x is one greater than the number of versions currently existing in that
fiscal year. Version names must be unique within each financial year, but you
can have the same name in different fiscal years.

4. Enter or edit allocations for the new budget version.
5. Click Save and Finish to return to the Budget tab. You can now access the new

version from the versions drop-down list.

To delete versions

You cannot delete the currently selected version or in-use version. If you want to
delete the in-use version, you must first mark a different version as in-use.
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Note: To create, edit, delete, update, and mark in-use, you must have the security
permissions "edit budget tab."
1. Navigate to a version other than the one you want to delete by clicking its

name in the version ( ) drop-down list. The name of the currently selected
version appears in red on the drop-down list.

2. Select the check box next to the names of one or more versions to delete.
3. Without leaving the drop-down list, click Delete Selected Version(s).
4. When prompted, click OK to confirm the deletion.

To compare versions

This tool allows you to view the allocations for up to six budget versions on the
same screen and is useful when selecting the most appropriate one.
1. Navigate to the version to which you want to compare others by clicking its

name in the versions ( ) drop-down list. The name of the currently
selected version appears in red on the drop-down list.

2. Select the check box next to the names of up to five other versions in the
drop-down list.

3. Without leaving the drop-down, click Compare Current with Selected.
The comparison screen appears. Colors differentiate each budget version. Red
arrows indicate whether the allocations for each area are higher or lower than
the current budget. While comparing, you can show and hide versions using +
and - to isolate specific versions in the comparison.

4. After you finish comparing, click End Comparison in the yellow box at the top
of the screen.

To mark a version in-use

IBM Unica Marketing Operations considers the active or finalized budget version
of a plan, program, or project "in-use" and rolls this version down to linked child
objects and up to linked parent objects. When working with budget versions,
please note the following.
v Only one version can be active or finalized at a time.
v The default budget version is active and in-use for new plans, programs, and

projects.
v After you finalize a version, you can no longer activate versions.
v After you finalize a version, you can finalize a different version, but you cannot

remove the finalized status from all versions. After you finalize one version, one
version from that fiscal year must always have the finalized state.

Note: If upgrading to IBM Unica Marketing Operations 8.5.0, the previously
existing budget is automatically finalized.
1. Navigate to the version you want to activate or finalize by clicking its name in

the versions ( ) drop-down list. The name of the currently selected
version appears in red on the drop-down list.

2. Click Make Current Version Active or Finalize Current Version from the
versions drop-down list.
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The version is marked active or finalized and is in-use. On the drop-down list, the
in-use version is marked with "^" before the name.

Note: To create, edit, delete, update, and mark in-use, you must have the security
permissions "edit budget tab."

To allocate funds

A parent plan, program, or project allocates funds down to individual child
programs and projects contained within it. Plans fund programs, programs fund
projects, and projects fund subprojects.

Add and edit allocations on the parent’s Budget tab. Begin by allocating money to
a plan, then allocate down the program, project, subproject hierarchy using the
same procedure.

Note: In this task, parent object refers to the plan, program, or project from which
you are allocating funds. Child object indicates the next level down in the plan,
program, project, subproject hierarchy. For instance, if allocating from a program to
a project, the program is the parent object and the project is the child object.
1. Navigate to the Budget tab for the parent object from which you want to

allocate funds.
2. Select the allocation version you want to edit or create an allocation version.

3. Click the Allocations icon ( ) to modify allocations to the child project.
The Cost Summary table appears opens in edit mode.
v If you are working below the plan level, the first row of data is bold and

controls allocations for the objects line items. See “To add or edit line items”
on page 151.

v The table lists the child objects in normal font below the parent’s line items.
4. Add or edit allocations by clicking cells in the table and entering the

appropriate value by week, month, or quarter.
v For reference, the topmost row shows total funding for the parent object

from which you are allocating funds for each week, month, or quarter.
v The Remaining column shows the amount of money left in the parent

object’s budget with the current allocations.
5. Click Save and Finish to save your work and return to the Budget tab.

To continue funding, click a child object in the Total Costs table to navigate to its
Budget tab. Repeat the process by allocating funds from the new object to its child
objects.

Note: If you need to link additional parent and child objects, do so on the
Summary tab and then return to the Budget tab to allocate funds to the new child
objects.

To allocate funds for stand-alone programs and projects

A stand-alone program or project is not linked to a parent plan. When you create a
budget for a stand-alone program, the budget reflects costs associated with the
program itself and any costs associated with any projects linked to the program.
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Note: For stand-alone programs, the fiscal year is assumed to be the current year
defined by the system clock.
1. Navigate to the Budget tab for the stand-alone program or project.
2. Allocate money directly in the total budget row at the top of the table.

Note: This row is only editable for stand-alone programs and projects; linked
programs and projects have a read-only total budget row because they receive
funding from parent objects.

3. Click line items ( ) and add line items as needed. For more information,
see “To add or edit line items.”

4. Enter a budget amount for each week, month, or quarter.
5. Click Save and Finish to return to the Budget tab.

The system populates total budget row at the top of table with the information you
entered.

To add or edit line items

Line items outline the forecasted and committed costs for a program, project, or
subproject so a manager knows whether the allocated or planned budget is
sufficient. Additionally, forecasted and committed amounts, once finalized, roll up
to the accounts affected, providing visibility into budget and cash flow needs for
higher level objects.
1. Navigate to the program, project, or subproject Budget tab.

2. Click the Line Items icon ( ). The Edit Program/Project/Sub-Project Line
Items page appears.

3. To add a line item, double-click an empty cell in the Item Description
column. Enter an item name or description.

Note: The # field populates automatically after you enter an item in the Item
Description field.
To edit a line item, double-click it in the Item Description column and make
changes as necessary.

4. If the line items table contains custom text fields, enter appropriate values.
5. In the Expenditure Date field, enter the anticipated date that funds will be

spent. Click the arrow to launch a menu from which you can select a date.
You must enter an expenditure date for the budget to be finalized.

Note: To track a certain expense on different dates, you should use separate
line items. For example, to track the expense for Printing in May, June, and
July, enter three separate line items, one for each month.

6. Select a source account from the Source Account drop-down menu. The funds
for this program, project, or subproject are posted against the account you
choose when the line items are finalized.

7. Select a cost category from the Cost Category drop-down menu.
8. In the Committed Amount field, enter any committed funds related to the

line item. Leave this field blank if no portion of the line item is committed.
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9. In the Forecast Amount field, enter the amount that you predict or forecast
the line item will cost.

10. Click Save and Finish to save your changes and go to the object’s Summary
tab.

IBM Unica Marketing Operations totals the line items, but they are not rolled into
the parent object's budget until you finalize them. Finalizing line items can require
approval. For more information, see “To finalize budget line items.”

Note: Adding line items to one budget version adds them to all budget versions.
For more information, see “Budget allocation versions” on page 147.

To finalize budget line items

When you finalize budget line items for projects or programs that are linked to a
parent program or plan, the forecasted and committed line item amounts roll up to
the parent program or plan.

If the project or program requires line item approval, finalizing the line items
triggers the approval process. When a line item requires approval, it rolls up to the
parent program or plan only after completing the approval process. The first
column of the Line Item Details table shows the approval status; for more
information, see “Program Line Item Details table” on page 147.

Note: In order to finalize line items, they must have an assigned expenditure date.

Note: Finalizing line items and finalizing budget allocation versions are unrelated.
Finalize line items to roll them up to all budget versions, then activate or finalize
the most appropriate budget version to use for your plan, program, or project. For
more information, see “Budget allocation versions” on page 147.
1. Add budget line items. For more information, see “To add or edit line items”

on page 151.
Finalize and Discard Changes links appear on the budget tab.

2. Navigate to the object's Budget tab and click the Finalize link.
v If the program or project does not require line item approval or if the line

item is automatically approved because of rules your administrator
established in the object's template, IBM Unica Marketing Operations
prompts you to confirm that you want to finalize your changes.

v If any or all line items require approval, IBM Unica Marketing Operations
prompts you to send the approval; for more information on the approval
process, see “Approvals” on page 5. Line items that require approval are
rolled up to the parent object only after the approval process is completed.

3. Click OK to finalize your changes or send the approval. Click Cancel if you do
not want to finalize changes or send approvals.

After the budget line item changes are finalized, and approved if required, they
roll up to their parent objects.

To discard budget line items

Instead of finalizing budget line item edits, you can discard all changes made since
the last time you finalized budget line items.
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1. Add budget line items. For more information, see “To add or edit line items”
on page 151.
Finalize and Discard Changes links appear on the Budget tab.

2. Click Discard Changes.
IBM Unica Marketing Operations prompts you to confirm that you want to
discard your changes.

3. Click OK.

IBM Unica Marketing Operations discards the changes that you made to budget
line items since the last time you finalized them and restores the previous finalized
version of the budget line items. Marketing Operations does not trigger the
approval process.

Budget line item approvals
Depending on rule criteria your administrator establishes in project and program
templates, budget line items can be automatically approved or sent through IBM
Unica Marketing Operations's approval process. For example, your administrator
might define rules based on the line item's expenditure date, source account, or
cost category. Your administrator can also select default approvers for each rule,
such as object or account owners. If your administrator has written these rules in
your organization's project and program templates, then budget line items must be
approved, either automatically using the rules or by the assigned approvers, before
they are finalized and roll up to the parent program or plan. However, if your
projects and programs use templates that do not contain budget line item approval
rules, the functionality works as it did before IBM Unica Marketing Operations
8.5.0 and line items can be finalized directly on the object's budget tab without
going through an approval process in Marketing Operations.

Approval status for line items can be seen on the object's budget tab in the second
column of the Line Item Details table.

v = In Progress

v = On Hold

v = Canceled

v = Completed

After an approval is sent, you may or may not be able to edit the line item.
v If the approval status is canceled or completed, the approval can be edited.

Finalizing any changes to the updated line item may trigger a new approval
process.

v When the approval status is in progress, the approval cannot be edited. You
must cancel the approval first; see “To cancel an approval process” on page 91.
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Chapter 14. Invoices

IBM Unica Marketing Operations allows you to view all changes made to an
invoice, and records the time and date, as well as the type of changes made to the
invoice.

An invoice typically bills for multiple items or services, and itemizes them. It is
important to be able to capture each item or service separately, because different
line items can be attributed to different projects or programs as well as to different
accounts.

For example, one invoice contains two line items, the first associated with a project
called Trade show, and the other associated with a program called Database
Marketing Campaign. One line item can be associated with Account 1, and the
other, with Account 2.

After you create an invoice, you can do any of the following actions from its
Summary tab.
v Edit the summary information of the invoice.
v Add or edit line items for the invoice.
v Delete the invoice.
v Change the status of the invoice.
v Print the Invoice summary page.

To add an invoice
1. Select Financials > Invoices. The My Active Invoices page appears by default.

2. Click the Add Invoice icon ( ).
3. Enter information in the fields on the New Invoice page. For more information,

see “New Invoice page” on page 156.
4. To add line items, click Save and Edit Line Items. For more information, see

“To add or edit invoice line items” on page 158.

Note: You must add line items to move the invoice out of Draft state, mark it
as Paid, and roll up the expenses.

5. Save the invoice.
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New Invoice page

This table describes the fields available on the New Invoice page.

Table 45. Fields on the New Invoice page

Field Description

Invoice # An invoice number can be one of the following.

v A number provided to you by an external vendor or supplier in a
paper invoice.

v An original number based on your company’s code schema for
internal invoices or expense reports.

Note: Invoice numbers are not required to be unique across all the
invoices in IBM Unica Marketing Operations, but they must be unique
among all invoices for a particular vendor.

Vendor Name Select a vendor from the drop-down list.

IBM Unica Marketing Operations administrators populate this list. If
you cannot find a vendor on the list, ask your administrator.

Owner(s) Click Add/Remove Members to add or remove owners. By default,
this field contains the name of the invoice creator.

Security Policy Select the invoice security policy from the drop-down list.

The default value is Global.

Purchase Order # Enter the purchase order number associated with the work now being
invoiced. Typically, this value is an internal company number. In some
cases, the purchase order number is used to track preapproved
invoices.

Invoice Date Enter the billing date of the invoice or select it on the calendar.

Due Date Enter the date by which the vendor expects payment or select it on the
calendar.

Other Notes Enter any helpful notes or comments related to the invoice.

Payment Terms Enter any notes regarding payment.

To edit an invoice
1. Select Financials > Invoices.
2. Select the invoice you want to edit. Depending on the status and owner of the

invoice, it is on the My Active Invoices page or the All Invoices page.

3. If your invoice is not in Draft state, click the status drop-down ( ) and
select Re-draft.

4. Edit the fields on the Invoice page as needed. For more information, see “New
Invoice page.”

5. Add or edit line items. For more information, see “To add or edit invoice line
items” on page 158.

Note: You must add line items to move the invoice out of Draft state, mark it
as Paid, and roll up the expenses.

6. Save the invoice.
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About rolling up line items
When you change the status of an invoice to Paid, the invoice line item amount
rolls up to the program or project budget as well as to the account with which you
associated it. Remember that you can attribute the different line items of one
invoice to different projects or programs and to different accounts. Line items from
multiple invoices can roll up to the same program or project.

There are two types of rollups.
v Scheduled rollups occur on a scheduled basis.
v Immediate rollups occur when you change the status of an invoice to Paid.

Note: Depending on the line item approval rules set by your IBM Unica Marketing
Operations administrator, line items can require an approval process before the
whole invoice can be marked Payable, a prerequisite to changing the status of the
invoice to Paid and rolling up line items. For more information, see “Invoice Line
Item Approvals.”

Invoice Line Item Approvals
Depending on rule criteria your administrator establishes in invoice templates, line
items can be automatically approved or sent through the IBM Unica Marketing
Operations approval process. For example, your administrator might define rules
based on the line item's cost per unit, total quantity, or total cost. If your
administrator has written rules in your organization's invoice templates, then all
invoice line items must be approved, either automatically using rules or by the
assigned approvers, before the invoice is marked as Payable. After the invoice is
moved from Payable to Paid, the invoice rolls up to assigned accounts and the
parent program or project's budget. However, if your invoice templates do not
contain line item approval rules, the functionality works as it did before IBM Unica
Marketing Operations 8.5.0 and the invoice can be marked as Payable without
going through an approval process in Marketing Operations.

Approval status for line items can be seen on the invoice summary page.

v = In Progress

v = On Hold

v = Canceled

v = Completed

Rollups to the source program or project
When you add an invoice line item, you link it to a program or project through the
Source Project or Program field. After the invoice is paid, IBM Unica Marketing
Operations includes the invoice line item amount in the program or project budget.
Depending on whether the invoice line item is a negative or positive number, IBM
Unica Marketing Operations adds or subtracts the amount on the Actual Total field
on the source project or program Budget tab.

For example, if an invoice contains a line item of $75 that you associate with
Project 1, the Actual Total field on the Project 1 Budget tab increases by $75 after
the invoice is paid, signifying the amount of funds used in the budget.
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If an invoice contains a line item of -$75 (indicating a credit) associated with
Project 1, the Actual Total field on the Project 1 Budget tab decreases by $75 after
the invoice is paid. If the Actual Total previously showed $200 (the total from all
Paid invoices containing line items linked to Project 1), the Actual Total column,
once the credit is rolls up to Project 1, shows $125, signifying the funds used so far
for Project 1.

Note: Depending on how your administrator configures your invoice templates,
marking the invoice Payable can trigger an approval process.

Rollups to the source account
When you add an invoice line item, you can also designate an account to which
you linked the invoice line item. After the invoice is paid, the invoice line item
amount rolls up to, or figures into, the account. The invoice line item amount
displays on the Actual row on the account Summary tab. IBM Unica Marketing
Operations places the amount in a date column that corresponds to the invoice
paid date.

Note: Depending on how your administrator configures your invoice templates,
marking the invoice Payable can trigger an approval process.

To add or edit invoice line items

You must add line items to eventually mark the invoice Payable and roll expenses
up to accounts and budgets.
1. Navigate to the invoice by selecting Financials > Invoices.
2. Click the invoice number of the invoice to which you want to add line items.

3. Click the Line Items icon ( ).
4. Supply information for the fields on the Edit Invoice Line Items page. Use the

following tools to help you add, edit, move, or delete line items.

v Click the Add Row icon ( ) to insert a new line item.

v Use the Move Selected Row Up icon or Move Selected Row Down

icon to change the order in which the line items appear.

v Click a line item and use the Delete the Selected Row icon to delete a
line item.

5. Save your changes.

After line items are saved, the system calculates the Invoice Total of all line items.
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Field descriptions for the Edit Invoice Line Items page

This table lists the fields available on the Edit Invoice Line Items page.

Table 46. Fields on the Edit Invoice Line Items page

Field Description

Item Description Enter a description for the line item.
Note: The # field populates automatically when you create a line item.

Source Project or
Program

Click the drop-down list to search for a project or program with which
the invoice line item is associated.

In the Select Item window, do the following.

1. Select either Project or Program under the Find by name or code
field to find a particular type of item.

2. Enter a search string to search for a specific project or program in
the Find by name or code field. Or, leave blank and click Find to
search for all projects or programs.

3. Select a project or program from the Search Results list.

4. Click Select to close the dialog box and add the selected project or
program to the line item.
Note: This field is required in order to be able to move an invoice
into the Payable state. Once in the Paid state, the invoice amount
rolls up to the Actual Total field on the source project or program
Budget tab.

Source Account Click the drop-down list to select from all enabled accounts. The funds
for this item come from the account you choose.
Note: Once in the Paid state, the invoice amount rolls up to the source
account's summary information.

Cost Category Click the drop-down list to select an enabled cost category.

Cost per Unit Enter the amount of the line item.

Qty Enter the line item quantity.

Cost Displays the total cost for the line item. The system calculates this field
after you enter values in both the Cost per Unit and Qty fields.

Invoice status types

IBM Unica Marketing Operations invoices can be in the Draft, Canceled, Payable,
Under Review, or Paid state.

Table 47. Invoice statuses

Status Description

Draft Indicates that the invoice is still being worked on; an invoice is in
Draft state when it is first created. To move an invoice out of Draft
state, you must add line items.

If necessary, you can place an invoice in Draft state by choosing
Re-draft Invoice from the Status drop-down menu.

Canceled Canceling an invoice is not the same as deleting an invoice. When you
cancel an invoice, it is inactive, yet you retain the ability to view it in
IBM Unica Marketing Operations. Deleting an invoice removes it from
the system. When you move an invoice to this state, Marketing
Operations sends an alert to the invoice owner(s).
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Table 47. Invoice statuses (continued)

Status Description

Under Review Approvers are in the process of examining the invoice's line items.

Note: This is an internal status that occurs after marking an invoice
Payable.

Payable Items on the invoice have been reviewed, and the invoice is ready to
be sent to Accounts Payable. When you move an invoice to this state,
the owner of the account to which the invoice belongs receives a
notification.

Changing an invoice's state to Payable triggers the IBM Unica
Marketing Operations approval process if your organization is using
this functionality. The invoice may enter the Under Review status
while waiting for approvals. For more information, see “Invoice Line
Item Approvals” on page 157.

Paid The invoice has been paid. When you move an invoice to this status,
the system triggers invoice rollup. This status is not available until the
approval process is complete.

When changing an invoice from one state to another, a dialog box appears in
which you are able to enter comments regarding the status change. IBM Unica
Marketing Operations records these comments in the invoice revision history.
When changing an invoice to the Paid status, you are able to enter the date on
which the invoice was marked Paid.

To change the status of an invoice
1. Navigate to the Summary tab for the invoice of which you want to change the

status.

2. Click the Status icon ( ) and select a status. A dialog box appears in which
you can add comments.
If you select Canceled or Paid, you cannot change the status of the invoice at a
later time.

3. Click Continue to close the dialog box and apply the new status.

To delete an invoice

Owners and users with the appropriate privileges can delete an invoice that is in
the Draft state. You cannot delete invoices in the Canceled, Payable, or Paid state.
1. Navigate to the invoice by selecting Financials > Invoices.
2. Click the invoice number of the invoice you want to delete.

3. Click the Delete this Item icon ( ).
IBM Unica Marketing Operations asks whether you would like to delete the
invoice.

4. Click OK.
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To print the invoice summary

You can print all information found on your invoice summary page, or select
certain columns of information to print.
1. Navigate to the summary page of the invoice you want to print.

2. Click the Print icon . A window appears with a list of columns from
which you can choose to print. By default, all columns are selected.

3. Clear any columns you do not want to print.
4. By default, the Shrink to Fit Landscape Page Width box is checked. Clear to

print the columns at a size of 100%.
Selecting this option shrinks the page to fit all selected columns onto a single
page. If you use this feature, change your printing preference (for this print job)
to landscape.

5. Click Print Selected Columns. A preview window appears, showing you what
the printed information will look like.

6. Click Print. The Print dialog appears.
7. Select your printer and printer options (choose landscape mode for best

results), and click Print to print the selected columns.
8. In the preview window, click Close to close the print preview.

Chapter 14. Invoices 161



162 IBM Unica Marketing Operations: User's Guide



Chapter 15. About accounts

A top-level IBM Unica Marketing Operations account represents a specific
corporate general ledger account established by a finance department for the
purpose of tracking and controlling expenditures and cash flows for a certain area
of the business. Accounts may have subaccounts.

Key capabilities related to accounts include the following.
v Defining a hierarchy of accounts and subaccounts.
v Funding or allocating money to the account, at the beginning of a fiscal period,

typically a year, revisited weekly, monthly, or quarterly.
v Tracking estimated and actual withdrawals from those accounts, by time period.

You must have administrative privileges to add new accounts to IBM Unica
Marketing Operations.

About the accounts summary page
When you select Financials > Accounts, the account Summary tab appears. Use
the account Summary tab to perform the following tasks.
v View Basic account information.
v Review the Account summary table. This is a view-only table which reflects the

budgeted, forecasted, committed, and actual amounts for that account, as well as
remainder amounts.

v Select the fiscal year to view.

Account summary table

The Account Summary table contains the following information.

Table 48. Fields in the Account Summary table

Field Description

Budget Amounts that the account administrator entered to fund the account.
For more information about creating and editing accounts, see the IBM
Unica Marketing Operations Administrator's Guide.

Forecast The sum of all forecasted values entered into the Forecast Amount
field of finalized project and program budget line items for which this
account is the source account (as specified in the budget line item
Source Account field). These sums appear for a particular month on the
table according to when you finalized the line items. For example, if
you finalize a forecasted line item amount in May, that amount appears
in the May column of the Forecast row.

Available The difference between values in the Budget and Forecast rows.

Committed The sum of all committed values entered into the Committed Amount
field of finalized project and program budget line items for which this
account is the source account (as specified in the budget line item
Source Account field). These sums appear for a particular month on the
table according to when you finalized the line items. For example, if
you finalize a committed line item amount in May, that amount
appears in the May column of the Committed row.
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Table 48. Fields in the Account Summary table (continued)

Field Description

Uncommitted The difference between values in the Budget and Committed rows

Actual The sum of all invoice line items for which this account is the source
account (as specified in the invoice line item Source Account field).
These invoice line items roll up to this field only when the invoice to
which they belong is in the Paid state. These sums appear for a
particular month in the table according to when you marked the
invoice line items Paid.

For example, if you mark an invoice line item amount Paid in May,
that amount appears in the May column of the Actual row.

Remaining The difference between values in the Budget and Actual rows.

About selecting the fiscal year to view
Because accounts can span multiple fiscal years, you can select a year in which to
view the account information.

From the Account Summary drop-down list, you can choose from the current year,
and the following two years. Additionally, if budget or invoice line items draw
from the account in other years, those years also appear in the list.

A Marketing Operations administrator configures your fiscal year by setting the
Settings > Configuration > Marketing Operations > umoConfiguration >
firstMonthInFiscalYear parameter to the month that you would like your account
fiscal year to begin. For more information, see the IBM Unica Marketing Operations
Administrator's Guide.
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Chapter 16. Metrics

Metrics are used for management reports and analysis. You view them on the
Tracking tab for plans, programs, and projects.

Use IBM Unica Marketing Operations metrics for the following calculations.
v Automatically calculate internal measures (such as budgets and resource

consumption).
v Automatically tabulate program results, such as the following.

– Measure consistently across activities.
– Aggregate results across programs.

v Automatically link key metrics (such as number of contacts and responses) from
campaigns back to project metrics.

v Build a marketing memory.

The metrics that are available in a plan, program, or project depend on the
template you used to create it.

To set up program or project metrics

This procedure describes setting up metrics for a program; setting up metrics for a
project is similar.
1. Add a program, using the wizard.

While using the wizard, the tracking page displays the template tracking
information for your program. You cannot change the type of information that
is captured on this page. You can enter target values for the categories that
exist on the Tracking page. Depending on how your administrator set up your
program templates, the number of columns on this page can vary.

2. Enter the target value you want to achieve by executing this program in the
Target column. For example, if the program is a product launch, you may want
to achieve 100 contacts, or get 1 hour of media coverage.

3. If other columns such as Optimistic or Pessimistic appear, you can enter
corresponding values. For example, if your target value for a Total Contacts
category was 100, a Pessimistic value for Total Contacts might be 50.

4. Click Next to continue the program wizard.
When you are finished creating the program, the metrics you entered appear on
the Tracking tab for that program.

To edit program or project metrics

When you created your program or project using the wizard, you entered various
metrics on the Tracking page. To edit the values you entered, follow the procedure
below.

If the program is linked to a plan, or the project is linked to a program, you must
finalize the edits you made before they will roll up to the parent object.
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This procedure describes editing metrics for a program; editing metrics for a
project is similar.
1. Navigate to the Tracking tab of the program whose metrics you would like to

edit.

2. Click the Program Metrics icon ( ).
The Edit Program Tracking page appears.

3. Edit the values you would like to change.
4. Click Save and Finish.

The Tracking tab for the program displays. The updated metrics appear in the
Program Metrics table.

Entering planned values for rollup metrics
You can incorporate your goals and performance expectations for your marketing
campaign into IBM Unica Marketing Operations by entering planned values for
metrics that roll up. The planned values display side-by-side with the actual values
at the end of the campaign.

When entering planned values for metrics, you work top-down. That is, you open
a plan and specify planned values for the metrics for each of its child programs.
You then open a program and add planned values for the metrics for each of its
child projects.

To enter planned values for metrics that roll up
1. Open a plan or program that has child programs or projects with rollup

metrics.
2. Click the Tracking tab.

3. Click the Planned Rollups icon ( ).
The Edit Planned Rollup Values page displays.

4. Enter the planned values for the metrics.
5. Click Save and Finish.

The values you entered display in the Planned column of the Program Metrics or
Project Metrics table on the Tracking tab.

Views for rollup metrics
The following views are available for rollup metrics.

Table 49. Views for rollup metrics

View mode Description

High-Level
Summary

Displays a summarized view of all rolled up metric dimensions. The
High-Level Summary is the default view.

Breakout of
Planned

Displays details of planned values for rollup metrics.
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Table 49. Views for rollup metrics (continued)

View mode Description

Breakout of
Planned and
Rollup Target(s)

Displays details of planned and target values for rollup metrics

Breakout of
Planned, Rollup
Target(s), and
Rollup Actual(s)

Displays details of planned, target, and actual values for rollup metrics.

Breakout of All
Rollups

Displays details of target, actual, and any other custom values for
rollup metrics used in the plan or program.

To change the view for rollup metrics, click the View icon ( ) and select a
view from the drop-down menu.

To import metrics from a campaign
1. Navigate to the Tracking tab of the campaign project whose metrics you want

to import.
2. Click Import Values.

The IBM Unica Campaign metrics are displayed on the Import Values page.
The information imported depends on the metrics the template creator defined.
IBM Unica Marketing Operations captures and displays the last date of import,
shown as External Sources Last Refreshed Date Time at the bottom of the
table.

3. Click Save and Finish to update the metrics on the Tracking tab and close the
Import Values page.

If necessary, manually update metrics that you imported.

Finalizing and rolling up metrics
When a project is linked to a program or a program is linked to a plan, you can
roll up metric values from the child object to the parent object. Template creators
define how metrics roll up to the parent object. For more information about
defining rollup behavior, see the IBM Unica Marketing Operations Administrator's
Guide.

Note: Planned values for metrics do not roll up. Those values are for top-down
planning.

Metric values do not roll up automatically. IBM Unica Marketing Operations rolls
up the values when you indicate that they are final. Each time you import new
metric values or edit metric values, you must indicate that the values are final in
order for them to roll up.

Whenever there are metric values that have not been rolled up, a Finalize link
displays on the Tracking tab of the object containing the values.
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To finalize and roll up metrics

The Finalize link displays only if there are new or changed metric values that have
not yet been rolled up.
1. Navigate to the Tracking tab of the project or program whose metrics you want

to roll up to their parent program or plan.
2. Click the Finalize link. (The Finalize link appears after metrics are edited or

imported.)
3. The metrics that are defined for rollup are rolled up to the parent program or

plan and are available on the parent object's Tracking tab.
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Chapter 17. Reports

By default, IBM Unica Marketing Operations provides a set of predefined reports
and dashboard components. The Marketing Operations reports package provides
additional example reports and dashboard report components created in IBM
Cognos®, a separate business intelligence application.

You access reports from IBM Unica Marketing Operations in the following ways.
v Click the Analysis tabs of individual items like projects and marketing objects to

see reports that apply to the current item.
v Select the Analytics > Operational Analytics to see example Cognos reports that

present data from more than one object.

The reports administrator can modify the reports, create new ones, add custom
attributes, set up criteria filters, etc.

Report appearance and output

Each Cognos report has a header, a body section, a page footer, and navigational
controls. When you run a report, it appears in your browser window in HTML
format. For many of the reports, you can select a different format (for example,
PDF or XML) to view.

Because the following reports have multiple queries, you cannot export them as
CSV or XML files.
v Analytics page report: Project Crosstab Summary Report
v Analysis Tab reports: Project Detailed Expense Breakout, Project Approval and

Response, and Budget Summary reports (plan, program, project)

For further details on report output appearance and formats, see the Cognos
documentation.

Sending reports in email

Click the Email icon ( ) to open a form where you enter email addresses for
recipients of the report. After you complete the form and choose OK, the report is
sent in the current format chosen for display.

For example, if you choose PDF then email, the report is sent as a PDF attachment
to the message.

Enter the following information in the email dialog:
v Email addresses: type the address for each recipient, separated by semicolons.
v Subject: type subject for the message. Defaults to the name of the report.
v Body: type in the message.
v Attachments: ensure the Include the report box is checked.

Note: Do not select Include a link to the report; this option is not currently
supported.
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Filtering report criteria
The data in reports can be filtered in various ways, depending on the report. You
use filters to specify report criteria and parameters for your report.

This section describes how to use the filters and prompts that appear when you
run reports.

Search and Select Prompt boxes

This type of filter allows you to perform a search and then choose which results to
use for the report. Various reports use these filters for the following types of data:
v Owners
v Users
v Vendors
v Projects; you can search by project name or project code.
1. Type a keyword or words to search, then optionally choose the search option:

v Starts with any of these keywords (default setting)
v Starts with the first keyword, and contains all of the remaining keywords
v Contains any of these keywords
v Contains all of these keywords
For example, if you are searching for project code PRO1001, you can type PRO
or 1001, and choose the Contains any of these keywords option.

2. Click Search.
System returns data matching the search criteria.

3. Use Insert, Remove, Select all, and Deselect all to create a list of items for
your report. Move the items to appear in your report into the Choices list box,
as shown here:

The report contains data for the owners, users, vendors, or projects that appear
in the Choices list box.

Dates
To narrow the date range for your report, use the Date filter:
v The Earliest date option puts no limitation on the begin dates for the search.

Similarly, the Latest date option does not limit by end date. The default setting
is to have both of these options selected, which means the system does not filter
on dates at all.
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v Entering actual dates in the From or To field, or both, limits the report to tasks
that contain dates active within the selected range.

Active dates
Date prompts use active dates. All projects (or plans or programs) that are active
any time within the date range specified meet the report criteria.

For example, if you specify a date range from January 1, 2005 to March 15, 2005,
the following projects will meet the criteria:
v Projects starting on or after January 1, 2005, no matter when they end.
v Projects ending on or before March 15, 2005, no matter when they began.

Projects that do not meet the criteria:
v Projects ending before January 1, 2005
v Projects starting after March 15, 2005

Status and Type
These filters limit the report to contain only tasks with selected status or type
(determined based upon the template used to create the project). For these filters,
select as many choices as you like.

Note: Making no selection is equivalent to selecting all choices.

Multi-object reports

This section describes the default reports that are listed on the Analytics Home
page when the IBM Unica Marketing Operations reports package is installed. It
also presents procedures for running them.

The following table introduces the default reports.

Table 50. Default reports: Analytics Home page

Report Description

Marketing
Activity Report

Lists all users who logged in to Marketing Operations during a
specified date range, with the total number of projects created by each
user.

Overdue
Milestone

Displays all overdue milestones with task end dates that fall between
the selected start and end dates.

Program Tasks
and Milestones

Displays all milestones for the program selected in the parameter field.

Project On Time
Analysis

Displays completed projects within the time period specified along
with the number of days early or late. These dates are calculated by
pulling the greatest date in the workflow for the project for both the
target and forecast/actual columns.

Project
Performance
Crosstab

Displays project performance metrics, including leads passed, revenue,
and ROI. The data is aggregated over initiative and project type versus
business units. This report requires the Financial Management Module.

Project
Performance
Summary

Displays projects and their budget data. This report requires the
Financial Management Module.
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Table 50. Default reports: Analytics Home page (continued)

Report Description

Project
Performance
Summary
(Custom)

Displays projects grouped by initiative, with their budget, cost,
revenue, response rate, and lead generation performance data. This
report demonstrates how a sample report can be customized using
custom attributes. This report does not work unless your template
administrator implements the example custom attributes. This report
requires the Financial Management Module.

Project Tasks Displays all tasks and their status for the specified project.

Resource Task
Load

Displays tasks assigned to selected users. The report returns tasks for
each project that falls into the specified date range.

Resource
Utilization
Summary

Displays a summarized view of resource utilization percentages by
user. Select start and end dates to specify a date range for the report.

System Programs Displays a breakdown of programs by status and template type.

System Projects Displays projects broken down by status and template type.

System Users Displays details for each IBM Unica Marketing Operations user.

Task On Time
Analysis

Displays all tasks that are either early or late, where the task end date
falls between the selected Start Date and End Date. The report is
grouped by task name.

If a task ended early, the number of days it finished ahead of schedule
displays on a green background. If it ended late, the number of days
late displays as a negative number on a red background.

Vendor Spend
Summary

Displays total invoiced expenses for specified vendors in the specified
date range, including breakouts for paid, approved, and received
expenses. This report requires the Financial Management Module.

To run the Marketing Activity report

The Marketing Activity report presents a list of all Marketing Operations users
who logged in to the system during a specified date range, with the total number
of projects each one created. You produce the report by entering a Report Start
Date and Report End Date.
1. Select Analytics > Operational Analytics.
2. In the list of reports, click Marketing Activity Report.

A screen appears allowing you to set filter criteria.
3. Choose start and end dates for the report.
4. Click Finish to create the report.

The report contains the following columns: First Name, Last Name, Email Address,
Login ID, No. of Projects, and No. of Subprojects.

To run the Overdue Milestone report

The Overdue Milestone report shows all overdue milestones with task end dates
that fall between the selected start and end dates. You can filter the report by using
the Report Start Date and Report End Date parameters as well as the Task Status
and Project Status parameters.
1. Select Analytics > Operational Analytics.
2. In the list of reports, click Overdue Milestone Report.
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A screen appears allowing you to set filter criteria.
3. Choose start and end dates for the report.
4. Optionally, set filters for Task and Project status.
5. Click Finish to create the report.

The report displays a list of milestones, grouped by the milestone owner, sorted by
project code, and containing the following columns: Milestone Owner, Project
Code, Milestone, Task Number, Status, Task Name, End Date, Forecast/Actual End,
Days Late, and Notes.

To run the Program Tasks and Milestones report

The Program Tasks and Milestones report shows all milestones for projects that are
part of the program selected in the parameter field. You can filter the report on
milestone type. If you chose not to filter on milestone type, all tasks are displayed.
1. Select Analytics > Operational Analytics.
2. In the list of reports, click Program Tasks and Milestones.

A screen appears allowing you to set filter criteria.
3. Select a program in the Program drop-down menu.
4. Optionally, select Milestone types for the report. If you do not choose any

Milestone types, the report contains all tasks in all projects that belong to the
selected program.

5. Click Finish to create the report.

The report displays a list of milestones (or tasks), grouped by project and sorted by
date, and containing the following columns: Project Name, Milestone type, Task
Number, Forecast/Actual dates and effort, Target dates and effort, Variance, and
Notes.

The Variance column contains the number of days early or late the milestone
occurred. If a milestone is reached early, it is displayed on a green background. If
it is reached late, it is displayed as a negative number on a red background.

To run the Project Performance Crosstab report

The Project Performance Crosstab report shows high-level project metrics in a cross
tabulation along multiple dimensions of custom attributes.

The example included is a cross tab of project performance metrics including leads
passed, revenue, and ROI (Return on Investment), aggregated over initiative and
project type vs. business units.

This report requires the Financial Management Module.
1. Select Analytics > Operational Analytics.
2. In the list of reports, click Project Performance Crosstab. A screen appears

allowing you to set filter criteria.
3. On the first filter page, choose the projects to include in the report. To specify

other filters, click Additional Prompts and proceed to step 4. Otherwise, skip
to step 5.

4. On the second filter page, specify filters for any or all of the following:
v Project owner
v Project date range
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v Project status
v Project type: determined based on the template used to create the project
All sections on the filter pages are optional. If you do not enter any information
in any of the sections, the resulting report contains the resource task load for all
users and all projects in the system.

5. Click Finish to create the report.

The sample report provided contains the following information:
v Row Dimensions: (1) Initiative, (2) Project Type

Data in the rows is grouped by Initiative; you can use this field to categorize
your programs and plans. Each Initiative section contains rows for each Project
Type included in the report.
Project type is determined from the template used for creating the project.
Sample project types are Database Marketing Campaign, Tradeshow Template,
Marketing Collateral, and Campaign Project Template.

v Column Dimension: Business Unit
A business unit is a field on the project and plan creation page. It is one way to
categorize projects and plans.

v Metrics to show: number of leads passed, revenue, and ROI (Return on
Investment)
Example of a Project Performance Crosstab report:

To run the Project Performance Summary report

The standard Project Performance Summary report lists projects alphabetically,
along with status, date, and budget information. The custom version lists projects
grouped by initiative, with budget, cost, revenue, response rate, and lead
generation performance data. Both versions require the Financial Management
Module.

The custom version of this report also contains additional prompts and custom
fields. It demonstrates how a standard report can be customized using custom
attributes and works only if your template administrator implements the custom
attributes.
1. Select Analytics > Operational Analytics.
2. In the list of reports, click Project Performance Summary.

A screen appears allowing you to set filter criteria.
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3. On the first filter screen, you can choose the projects to include in the report. If
your only filter criteria is projects, click Finish to run the report. To specify
other filters, click Additional Prompts and proceed to step 4.

4. On the second filter page, specify filters for any or all of the following:
v Project owner
v Project date range
v Project status
v Project type: these are determined based upon the template used to create

the project
All sections on the filter pages are optional. If you do not enter any information
in any of the sections, the report contains project performance for all projects in
the system.

5. Click Finish to create the report.

The report displays a list of projects sorted by project name. The custom version is
grouped by Initiative. The reports contain the following columns:

Table 51. Columns in the Project Performance Summary report

Column Description

Project
Name/Code

Displays the project name and its ID.

Status Displays the status of each project.

Target dates Displays the target start and end dates.

Business Unit,
Segment, and
Product Family

Displays the business unit, segment, and product family for each
project. These fields are included with the sample templates, and are
used to categorize projects. Not all types of projects contain all of these
fields. If your report uses a project that does not contain one or more
of these fields, the column is ignored (it is blank for that project).

(These fields are only in the custom version of the report.)

Total Budgeted
Total Forecasted
Actual Cost

Displays a variety of budgeting information. These fields are supplied
from the budget tab for each project.

Total Revenue Displays revenue metrics (if defined) for the project.

Response rates
and leads
columns

Displays response rate and leads generation data. Response rates and
leads data are taken from the metrics for each project (found in the
Tracking tab).

(These fields are only in the custom version of the report.)

ROI Displays ROI (Return On Investment) metrics (if defined) for the
project.

(This field is only in the custom version of the report.)

To run the Resource Task Load report
1. Select Analytics > Operational Analytics.
2. In the list of reports, click Resource Task Load.

The Filter Resource Workload screen appears.
3. Specify filters for any or all of the following:

v User
v Projects
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v Project date range
v Project status
v Project type: these are determined based upon the template used to create

the project
All sections on this page are optional. If you do not enter any information in
any of the sections, your report contains the resource task load for all users and
all projects in the system.

4. Click Finish to create the report.

The report results are written to the screen, unless another format is selected. The
report displays tasks meeting the filter criteria, grouped by user, and containing
the following columns from the workflow tab of the project:

Table 52. Columns on the Resource Task Load report

Column Description

Task Name Displays the project name and its ID.

Project Name Displays the project name and code; clicking the link opens the
summary page of the project (if your report administrator has
configured the drill-back URL).

Dates Displays the forecast/actual and target start and end dates.

Status Displays the status of each task.

% Complete Displays the current progress of each task.

Notes Displays the notes for a task.

Condition Displays a condition, based on the dates for a task.

If the end date for a task is later than its target end date, this column
contains one of two values:

v Late: if status is In Progress or Completed, and Forecast Start Date
is later than Target Start Date.

v Overdue: if status is In Progress or Completed, and Forecast End
Date is later than Target End Date.

For all other tasks, this field is blank.

To run the Vendor Spend Summary report

The Vendor Spend Summary report displays total invoiced expenses for specified
vendors in a specified date range, including breakouts for paid, approved and
received expenses. This report requires the Financial Management Module.
1. Select Analytics > Operational Analytics.
2. In the list of reports, click Vendor Spend Summary.

A screen appears where you can set filter criteria.
3. Specify filters for:

v Vendor
v Invoice date range (defaults to today’s date)
Both filters are required.

4. Click Finish to create the report.

The report is a summary of invoices by vendor, with three columns. The columns
categorize the invoice totals by their status, as follows:
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v The Outstanding column totals all invoices with a status of Draft.
v The Payable column sums all invoices with a status of Payable.
v The Actual Spent column sums all invoices with a status of Paid.

An example of the Vendor Spend Summary report:

Single-object reports

The single-object reports are available from the Analysis tab of projects, programs,
and plans. For these reports, you are reporting on that single object.

The following table describes both the standard single-object reports and the
example IBM Cognos reports made available when the IBM Unica Marketing
Operations reports package is installed.

Table 53. Default reports: Analysis tab

Report Description

Revision History A report that lists the revisions made to the current object. You see
this report by default when you click the Analysis tab of accounts,
approvals, assets, plans, programs, projects, marketing objects,
requests, teams, and invoices.

Approval Responses A report for projects that displays information about approval
tasks.

Invoice Summary List A report for projects and programs that lists invoice summary
information. This report requires the Financial Management
Module.

Marketing Object
Cross-Reference

A report for projects and marketing objects that lists the marketing
objects referenced or modified by the current object.

Approval and
Compliance Listing

An example Cognos report for projects that displays additional
information about approval tasks.

Budget Summary An example Cognos report for projects, programs, and plans that
displays a summary of the budget by week, month, or quarter.
This report requires the Financial Management Module.

Detailed Expense
Breakout

An example Cognos report for projects that displays a breakout of
the project expenses. This report requires the Financial
Management Module.

Work Assigned A report for teams that displays work assignments by team and by
team member.
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To view the revision history of an object

After you work in an object, you can view its revision history to see who created
and modified the object, which fields were modified, and when the modification
took place.

You can review the revision history for the following objects: accounts, approvals,
assets, plans, programs, projects, requests, teams, and invoices.
1. Navigate to the Summary tab of an object to view its revision history.
2. Click the Analysis tab.

By default, the page displays the revision history of the object, listing all
modifications to the object since it was created.
You can click Revision History in the Report Type pull-down menu to display
the revision history if another report is displayed.
Note the following:
v For projects, click Approval Responses in the Report Type pull-down menu

to display the revision history for any approvals linked to tasks within the
project.

v For approvals, an entry is created whenever the approval round number
changes (when the approval owner requests reapproval for whatever reason).
For example, if Connie Contact (approval owner) changes an approval and
requests reapproval, an entry like the following is added to the revision
history of the approval:
Connie Contact on 12/15/2005 01:47:50 PM Approval Round #2: Approval
was re-requested and the round number has increased.

To run the Approval and Compliance Listing report

The Approval and Compliance Listing report lists the approval processes for the
workflow approval tasks of a project. It is separated into sections for current
approval processes, completed approval processes, and approval processes
scheduled to begin in the future.
1. Select Operations > Projects.
2. From the list of projects, select the one to report on.
3. Navigate to the Analysis tab of the project.
4. From the Report Type pull-down menu, choose Approval and Compliance

Listing.
The report displays on screen.

This report contains the following information:

Table 54. Columns on the Approval and Compliance Listing report

Column Description

Approval
Process/Progress

Displays the task number, name, and progress for each approval
process listed. Progress is described as how many approvals have been
received out of the total number expected.

Items Being
Approved

Displays a list of the items being approved.

Approvers Displays a list of the approvers. For a required approver, displays
(Required) next to the name of the approver.
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Table 54. Columns on the Approval and Compliance Listing report (continued)

Column Description

Linked Task Displays the task number and name of the workflow task linked to the
approval.

Status Displays the status of the approval:

v In Progress: indicates an active approval process.

v On Hold: indicates a temporarily halted approval process

v Completed: indicates an approval process that is finished.

v Not Started: indicates an approval process that has not yet been
submitted for review.

To run the Budget Summary by Quarter report

The Budget Summary by Quarter report displays budget information by quarter
for the selected project, program, or plan, and fiscal year. For programs and plans,
data rolls up from contributing projects and programs. This report requires the
Financial Management Module.
1. From the Operations menu, select:

v Projects to run the report for a project.
v Programs to run the report for a program.
v Plans to run the report for a plan.

2. From the list, select the project, program, or plan to report on.
3. Click the Analysis tab.
4. From the Report Type pull-down menu, choose Budget Summary by Quarter.

The report for the current fiscal year displays. If there is data for more than one
year, you can choose a different fiscal year for the report from the Fiscal Year
pull-down menu.

Data is organized for the selected fiscal year, as follows:

Table 55. Data on the Budget Summary by Quarter report

Section Description

Summary table This table displays summary budget information:

v Rows: different breakdowns of the budget; actual/remaining,
committed/uncommitted, and forecast/available

v Columns: Fiscal year total, then one column for each quarter.

Note: For projects, the report consists of only this table.

Details table For programs and plans, this table shows budget information rolled up
from subordinate objects.

v Rows: for a program report, each individual project that is part of
the program has its own row. Similarly for a plan report, each
program has its own row.

v Columns: Each quarter has columns for rollup budget, rollup
forecast, rollup committed, and rollup actual.
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To run the Detailed Expense Breakout report

This report requires the Financial Management Module.
1. Select Operations > Projects.
2. From the list of projects, select the one to report on.
3. Click the Analysis tab of the project.
4. From the Report Type pull-down menu, choose Detailed Expense Breakout.

The report for the current quarter displays. If there is data for more than one
quarter, you can choose a different quarter for the report from the Fiscal
Quarter pull-down menu.

Data is organized for the selected quarter, as follows:

Table 56. Data on the Detailed Expense Breakout report

Section Description

Accounts Displays three columns (actual, committed, and forecast) of the budget
information for the account. The data for each account is displayed on
its own row. The first row contains summary data for all accounts.

Cost categories Displays three columns (actual, committed, and forecast) of budget
information. The data for each category is displayed on its own row.
The first row contains summary data for all cost categories.

Vendors Displays actual money spent per vendor. There is one row per vendor,
and the first row presents summary data.

To run the Work Assigned to Team or Team Member Reports

You can view the approvals, projects, project requests, and tasks associated with a
team as a whole or with a specific team member.
1. Navigate to the Analysis tab of a team.
2. Select the report type and work assignment (approvals, projects, project

requests, or tasks). If you select the Work Assigned to Team Member report,
also select the team member.
The report is displayed.

The following information is available.

Table 57. Data on the Work Assigned to Team or Team Member Reports

Section Description

Name Displays the name for approvals, project requests, and tasks;
clicking the link opens the summary page of the work assignment
(if your Report Administrator has configured the drill-back URL).

Project Name Displays the project name for projects; clicking the link opens the
summary page of the project (if your Report Administrator has
configured the drill-back URL).

Project Code Displays the project code for approvals, projects, and tasks.

Project Owner Displays the project owner for approvals and tasks.

Requester Displays the requester for approvals and project requests.

Task Owner Displays the task owner for tasks.

Request ID Displays the ID for project requests.
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Table 57. Data on the Work Assigned to Team or Team Member Reports (continued)

Section Description

Approver Displays the approver for approvals.

Status Displays the status for approvals, projects, and tasks.

Marketing Operations list portlets

This section describes the standard Marketing Operations portlets that are available
for use on dashboards even if the Marketing Operations reports package is not
installed.

Table 58. Standard Marketing Operations portlets

Report Description

Approvals Awaiting
Action

List of approvals waiting for your action.

Manage My Tasks Lists your Pending and Active tasks and Not Started and In
Progress approvals. An option to change the status of each item
appears.

v For tasks, you can change the status to Finish or Skip.

v For Not Started approvals, you can change the status to Submit
or Cancel.

v For In Progress approvals that you own, you can change the
status to Stop, Finish, or Cancel.

v For In Progress approvals that you are assigned to approve, you
can change the status to Approve or Reject.

My Active Projects Lists your active projects.

My Alerts Lists your Marketing Operations alerts.

My Requests Lists requests that you own.

My Tasks Lists tasks that you own.

Projects Over Budget Lists all projects that are over budget for the calendar year. This
report requires the Financial Management module.

Marketing Operations IBM Cognos report portlets

This section describes the Marketing Operations dashboard portlets that are
available in the Marketing Operations reports package.

Table 59. Standard Marketing Operations IBM Cognos report portlets

Report Description

My Task Summary An example IBM Cognos report showing data about all active and
completed tasks for the user viewing the report in all In Progress
projects.

My Approval
Summary

An example IBM Cognos report showing data about active and
completed approvals for the user viewing the report.

Manager Approval
Summary

An example IBM Cognos report showing data for active and
completed approvals for all In Progress projects in the system.

Projects by Project
Type

An example IBM Cognos report showing a 3-D pie diagram that
shows all In Progress projects in the system by template type.
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Table 59. Standard Marketing Operations IBM Cognos report portlets (continued)

Report Description

Projects by Status An example IBM Cognos report showing a 3-D bar chart that
shows all projects in the system by status: draft, in progress, on
hold, canceled, and finished.

Manager Task
Summary

An example IBM Cognos report showing data for active and
completed tasks for all In Progress projects.

Marketing Financials
Position

An example IBM Cognos report showing a timeline with Budget,
Forecasted, Committed, and Actual amounts for all plans in all
states in the current calendar year. This report requires the
Financial Management module.

Spend by Project
Type

An example IBM Cognos report showing a 3-D pie chart of the
actual amount spent per project type in the current calendar year.
This report requires the Financial Management module.

Completed Projects
by Quarter

An example IBM Cognos report showing a 3-D bar chart of the
number of early, on-time, and late projects completed this quarter.

Projects Requested
and Completed

An example IBM Cognos report showing a timeline graph of the
number of project requests and number of completed projects per
month. This report counts project requests with the following states
only: Submitted, Accepted, or Returned.

Forecast by Project
Type

An example IBM Cognos report showing a 3-D pie chart of the
forecasted spending per project type for the current calendar year.

Budget by Project
Type

An example IBM Cognos report showing a 3-D pie chart of the
budget per project type for the current calendar year. This report
requires the Financial Management module.
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Chapter 18. Searches

You can perform two kinds of search in IBM Unica Marketing Operations: simple
and advanced.

You can perform a simple or advanced search for plans, programs, projects, tasks,
assets, approvals, marketing objects, and invoices from any view in the
corresponding section of IBM Unica Marketing Operations. Searching in the
Programs section retrieves only programs; searching in the Projects section
retrieves only projects, etc.

Simple searches

IBM Unica Marketing provides a simple search function that enables you to search
for most objects, including plans, programs, projects, assets, approvals, tasks, and
invoices. You can perform these searches using the Search field in the menu bar at
the top of the IBM Unica Marketing window. For details on this search function,
see the IBM Unica Marketing Platform Administrator's Guide. You can use this search
to search for most objects, including plans, programs, projects, assets, approvals,
tasks, and invoices.

Advanced searches

IBM Unica Marketing Operations also provides an advanced search function that
enables you to specify more complex searches based on several different criteria
that apply the type of items for which you are searching. You can save commonly
used advanced searches to save time.

Advanced searching works the same for all objects except assets. Marketing
Operations provides one type of advanced search page for assets, and a different
type for all other objects that contain advanced search functionality.

Permissions considerations

When you search for an object, IBM Unica Marketing Operations always conducts
the search against all the objects the user has security rights to view (for example,
all projects). This comprehensive search occurs even if you initiate the search from
within a filtered view, such as the Active Projects view, or from within a saved
search.

For example, if you do not have access to the Workflow tab of a project template,
tasks from the project created from that template do not appear in the results of an
All Tasks search even if you are a member (Owner/Participant/Requester) of the
project. However, if one or more tasks from that project are assigned to you, then
those projects display regardless of your access rights.

About searching within grids
In advanced search, grid attributes appear in the list of available attributes to add
to a search for all project templates that are enabled, whether or not any projects or
marketing objects exist that have been created from that template.

For example, assume that your system contains the following:
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v A project template named Trade show, and this template is enabled.
v A tab named Vendors is available for Trade show templates.
v The Vendors tab contains a grid, and one of the grid columns is named Vendor

URL.

On the advanced search screen for projects, you can select Vendor URL when you
choose a condition for the search. The Vendor URL attribute appears in the list,
even if your system does not contain any Trade show projects.

When a template is deleted, its grid attributes are no longer available as search
criteria. You can search for attributes in a disabled template; choose a disabled
template (or All Disabled) from the advanced search screen.

About searching for marketing object attributes
You can search for attributes contained in a linked-to marketing object, from
marketing objects or projects. For example, suppose that you have projects that
link to marketing objects that in turn contain an attribute for which you want to
search:
v You have projects of type Marketing Collateral, which can link to
v Marketing objects of type Creatives, which contain an attribute
v Cost, representing the cost of the creative.

From the project page, you can perform an advanced search which returns projects
based on criteria you specify about the Cost attribute.

To perform an advanced search of a digital asset library

The advanced search for assets allows you to search for information in specific
fields that the owner filled out when creating or modifying the assets.
1. Select Operations > Assets.
2. Select a digital asset library to search

3. Click the Search/Filter icon ( ).
The Assets Search screen appears.

4. Fill in one or several of the fields, depending on what you want to search for.
5. Click Search.

The items meeting the search criteria are displayed on the Assets list page.

To perform an advanced search (except for assets)
1. Open the list page of the object type for which you want to search (for

example, projects or tasks).

2. Click the Search icon ( ).
The Advanced Search page appears:

184 IBM Unica Marketing Operations: User's Guide



3. Select a template on which to base the search. The list groups templates for
the object type into All Templates, All Enabled, and All Disabled.

Note: This list does not appear if there is only one template available for the
object type.

4. Select an attribute on which to base the search. Attributes are listed in
alphabetical order.

5. Select an operator for the search. The operators that are available depend on
the type of attribute selected for the search.

6. Select or enter a value.
7. Repeat steps 3 through 6 as necessary to add criteria to your advanced search.
8. If you specify multiple criteria, indicate whether you want to search for

objects that match any of your criteria or all of them at the top of the dialog.
9. Optionally, click Save as to save the search. Administrators can also publish

the search by selecting the Publish check box on the Save As dialog box.
Published searches are available to all Marketing Operations users.

10. Click Apply to perform the search based on your criteria.

To regroup and reorder search criteria

As you construct search criteria, you can rearrange the grouping and order of any
individual search condition:
1. For the condition you want to move, position the cursor over the condition’s

number box.
The cursor changes to a double vertical arrow, and the tooltip, "Drag to move
this condition to another place in the query." appears.

2. Drag the condition to where you want to insert it. Note the red guide line,
showing where the condition will be inserted.

3. Once the condition is positioned correctly, release the mouse to drop it into its
new location.

Note: You can drag and drop search criteria at any level.

About the Not In operator
Background

IBM Unica Marketing Operations objects (plans, programs and projects) are created
from templates.
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Templates have definitions of attributes, for example, brochure_type. Project
instances created from the same template can have different values for their
attributes. For example, TS001 might have Tri-fold as its brochure type, and TS002
might have Bi-fold.

In a typical IBM Unica Marketing Operations installation, there are multiple project
templates, and a particular attribute might be present in some templates and
absent in others.

The behavior of the Not In operator

The operator, Not In, returns all instances of objects (for example, projects) that do
not have the value of the attribute as given in the search, or if the object does not
have the attribute itself. To illustrate, if you search for all Fruits that do not have
black colored seeds, this search returns fruits that do not have black colored seeds
AND fruits that are seedless, since seedless fruits do not have black colored seeds.

Consider the following example:
v Template1 has a custom tab, Business, that contains the attribute BusinessUnit.
v Template2 does not have the Business custom tab (hence it does not contain the

BusinessUnit attribute).
v Two projects are created from Template1:

– Project1 is created with "Insurance" as the value for BusinessUnit.
– Project2 is created with "Banking" as the value for BusinessUnit.

v Two projects are created from Template2: Project3 and Project4.

Assume that you create a search with the following criteria:
[All Templates] -> [BusinessUnit] -> [Not In] -> [Insurance]

This search returns Project2, Project3, and Project4, since none of these projects has
BusinessUnit = Insurance.

Assets advanced search page

When you click Advanced Search on a digital asset list page, the system displays a
page with the following fields.

Table 60. Advanced Search options for digital assets

Field Description

Asset Name Allows you to search in theAsset Name field of all existing assets. IBM
Unica Marketing Operations searches for all asset names that contain
the text string you enter. You can use the following standard wildcards.

v * - to search for any string

v ? - to search for any character.

AND

OR

Allows you to choose a Boolean operator.

v AND: to return items containing all the words in the Asset Name
field.

v OR: to return items containing any of the words in the Asset Name
field.

Asset Code Allows you to search in the Asset Code field of all existing assets. IBM
Unica Marketing Operations searches for all codes that contain the
string you enter.
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Table 60. Advanced Search options for digital assets (continued)

Field Description

Description Allows you to search for text in the Description field of all the existing
assets. IBM Unica Marketing Operations searches all the description
fields for the characters you enter.

Status Allows you to select any or all of the statuses to search; Draft,
Finalized, or Locked.

Expires Before Allows you to specify a date. IBM Unica Marketing Operations
searches for all assets with expiration dates on or before the specified
date.

Folder Name Allows you to enter part or all of a folder name to search. IBM Unica
Marketing Operations searches for all folder names that contain the
text string entered and searches for assets in that folder.

Keywords Allows you to search in the Keywords field of all existing assets. IBM
Unica Marketing Operations searches for any of the keywords that
contain the text string you enter.

Owners Allows you to select one or more owners to search for assets belonging
to the selected owner(s).

Version Name Allows you to search in the Version Name field of all existing assets.
IBM Unica Marketing Operations searches for all versions that contain
the text string you enter.

Usage Guidelines Allows you to search in the Usage Guidelines field of all existing
assets. IBM Unica Marketing Operations searches for all usage
guidelines that contain the text string you enter.

Advanced search page for objects other than assets

When you click Search on the list page for most IBM Unica Marketing Operations
objects, the system displays a page with the following information.

Table 61. Advanced Search options for other objects

Control Description

Search for Displays text indicating the objects for which you are searching. For
example, if you are searching for programs, the dialog displays Search
for: Programs.

Select items Determines whether the search needs to match all or any of the search
criteria. Options are: all, to specify that the search must meet all search
criteria, or any, to specify that the search can match any of the search
criteria. The default is all.
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Table 61. Advanced Search options for other objects (continued)

Control Description

Condition Allows you to construct a search condition by specifying the following.

v From the first pull-down list, select the template on which to base
the condition.

v From the second pull-down list, select the attribute for which you
want to search. Possible values are: Project Name, Owner,
Description, etc.

v From the third pull-down list, select the search operator.

v In the fourth field, enter the value for the criteria.

For example, if you are searching for projects, and want to find project
names that include the word Marketing.

v Select All Enabled to search on all enabled project templates

v Select Project Name in the second pull-down,

v Select Contains in the third pull-down, and

v Type Marketing in the fourth field.

Grouping Allows you to construct a grouping for the search results by specifying
the following.

v From the all/any pull-down, select all or any, to determine whether
to use all or any of the grouping criteria.

v Supply the remainder of the grouping criteria as described for
constructing the Condition.

Insert a new
condition

Click to insert a new line for entering a condition.

Insert a new
grouping

Click to insert a new line for grouping the search criteria.

Remove selected Click to remove any selected conditions or groupings.

Save as Click to save your criteria as a named search. You are prompted to
enter a name for the search. Additionally, IBM Unica Marketing
Operations administrators can publish a search by selecting the
Publish check box.

Apply Click to perform the search based on the criteria specified.

Reset Click to reset the dialog box, clearing any criteria already specified.

Close Click to close the dialog box without performing a search.

About saved searches

You can save any advanced search by clicking Save As on the Advanced Search
page. Saved searches are available only for plans, programs, projects, and
marketing objects.

There are two types of saved searches: unpublished and published. Unpublished
saved searches are available only to the user who saved it. Published saved
searches are available to all users. Only an IBM Unica administrator can publish
saved searches.

Accessing saved searches

After you save a search, you can access the search and rerun it with the same
criteria, or delete it. You can access saved searches in two ways:
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v On the Action icon's menu on the object’s list page
v On the list page itself, when you view all objects of that type by selecting All

[item] in the Action menu

For example, saved searches for projects are available on the Projects List page
when viewing all projects and requests. If your system contains any published
saved searches, they are listed along with your unpublished saved searches.

Setting the sort order in saved searches

When you save a search, the sort column and sort order that exist on the page
from which you are searching becomes the default sort order in the saved search.

Note: If you create a saved search from another saved search that has optional
columns, the optional columns are not included. Thus, if the sort column in the
original search was an optional column, in the second saved search the sort
column reverts to the default, as the sort column does not exist in the new saved
search.

You can change the sort column and sort order of an unpublished search by
changing the sort column and sort order of the list page, accessing the saved
search, and clicking Save, which updates the search. This option applies only to
unpublished searches. To change the sort column, sort order, or both for a
published search, an IBM Unica administrator must first unpublish the search,
change the sort as described above, and then republish the search.

To view a saved search
1. Open the list page for an object type.
2. Click All <objects> (where objects are projects/requests, programs, or plans).

Your saved searches and all published searches appear as folders at the top of
the screen.

3. Click the folder that contains the search results you want to view.

Note: Saved searches are also available from the Actions icon menu.

To delete a saved search

You cannot delete a saved search with any of the following characteristics.
v Created by another user
v A default calendar, project, or task search
v A system search
v Published
v The search the user is currently using
1. Open the list page for an object type.

2. Click the Actions icon ( ) and click the check box next to the search or
searches you want to delete.
You can delete only your own saved searches; you cannot check boxes for any
other searches.

3. Click Delete Selected to remove your selected saved searches.
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Chapter 19. Alerts and the message board

Alerts and the message board both allow you to communicate information to other
users of IBM Unica Marketing Operations.

Alerts and the message board are available for the following objects: plans,
programs, projects, requests, assets, accounts, approvals, invoices, tasks, teams, and
marketing objects.

Alerts
You can use alerts to communicate information to specific people about the state of
an object or about an action that the user needs to take. Default alert subscriptions
are set by administrators, but can be overridden on a per-object basis by owners
and participants of the specific objects.

For workflow tasks, alerts are either brief or detailed.

Message board
The message board allows you to communicate information to the other members
of the team or to an object owner.

Viewing alerts

When you receive an alert, go to the Alerts page to view it. Alerts are also sent to
affected users' email addresses (for each user that has a valid email address set
up). For a detailed list of events that could trigger an alert and for more
information about setting up alerts, see the IBM Unica Marketing Operations
Administrator’s Guide.

To view alerts, log in and click the Alerts icon ( ). Clicking, or scrolling, over
the alerts icon shows a drop-down menu separating the alerts for your installed
applications. The number of alerts appears to the left of each application name.
After you choose which application's alerts to view, the page displays the
following information:

Table 62. Columns on the Alerts page

Column Description

Page heading Contains the number of unread alerts (which appears in parentheses)
and the total number of alerts

Check box Each alert contains a check box; use check boxes to select alerts for a
specific action (for example, to mark a group of alerts for deletion).

Check the box in the first line (next to the Message Text label) to select
all the alerts.

Message text Displays the text of the alert.

Date/Time Displays the time of the event that triggered the alert.

You can perform the following actions from the page.
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Table 63. Controls on the Alerts page

Link/Button Description

Select the yellow envelope icon next to an alert to mark the alert as
read.

After you click the icon, the alert is disabled. Reselect the icon to mark
the alert as unread.

Alert title Click the link in the alert to go to the object that is the subject of the
alert.
Note: The Alerts page remains open while you view the information in
a separate window.

Pages Click a page number to list the corresponding page of alerts.

Delete Selected Click to delete the selected alerts.

Delete All Click to delete all of your alerts.

Mark All as Read Click to mark all your alerts as read, graying out each alert. A
confirmation screen appears to ensure that you want to mark all alerts
as read.

Mark All as
Unread

If you have no unread alerts, click this link to mark all your alerts as
unread.

Close Click to close the Alerts page.

Receiving alerts when outside the organization's domain
If your email address is outside the domain of the organization that has IBM Unica
Marketing Operations installed, you need to modify your SMTP server in order to
receive alerts. Add the IP address of the Marketing Operations server to the relay
allowed IP address list.

About adding comments for alerts
For many events, the system sends out alerts based on actions users perform. For
example, when a project owner starts a project, the system sends out alerts to
project members.

In this example, before the system sends the alert, the project owner can add
comments to the alert. The system provides a dialog box containing the text of the
alert. The user can enter any additional comments to the alert. When the user
closes the dialog box, the system sends the alert, including the comments.

For the following events, users can add comments to the alert before the system
sends the alert.

Table 64. You can add comments to the alerts for these events

Object Events

Project request v A project request is submitted.

v A project request is accepted.

v A project request is returned.

v A project request is canceled.
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Table 64. You can add comments to the alerts for these events (continued)

Object Events

Project v A project is started.

v A project is put on-hold.

v A project is restarted.

v A project is completed.

v A project is cancelled.

v A project is put in not started state.

Program v A program is started.

v A program is put on-hold.

v A program is restarted.

v A program is completed.

v A program is cancelled.

Plan v A plan is started.

v A plan is put on-hold.

v A plan is restarted.

v A plan is completed.

v A plan is cancelled.

Approval v An approval process is started.

v An approval process is put on-hold.

v An approval process is restarted.

v An approval process is complete.

v An approval process is cancelled

Asset v An asset is drafted.

v An asset is locked.

v An asset is finalized.

v An asset is archived.

Invoice v An invoice is marked as payable.

v An invoice is marked as paid.

v An invoice is redrafted.

v An invoice is canceled.

Marketing object The status of a marketing object changed.

To subscribe to alerts for an object

You can override default settings within a plan, program, project, or project request
even if you are not an administrator, which allows you to control the alerts that
each object owner and participant receives. However, if there are permissions
configured for any of the tabs of a project or request, the system filters alerts
appropriately. For example, alerts about attachments are not sent to users who do
not have access to a project's Attachments tab.
1. Open the object for which you want to change alert subscriptions.

2. Click the Communicate icon ( ) and select Subscribe to Alerts from the
drop-down list.
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3. From the list of alerts, select the check boxes that correspond to the alert that
you want to change. You can set or clear alert subscriptions for each type of
user, Owner, or Participant. The possible entries are as follows:
v Check mark: indicates that the user receives the alert or alarm
v Blank: indicates that the user does not receive the alert or alarm
v n/a: indicates that you did not specify team members for this access level

(for example, Program Participant) when you created the object. After you
add users with the corresponding access level, you can set alerts for that
access level.

4. Click Accept to save your changes or Cancel to leave the alert settings as they
were.

Brief and detailed task alerts
When someone makes edits to a workflow, they can make numerous edits that
affect several tasks, members, dates, and so on. IBM Unica Marketing Operations
allows you to determine whether users should receive detailed or brief alerts
(through notification by email and within Marketing Operations) about the
workflow changes:
v Brief mode: The notification informs users that changes were made to the

workflow. In certain cases, the field changed and new value are shown.
v Detailed mode: The notification contains a section for each task that changed.

For each change, both the previous and current values are listed in the alert.

Determine the correct level of information, and set the Detailed workflow change
notification alert accordingly.

Note the following:
v If a project is set up to deliver detailed alerts to owners and participants, any

changes to workflow tasks leads to a detailed alert being sent to project owners
and affected task members (that is, specific participants who are task members).
In this case, brief alerts related to workflow tasks (such as Task Assigned or Task
Started) are not sent.

v If a project is set up to deliver detailed alerts to owners only, then changes to
workflow task rows lead to a detailed alert being sent to project owners only.
Affected task members (project participants) receive brief alerts.

Group events that contribute to detailed alerts

In addition to edits made to the workflow itself, a few other actions can lead to
task alerts being sent, if a project is set for detailed alerts.

Table 65. Actions that result in alerts

Tab Actions

People v If a user uses the find and replace feature to change a workflow,
IBM Unica Marketing Operations sends an alert to both the previous
and new task owners.

v If a user clicks Assign work by role, Marketing Operations sends an
alert to each user assigned (or unassigned) tasks.
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Table 65. Actions that result in alerts (continued)

Tab Actions

Tasks v If a user clicks Complete Selected, Skip Selected, or Reassign
Selected, IBM Unica Marketing Operations sends an alert that
indicates the affected tasks.

v If a user edits a task from the screen, Marketing Operations sends
an alert indicating the changes to the task.

Teams If a team manager or member reassigns tasks, IBM Unica Marketing
Operations sends an alert to both the previous and new task owners.

Approvals If a user edits an approval task that is part of a workflow, IBM Unica
Marketing Operations sends an alert indicating changes to the task.

Examples of brief and detailed alerts

The following example depicts an email a user might receive if the project is set up
to deliver detailed alerts.
Subject: Project workflow updated: "Project 0004 (TRS1022)"
Project workflow updated: "Project 0004 (TRS1022)"
By: asm admin
When: Monday, October 15, 2007 at 1:38:24 PM EST
Task : 1.1 Determine objectives and theme (Task Code : <empty>)
Target Start changed to 11/01/2007 09:00:00 AM from 10/17/2007
09:00:00 AM
Notes changed to My Added new notes...... from Added new notes
% Complete changed to 6 from 3
Target End changed to 11/05/2007 05:00:00 PM from 10/19/2007
05:00:00 PM
Members changed to rm_user3, rm_user2, from asm admin
Task : 1.2 Estimate costs (1.1,1.1) (Task Code : <empty>)
Target Start changed to 11/06/2007 09:00:00 AM from 10/22/2007
09:00:00 AM
Notes changed to My Added new notes...... from Added new notes
% Complete changed to 25 from 10
Target End changed to 11/07/2007 05:00:00 PM from 10/23/2007
05:00:00 PM
Members changed to rm_user3, rm_user2, from asm admin
:
:
Click
http://svr01:7001/MktOps/affiniumplan.jsp?cat=projectworkflow&projectid
=103 to go to project.

The following example depicts an email a user might receive if the project is set up
to deliver brief alerts:
Subject: Project workflow updated: "Project 0004 (TRS1022)"
Project updated: "Project 0004 (TRS1022)"
By: asm admin
When: Monday, October 15, 2007 at 1:38:24 PM EST
Comment: "Workflow" tab updated.
Description: Tradeshow for 1st Mutual Bank of Fred
Click
http://svr01:7001/MktOps/affiniumplan.jsp?cat=projecttabs&projectid
=103 to go to project.

Configuring task alert level

Your administrator can select the Detailed workflow change notification alert. If
so, by default, all projects send detailed alerts. Project owners and members can

Chapter 19. Alerts and the message board 195



override the default setting on a per-project basis, by changing the setting for the
Detailed workflow change notification, located in the alert subscription window
for each project.

To post a message on the message board

The message board allows you to post or read messages about a particular plan,
program, project, asset, account, approval, or invoice. You can use this feature as a
method of communicating information about the object. When you post a message
to the message board, any user who has permission to access that object can view
the posted message.
1. Open the list page for the object type of the object for which you would like to

post a message. For example, click Operations > Accounts. (You can post
messages for plans, programs, projects, assets, accounts, approvals, or invoices.)

2. Click the plan, program, project, account, approval, or invoice for which you
want to post a message.

3. Click the Communicate icon ( ) in the IBM Unica Marketing Operations
toolbar and select Post a Message.
The Messages window appears.

4. Enter your message in the text box.
5. Click one of the radio buttons.

By default, you also receive an email alert when you post a message.
6. Click Post Comment.

The Messages window displays all the posted comments for this object. Your
new comment appears at the top of the list.
If you chose an email option, your message includes a line listing the email
recipients, similar to the following:
(cc’d to Mary Manager, Connie Contact, aartiste@unica.com)
The system displays names for users whose names are stored in IBM Unica
Marketing Platform. If this information is not in the platform, the system uses
the email address.

7. Click Close if this comment is the only one you want to post now, or click Post
a Comment to post an additional comment.
IBM Unica Marketing Operations posts the message to the message board and
sends any email messages you instructed it to send. The messages contain the
text of the message posted on the message board as well as a link to the object
(plan, program, project, and so on) where the message was posted.

To read a message on the message board

You can read messages that were previously posted to the message board, if you
have permission to view that object. Messages can be posted for plans, programs,
projects, assets, accounts, approvals, or invoices.
1. Open the list page for the object type of the object for which you would like to

read a message. For example, click Operations > Accounts. (You can post or
read messages for plans, programs, projects, assets, accounts, approvals, or
invoices.)

2. Click the plan, program, project, asset, account, approval, or invoice whose
messages you want to read.
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3. Click the Communicate icon ( ) and select Read Messages.
The Messages window appears, displaying all the messages on the message
board for that object.

4. Click Close to exit the message board or click Post a Comment if you want to
respond to a posted message.
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Contacting IBM Unica technical support

If you encounter a problem that you cannot resolve by consulting the
documentation, your company’s designated support contact can log a call with
IBM Unica technical support. Use the information in this section to ensure that
your problem is resolved efficiently and successfully.

If you are not a designated support contact at your company, contact your IBM
Unica administrator for information.

Information to gather

Before you contact IBM Unica technical support, gather the following information:
v A brief description of the nature of your issue.
v Detailed error messages you see when the issue occurs.
v Detailed steps to reproduce the issue.
v Related log files, session files, configuration files, and data files.
v Information about your product and system environment, which you can obtain

as described in "System information."

System information

When you call IBM Unica technical support, you might be asked to provide
information about your environment.

If your problem does not prevent you from logging in, much of this information is
available on the About page, which provides information about your installed IBM
Unica applications.

You can access the About page by selecting Help > About. If the About page is not
accessible, you can obtain the version number of any IBM Unica application by
viewing the version.txt file located under the installation directory for each
application.

Contact information for IBM Unica technical support

For ways to contact IBM Unica technical support, see the IBM Unica Product
Technical Support website: (http://www.unica.com/about/product-technical-
support.htm).
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information about the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
1623-14, Shimotsuruma, Yamato-shi
Kanagawa 242-8502 Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law: INTERNATIONAL
BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS"
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED,
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR
PURPOSE. Some states do not allow disclaimer of express or implied warranties in
certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM websites are provided for
convenience only and do not in any manner serve as an endorsement of those
websites. The materials at those websites are not part of the materials for this IBM
product and use of those websites is at your own risk.
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IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation
170 Tracer Lane
Waltham, MA 02451
U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

All IBM prices shown are IBM's suggested retail prices, are current and are subject
to change without notice. Dealer prices may vary.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
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been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. The sample
programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Trademarks
IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at “Copyright and
trademark information” at www.ibm.com/legal/copytrade.shtml.
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